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Настоящее пособие не раскрывает всех возможностей программы Microwave Office 
2002. Его цель – помочь быстро освоить основы работы в среде моделирования этой 
программы на конкретных примерах. Пособие составлено с использованием Getting 
Started, входящего в состав документации Microwave Office 2002 и которое содержит 
четыре примера по различным видам моделирования. К этим примерам добавлен ряд 
других, чтобы показать дополнительные особенности работы в среде моделирования, 
которые полезно освоить уже при первом знакомстве с работой программы. 

Е.Е. Дмитриев. 

Введение 
Microwave Office – это мощный инструмент для анализа высокочастотных устройств, 

позволяющий автоматизировать процесс их проектирования. Microwave Office позволяет полностью 
выполнять проектирование от технического задания до производства не выходя из среды разработки. 

При моделировании можно использовать один из методов: линейное моделирование, 
усовершенствованный гармонический баланс, ряды Вольтера или 3-х мерное электромагнитное 
моделирование (EMSight). Результаты могут выводиться в различных графических формах или в таблице 
в зависимости от цели проводимого анализа. Можно настраивать или оптимизировать проекты и все 
изменения немедленно и автоматически отражаются на графиках и в топологии. 

Справочная система Microwave Office обеспечивает информацию обо всех окнах, пунктах меню, 
и концепциях. К справочной системе можно обратиться через Пуск > Программы > AWR Suite 2002 > 
Microwave Office Help или, выбрав Help из выпадающего меню, или нажав клавишу F1. 
 
Инсталляция Microwave Office. 
 
 Для инсталляции Microwave Office требуется: 
 

o процессор с тактовой частотой 200 МГц; 
o 64 Мб оперативной памяти; 
o операционная система Microsoft Windows 2000, NT4, ME, XP или 98; 
o Microsoft Internet Explorer версии 5.0 или старше, включая Web Browser, Help и 
поддержку программирования сценариев Visual Basic. 

 
Если вы обновляете версию Microwave Office (например, устанавливаете версию 5.0 вместо 4.0), 

то сохраните старую версию до тех пор, пока не проверите, работают ли ваши проекты в новой версии. 
Программа инсталляции позволяет установить Microwave Office и дополнительно 

специализированные библиотеки. Эти библиотеки содержатся только на диске с дистрибутивом. Однако 
Microwave Office автоматически включает минимальный набор библиотек. 

Специализированные библиотеки содержат буквально тысячи электрических компонентов, 
которые могут использоваться в проектах. Чтобы инсталлировать библиотеки, вставьте диск в дисковод 
CD-ROM и щёлкните Install Libraries или найдите на диске файл libsetup.exe и запустите его. Можно 
установить сразу все библиотеки или выборочно. Для всех библиотек требуется номинально 170 Мб, но 
может потребоваться и больше места на диске. Библиотеки не могут быть установлены с сайта AWR 
(http://www.mwoffiсe.com), но ко многим XML библиотекам на сайте AWR можно обращаться из 
Microwave Office через окно просмотра элементов. 



1 Среда проектирования Microwave Office 

1.1 Запуск Microwave Office 
Чтобы запустить Microwave Office, сделайте следующее: 

• Нажмите команду Пуск; 
• Выберите Программы > AWR Suite 2002 > Microwave Office. Откроется главное окно 

Microwave Office, показанное на рис. 1.1. 
Если при инсталляции Microwave Office не был сконфигурирован так, чтобы находиться в меню 

Программы, тогда щёлкните значок Мой компьютер на рабочем столе, выберите диск и папку, в 
которую установлен Microwave Office, найдите файл MWOffice.exe и запустите его. Откроется главное 
окно Microwave Office (рис 1.1): 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Панели 

1.2 Компоненты среды проектирования 
Главное окно Microwave Office содержит все компоненты, которые составляют среду 

проектирования. Именно через это окно проектируются линейные и нелинейные схемы, 
устанавливаются электромагнитные структуры (EM), создаются топологии, исполняется моделирование, 
и отображаются графики. Основные компоненты описаны ниже: 

Компонент Описание 

Выпадающее меню Строка опускающихся меню, расположенная в верхней части окна, для 
выполнения ряда задач Microwave Office. 

Панель 
инструментов 

Строка значков, расположенных ниже выпадающего меню, которые обеспечивают 
доступ к часто используемым командам типа создания новых схем, выполнения 
моделирования, или настройки значений параметров или переменных. 

Окно просмотра 
проекта 

Древовидная структура групп и модулей, которая определяет активный проект 
Microwave Office, включая схемы, электромагнитные структуры (ЕМ), частоты 
моделирования и выходные графики. 

Рабочее поле Зона, в которой проектируются схемы, электромагнитные структуры (EM), 
отображаются и редактируются топологии, и выводятся графики. 

Панели Строка панелей, расположенная в нижней части левого окна, которая позволяет 
переключать содержание этого окна.  
Proj – включает окно просмотра проекта. 
Elem – включает окно просмотра элементов для формирования схем. 
Var – позволяет настраивать или оптимизировать значения параметров или 
переменных для элементов схемы в активном проекте. 
Layout – позволяет определить параметры для просмотра и рисования топологии и 
создавать новые элементы топологии. 
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Замечания. Многие выборы и команды, доступные из выпадающего меню, также доступны 
через панель инструментов и/или окно просмотра проекта. 
Значки панели инструментов динамически изменяются в зависимости от открытого активного 
окна. Установите курсор на значок, чтобы увидеть его описание. 
Окно просмотра проекта всегда активно после загрузки Microwave Office. Щёлкните правой 
кнопкой мышки по группе в окне просмотра проекта, чтобы вызвать всплывающее меню с 
соответствующими этой группе командами. 
В пределах рабочего пространства вы можете перемещаться, используя вертикальную и 
горизонтальную полосы скроллинга и изменять размеры внутри окна, используя значки на 
панели инструментов. Вы можете нажимать на элементы схемы правой кнопкой мышки, чтобы 
вызвать всплывающее меню с соответствующими командами. Вы можете также копировать и 
вставлять элементы, порты и проводники из одной схемы или проекта в другие, используя 
значки панели инструментов. 
 
Основное окно среды проектирования разделено на две части: окно просмотра проекта и рабочее 

поле. В верхней части основного окна расположено выпадающее меню, в котором заложены основные 
функции и команды для работы с проектом, а также панели инструментов, вид и состав которых 
"интеллектуально" меняется в зависимости от действия, выполняемого пользователем в данный момент 
времени. 

Окно просмотра проекта содержит четыре панели: Project (проект), Elements (элементы), 
Variables (переменные) и Layout (топология). 

На вкладке Project отображается дерево групп и модулей, которые уже используются, а также 
могут быть использованы в данном проекте. Сюда входят: 
 

o модуль примечаний к проекту (Design Notes); 
o модуль задания глобальных опций проекта (Project Options); 
o модуль глобальных выражений (Global Equations); 
o модуль использования внешних файлов данных (Data Files); 
o группа используемых схематических модулей (Circuit Schematics); 
o группа используемых электромагнитных структур (EM Structures); 
o список применяемых материалов проводников(Conductor Materials); 
o модуль выходных соотношений (Output Equations); 
o группа отображения результатов анализа (Graphs); 
o группа целей оптимизации (Optimizer Goals); 
o группа целей статистического анализа (Yield Goals); 
o список выходных файлов (Output Files); 
o группа мастеров (Wizards); 
o группа создания сценариев (Scripting). 

 
При двойном щелчке на каждой из групп, в случае, если группа не пустая, на дереве проекта 

отображается список модулей используемых данной группой. Двойной щелчок на каждом модуле 
открывает соответствующее окно просмотра на рабочем поле Microwave Office или диалоговое окно, 
руководящее последующими действиями пользователя. Удобной подсказкой являются также 
контекстные меню, появляющиеся при нажатии правой клавишей мышки на любом объекте проекта и 
предлагающие на выбор список возможных дальнейших действий. 

На вкладке Elements отображается дерево используемых библиотек "зашитых" моделей 
элементов построения схематических модулей: портов, источников, сосредоточенных и распределенных, 
линейных и нелинейных, идеальных и неидеальных элементов, а также внешних импортируемых 
библиотек моделей и подсхем. 

Все модели объединены в соответствующие группы, содержание которых отражается в нижней 
части окна. 

Добавление того или иного элемента в схему проекта производится привычным методом Drag-
and-Drop (возьми-и-брось), а редактирование параметров - или в списке прямо на схеме, или в 
специальном диалоговом окне, открывающемся при двойном щелчке на элементе. 

Контекстное меню, появляющееся при нажатии правой клавиши на библиотечном элементе, 
подсказывает возможные действия над ним, а также содержит команду вызова справки об этом элементе. 

На вкладке Variables отображается полный список переменных, используемых в проекте, а 
также их статус, например, возможность изменения при оптимизации или при работе с инструментом 
Tuner. 

При работе со схематическим модулем на рабочем поле пакета появляется соответствующее 
окно, изменяется состав основного меню и панелей инструментов. 

Здесь присутствуют наиболее часто встречающиеся элементы схем, кнопки управления 
масштабированием схемы, а также инструмент Tuner. 

Аналогичные действия происходят при переключении на модуль электромагнитной структуры. 
Инструмент Tuner здесь отсутствует, но присутствуют команды прорисовки полигонов и межслойных 
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соединений из различных проводящих материалов на различных слоях. Кроме того, имеется 
возможность просмотра трехмерного изображения исследуемой структуры, а также анимационного 
отображения рассчитанных токов. 

Группа отображения результатов предлагает наглядную демонстрацию результатов расчета на 
диаграммах различного типа в зависимости от выбранного типа анализа. 

Здесь возможно простое отображение S-параметров схем на диаграммах Смита, графиках в 
прямоугольных и полярных координатах, а также более сложная прорисовка форм и спектров сигналов в 
различных точках схемы или диаграмм направленности антенн, да еще и в диапазоне частот. 

Заметим также, что именно эта группа, совместно с используемыми моделями элементов и 
сигнальных портов, является определяющей при выборе того метода анализа, который будет 
использоваться в вашем проекте. Кроме того, в одном проекте могут комбинироваться различные 
методы анализа, а их результаты отражаться на одних и тех же графиках. 

Группа оптимизации содержит список назначенных целей оптимизации текущей схемы. Под 
целью оптимизации здесь подразумевается некоторая граница изменения какой-либо характеристики 
анализируемой схемы, к которой должен стремиться выбранный метод оптимизации при изменении 
определенных параметров элементов. 

Каждая введенная цель оптимизации сразу же отображается на соответствующем графике, что 
позволяет в последующем легко проверить ее параметры, а также легко изменить их тут же на графике с 
помощью мышки. 

Программа моделирования линейных или квазилинейных схем компании AWR носит название 
VoltaireLS. Она прочно интегрирована в систему Microwave Office и активируется каждый раз, когда 
запрашиваются результаты анализа, которые можно получить без использования нелинейных моделей. 

Наиболее распространённой линейной задачей является расчет частотных характеристик 
пассивных устройств или малосигнальный анализ активных устройств с использованием 
линеаризованных библиотечных моделей активных элементов. Такой анализ, как правило, проводится 
очень быстро. Например, расчет частотных характеристик фильтра на пяти связных микрополосковых 
линиях занимает менее секунды. 

Не смотря на то, что в библиотеках пакета содержится более 450 линейных и нелинейных 
моделей элементов, всегда может оказаться, что правильная модель используемого устройства 
отсутствует или эффект близкого расположения элементов подрывает точность уже имеющейся. В этом 
случае, пользователи могут обратиться к третьему компоненту пакета Microwave Office - модулю 
полного электродинамического анализа. 

Здесь для анализа поведения электромагнитных структур используется метод моментов 
Галёркина, который, по мнению разработчиков пакета, представляет собой точный и устойчивый 
алгоритм электромагнитного анализа. Структура, построенная из набора проводящих и резистивных 
полигонов, а также межслойных соединений произвольной геометрической формы, анализируется 
внутри ограниченной многослойной области прямоугольной формы. Боковые границы этой области 
всегда идеально проводящие, а верхняя и нижняя границы могут быть заданы тремя различными 
способами: проводящая поверхность с потерями (или без них), эквивалент открытого пространства и 
бесконечного волновода. Количество анализируемых слоев, межслойных соединений и внешних портов 
теоретически неограниченно. 

Мощные графические возможности модуля электродинамического анализа позволяют 
пользователю наблюдать цветное трехмерное анимационное изображение токов высокой частоты, на 
котором отображается не только амплитуда, но и направление этих токов, что позволяет получить новое 
представление о поведении СВЧ структур. 

1.3 Работа с проектами 
В среде проектирования Microwave Office используются проекты, организуемые и управляемые 

из древовидной структуры в окне просмотра проектов. 
Проект представляет собой любой желательный набор моделей и может включать одну или 

более линейных схем, нелинейных схем, и/или электромагнитных структур. Проект также включает всё 
связанное с проектом, типа глобальных значений параметров, импортированных файлов, топологий и 
выходных графиков. При сохранении проекта автоматически сохраняется всё связанное с ним. Проекты 
в Microwave Office сохраняются как *.emp файлы. 

 
Замечание. При запуске Microwave Office по умолчанию загруженным или активным является 
проект без названия (Untitled Project). Имя активного проекта отображается в заголовке 
основного окна. 
 
После создания проекта вы можете реализовывать свои замыслы. Вы можете генерировать 

топологию этого проекта и выводить её в DXF, GDSII или Garber файлах. Вы можете выполнить 
моделирование, чтобы сделать анализ проекта и просмотреть результаты на ряде графиков, которые вы 
определили. После этого вы можете настраивать или оптимизировать значения параметров или 



переменных. Так как все части Microwave Office интегрированы, все ваши модификации автоматически 
отображаются на схеме и в топологии. 

1.4 Основные элементы среды проектирования 
В этом разделе описаны основные окна, пункты меню и команды, необходимые для выполнения 

основных задач Microwave Office, таких как: создание проекта, схемы, рисунка электромагнитных 
структур, топологий, выполнение моделирования, настройка и оптимизация значений параметров и 
переменных, отображение выходных графиков. Главы с 1-ой по 4-ю этого руководства, познакомят с 
этими и другими возможностями Microwave Office. 

Многие, описанные здесь, выборы меню и команд могут быть вызваны различными способами 
из выпадающих меню, из панели инструментов и/или окна просмотра проектов. В этом руководстве не 
описываются все способы вызвать задачу. 

 
Создание, открытие и запись проектов. 
 

 
Создание проекта – первый шаг к формированию и моделированию ваших проектов. 

Организация и управление проектом и всем связанным с ним производится в древовидной структуре 
групп и модулей в окне просмотра проектов при нажатой панели Proj (рис. 1.2). 

Для создания нового проекта нужно выбрать File>New Project в выпадающем меню. Затем 
нужно дать имя новому проекту, выбрав File>Save Project As в том же меню. Имя проекта отображается 
в заголовке окна. 

Для открытия существующего проекта нужно выбрать File>Open Project.  
Для сохранения текущего проекта нужно выбрать File>Save Project. 

 
Создание схем и списка цепей. 

 
Схемы – это графическое изображение схем, а список цепей – это текстовое описание. Проект 

Microwave Office может включать множество рисунков линейных и нелинейных схем и/или списков 
цепей, а также электромагнитных структур. 
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Чтобы создать новую схему или список цепей, нужно щёлкнуть правой кнопкой мышки по 
группе Circuit Schematics и выбрать New Schematic или New Netlist и, в открывшемся поле ввода, 
ввести имя схемы или списка цепей. 

После того, как определено имя схемы или списка цепей, на рабочем поле открывается пустое 
окно схемы (рис. 1.3) или списка цепей, в заголовке которого отображается присвоенное имя, а в окне 
просмотра проектов отображается новая схема или список цепей, как подгруппа в группе Circuit 
Schematics. Подгруппа новой схемы или списка цепей содержат все параметры и опции, которые 
определяют и описывают схему или список цепей. Кроме того, выпадающее меню и панель 
инструментов отображают новый специфический набор команд и инструментов для формирования и 
моделирования схемы или списка цепей. 
 
Добавление элементов в схему. 
 

Замечание. Библиотеки и папки данных в окне просмотра элементов предлагают широкий 
выбор электрических моделей и файлов S-параметров от производителей. 

 
Окно просмотра элементов (рис. 1.4) позволяет  просматривать встроенную базу данных 

иерархических групп электрических элементов таких, как сосредоточенные элементы или элементы 
полосковых линий, и выбирать нужные элементы для включения в схему. 

Чтобы добавить элементы к схеме, нужно нажать панель Elem в нижней части левого окна. Окно 
просмотра проектов будет заменено окном просмотра элементов. 

Нажимая значки + или – возле группы, можно развернуть или свернуть группу, а при нажатии на 
значок желательной подгруппы, например, Capacitor (Конденсатор) или Inductor (Индуктивность), в 
нижней части окна просмотра элементов отображаются доступные элементы из этой подгруппы. 

Чтобы поместить нужный элемент, нажмите его левой кнопкой мышки и, не отпуская кнопки, 
переместите в окно схемы. Здесь, в любом свободном месте окна, отпустите кнопку. Нажатием на 
перемещённом элементе правой кнопкой мышки, можно его вращать, чтобы получить нужную 
ориентацию. Затем, не нажимая кнопок мышки, элемент нужно поместить в соответствующее место и 
зафиксировать его, щёлкнув левую кнопку мышки. 

Параметры элемента располагаются в окне схемы рядом с элементом. Чтобы изменить значение 
какого либо параметра, нужно дважды щёлкнуть левой кнопкой мышки по этому параметру. Откроется 
диалоговое поле ввода, в котором можно отредактировать значение параметра. 
 
Добавление элементов в схему. 
 

В Microwave Office в схему можно включать подсхемы в виде блоков, что позволяет создавать 
иерархические структуры схем. Таким блоком могут быть схемы, списки цепей, электромагнитные 
структуры или файлы данных. 
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Чтобы добавить подсхему, нужно нажать Subcircuits (Подсхемы) в окне просмотра элементов. 
Доступные подсхемы отображаются в нижней части этого окна. Они включают все схемы, списки цепей 
и электромагнитные структуры, связанные с проектом, а также любые импортированные файлы данных, 
определённые для проекта. 

 
Замечание. Чтобы добавить файл данных как подсхему, он должен быть сначала импортирован 
и добавлен к проекту как объект. Чтобы сделать это, выберите Project > Add Data File. Любые 
импортированные файлы данных автоматически отображаются в перечне доступных подсхем в 
окне просмотра элементов. 
 
Для размещения желательной подсхемы, её нужно просто перетащить мышкой в окно схем, при 

необходимости повернуть правой кнопкой мышки и установить в нужное место. 
Для редактирования параметров подсхемы нужно щелкнуть мышкой по ней в окне схем, чтобы 

её выделить, затем щёлкнуть правой кнопкой и выбрать Open Subcircuit во всплывающем меню. Или 
открыть схему, список цепей, электромагнитную структуру или файл данных на рабочем поле (через 
окно просмотра проектов). Редактирование делается так же, как и редактирование параметров 
отдельного элемента. 
 
Добавление портов (входов) и проводов в схему. 

Замечание. Для размещения портов или земли щёлкните по  значку Port  или Ground  
на панели инструментов, переместите его в схему и щёлкните левой кнопкой мышки, чтобы 
зафиксировать. 
 
Чтобы добавить порты к схеме, нужно нажать на группу Ports (Порты) в окне просмотра 

элементов. Затем щёлкнуть нужную подгруппу портов, например Volterra. Доступные типы портов 
будут отображены в нижней части окна. 

Для размещения требуемого типа порта, нужно перетащить его мышкой в окно схем, при 
необходимости развернуть его правой кнопкой мышки, поместить в нужное место и зафиксировать 
левой кнопкой мышки.  

Отредактировать параметры порта можно двойным щелчком мышки по порту в окне схем. 
Откроется диалоговое окно, в котором можно ввести новые значения параметра. 

Чтобы соединить два элемента схемы проводом, нужно установить курсор возле точки элемента, 
к которой нужно подключить начало провода, в окне схем. Курсор должен отображать провод в виде 
соленоида. Нажмите в этой позиции левую кнопку мышки, чтобы зафиксировать начало провода, и, 
отпустив кнопку мышки, двигайте мышкой к месту, где нужно сделать изгиб провода. Щёлкните снова 
левой кнопкой, чтобы зафиксировать изгиб. Изгибов можно делать сколько угодно. Чтобы закончить 
подключение провода, щелкните по другому элементу, к которому нужно присоединить провод, или по 
другому проводу. Для отмены соединения проводом нажмите клавишу Esc. 
 
Добавление данных к списку цепей. 

 
При создании списка цепей открывается пустое окно Netlist, в котором вы вводите базовый текст 

описания схемы. Данные списка цепи размещаются в блоках в особом порядке, где каждый блок 
определяет различные атрибуты элемента, типа единиц измерения, уравнений или элементных связей. 
Для большей информации о создании списка цепи см. Руководство пользователя Microwave Office. 
 
Создание электромагнитных структур (ЕМ). 
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Электромагнитные структуры – это произвольные многослойные электрические структуры типа 
спиральных катушек индуктивности с воздушными прослойками. Чтобы создать новую 
электромагнитную структуру, щёлкните правой кнопкой мышки по группе EM Structures в окне 
просмотра проектов и выберите New EM Structure. 

После присвоения имени электромагнитной структуре на рабочем поле открывается пустое окно 
электромагнитной структуры (рис. 1.5) и в окне просмотра проектов отображается новая 
электромагнитная структура, как подгруппа в группе EM Structures. Подгруппа новой 
электромагнитной структуры содержит все параметры и опции, которые определяют и описывают её. 
Кроме того, в выпадающем меню и панели инструментов появляются новые пункты для рисования и 
моделирования электромагнитных структур. 
 
Рисование электромагнитной структуры. 

 
Прежде чем нарисовать электромагнитную структуру, необходимо определить параметры 

корпуса. Корпус определяется краевыми условиями и диэлектрическими материалами каждого слоя 
структуры. 

 
Для определения корпуса дважды щёлкните по подгруппе Enclosures (Корпуса) в окне 

просмотра проектов (рис. 1.6). Откроется диалоговое окно, в котором можно ввести необходимую 
информацию. 

После определения параметров корпуса можно создавать рисунки, выбрав Draw (Рисовать) в 
выпадающем меню, чтобы отобразить опции рисования, или, щёлкая соответствующие значки на панели 
инструментов, можно рисовать компоненты типа проводников прямоугольного сечения, межслойных 
переходов и портов. 

Электромагнитные структуры можно просматривать в 2-х и в 3-х мерном пространстве, выбрав 
команду View (Просмотр) из выпадающего меню. Токи в структуре и электромагнитные поля можно 
просмотреть, выбрав команду Animate (Анимация) из выпадающего меню. 
 
Создание топологии. 

 
Топология – это изображение физического 

представления цепей, в котором каждому компоненту 
схемы соответствует элемент топологии. В объектно-
ориентированной среде Microwave Office топология 
тесно связана со схемой и электромагнитной 
структурой, которые она представляет, это просто 
другой вид тех же самых цепей. Любые изменения, 
сделанные в схеме или электромагнитной структуре, 
автоматически и немедленно отображаются в 
соответствующей топологии. Рис. 1.7

Для создания топологии схемы, щёлкните по схеме, чтобы сделать её активной и выберите 
Schematic>View Layout из выпадающего 
меню или щёлкните по значку View Layout 

 на панели инструментов. На рабочем 
поле откроется окно топологии с 

автоматически созданной топологией схемы, если для элементов схемы имеются соответствующие 
элементы топологии. Однако элементы топологии могут быть соединены между собой неверно или не 
соединены вовсе, как показано на рис. 1.7, при этом пунктирными красными линиями указываются 
общие точки соединения элементов топологии, т.е. точки, в которых эти элементы должны быть 

Рис. 1.8 
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соединены. Чтобы правильно скомпоновать топологию, выберите Edit>Snap Together в выпадающем 
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ки, 

лняете команду Schematic>View Layout, по умолчанию элементы топологии 
автомат ой 

оторым не определены элементы топологии по умолчанию, вы должны их 
определ о 

такие ве
ементы топологии, 

которых на. 

деляет атрибуты, такие как 
свойств

 
шаблон ие 

так 

просмат начения + 

ент 

 вывода топологии 
щёлкни ut 

меню. Топология будет скомпонована автоматически, как показано на рис. 1.8. При желании это можно
сделать и вручную. Для этого щёлкните левой кнопкой по элементу, который нужно переместить в 
другое место, установите курсор на этот элемент, нажмите левую кнопку мышки и, не отпуская кноп
переместите элемент. 

Когда вы выпо
ически назначаются для общих электрических компонентов, таких как элементы симметричн

полосковой линии, микрополосковой, компланарного волновода. Любые компоненты схемы, которых 
нет в отображаемых по умолчанию элементах, будут появляться в синем окне схемы после того, как 
топология создана, в то время, как компоненты, имеющиеся в задаваемых по умолчанию, будут 
появляться в сиреневом. 

Для компонент, к
ить сами или импортировать через менеджера топологии (Layout Manager), как будет описан

далее. 

Вы можете чертить в окне топологии, используя палитру рисования топологии, чтобы делать 
щи, как создавать эскиз подложки или рисовать контактные площадки. 
Изменять атрибуты топологии, свойства рисования и создавать новые эл
 нет среди задаваемых по умолчанию, можно нажав панель Layout в нижней части левого ок

Менеджер топологии заменит при этом окно просмотра проектов (рис. 1.9). 
Группа Layer Setup (Установка Слоёв) в менеджере топологии опре
а рисования (цвет линии, рисунок слоя и т.д.), 3-х мерные свойства (толщина и т.д.) и положение 

слоёв. Чтобы изменить атрибуты слоя, щёлкните правой кнопкой мышки Layer Setup и выберите Edit 
Drawing Layers (Редактирование рисования слоёв) во всплывающем меню. В качестве альтернативы 
можно импортировать файл воспроизведения слоёв (LPF) для определения их атрибутов, щёлкнув 
правой кнопкой мышки Layer Setup и выбирая Import Process Definition из всплывающего меню. 

Группа Cell Libraries (Библиотека элементов) в Менеджере топологии позволяет создавать
ы для элементов, которых нет в задаваемых по умолчанию. Редактор элементов включает так

возможности, как покоординатный ввод, булевы операции для вычитания и объединения моделей, 
копирование массива, произвольное вращение, группировку и инструменты настройки. Вы можете 
же импортировать библиотеки шаблонов элементов типа CDSII или DXF в Microwave Office. 

Как только библиотеки элементов топологии созданы или импортированы, их можно 
ривать и выбирать необходимые элементы для включения в топологию. Нажмите обоз

или – , чтобы развернуть или свернуть библиотеки элементов и выберите необходимый элемент. 
Доступные элементы топологии отображаются в нижней части левого окна. Чтобы поместить элем
топологии в окно топологии, просто нажмите на него левой кнопкой мышки и переместите; отпустив 
кнопку мышки, позиционируйте его и щёлкните мышкой, чтобы зафиксировать. 

Топология может выводиться в файлах GSII, DXF, Gerber или PADS. Для
те по окну топологии, чтобы сделать его активным, и выберите команду Layout>Export Layo

из всплывающего меню. 
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оздание выходных графиков и добавление единиц измерения. 

амечание. Чтобы просмотреть справку о различных параметрах единицы измерения, выделите 

icrowave Office даёт возможность просматривать результаты моделирования в виде различных 
графико

я, 

е правой кнопкой мышки по группе Graphs (Графики) в окне 
просмот

ем 

С
 
З
представляющую интерес единицу измерения в диалоговом окне Add Measurement и нажмите 
Meas. Help. 
 
M
в. Перед выполнением моделирования необходимо создать график. Необходимо так же 

определить данные или единицы измерения, которые вы хотите видеть на графике, типа усилени
шумов или коэффициентов отражения. 

Чтобы создать график, щёлкнит
ра проектов и выберите Add Graph (Добавить график) из всплывающего меню. Появится 

диалоговое окно, в котором нужно задать имя графика и его тип. Пустой график появится на рабоч
поле, и имя графика появится как подгруппа в группе Graphs в окне просмотра проекта. Доступны 
следующие виды графиков: 

 Тип графика  Описание 

  измеряемые величины по осям X – Y, обычно по частоте ОтображаетПрямоугольный

Диаграмма Сми а Отображает импедансы или адмитансы на круговой диаграммет  

Полярный Отображает величины и углы измеряемых величин  

Гистограм ы Отображает измеряемые величины в виде гистограммы м

Антенная диаграмма авленности Отображает измеряемые величины в виде диаграммы напр

Таблица Отображает измеряемые величины в виде таблицы, обычно по частоте  
Чтобы определит  мышки 

по имен

становка частот для анализа и выполнение моделирования. 

Замечание. Чтобы выполнить моделирование активного проекта, нажмите значок Analyze

ь, какие данные вы хотите видеть на графике, щёлкните правой кнопкой
и нового графика в окне просмотра проекта и выберите Add Measurement во всплывающем 

меню. Откроется диалоговое окно, в котором можно выбрать необходимое из списка измеряемых 
величин. 
 
У

  
на панели инструментов. 
 
Чтобы установить частоты для моделирования, дважды щёлкните по группе Options (Опции) в 

окне пр

icrowave Office выполнит моделирование, автоматически выполняя соответствующий метод 
моделир

После окончания моделирования, 
результа ных 

ного 

ике при 
а 

ры 

ти 

раметров. 

осмотра проектов или выберите Options>Project Options из выпадающего меню. Откроется 
диалоговое окно, в котором можно определить частоты для моделирования. 

 
M
ования для различных частей проекта, т. е. линейное моделирование, гармонический баланс, 

моделирование нелинейными рядами Вольтера, или 3-х мерное моделирование электромагнитной 
структуры. 

Рис. 1.10 

ты можно просматривать на создан
графиках (рис. 1.10) и затем настраивать и/или 
оптимизировать при необходимости. Блок 
настройки Microwave Office в режиме реаль
времени позволяет сразу же наблюдать 
изменение выходных параметров на граф
изменении параметров схемы движком тюнер
или при проведении оптимизации. При 
настройке или оптимизации автоматически 
изменяется схема, электромагнитные структу
и связанные с изменяемыми параметрами 
элементы топологии. Если теперь произвес
повторное моделирование, то анализ 
производится с учётом изменённых па

 



Замечание. Для настройки электрической цепи нажмите значок Tune Tool  на панели 
инструментов и выберите параметры, которые вы желаете настроить. Затем нажмите значок 

Tuner,  чтобы их настроить. 

1.5 Сценарии и мастера 
Сценарии и мастера – это новые особенности, которые позволяют автоматизировать и 

расширить функциональные возможности Microwave Office. 
Сценарии – это программы Basic, которые пользователи могут записывать, чтобы, например, 

автоматизировать задачи формирования схемы в Microwave Office. 
Мастера – это файлы динамически загружаемых библиотек (DLL), которые можно использовать, 

как добавочные инструментальные средства, например, для синтеза фильтров. 
Сценарии и мастера отображаются как группы в окне просмотра проекта. 

1.6 Помощь 
Страницы помощи Microwave Office обеспечивают необходимую информацию об окнах, 

пунктах меню, диалоговых окнах, а так же обо всех элементах Microwave Office. 
Для получения справки выберите Help из выпадающего меню или нажмите клавишу F1, чтобы 

отобразить справочное меню. 
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2. Линейное моделирование 
Линейное моделирование для определения характеристик электрической цепи использует метод 

узловых напряжений. Оно может применяться для цепей типа усилителей в линейном режиме, фильтров, 
направленных ответвителей, делителей мощности и других, чьи элементы могут быть описаны матрицей 
полных проводимостей. Для линейного моделирования характерно определение измеряемых величин 
типа усиления, устойчивости, коэффициента отражения, коэффициента передачи. 

В блок линейного программирования включён блок настройки в реальном масштабе времени, 
который позволяет настраивать элементы схемы и сразу наблюдать результаты настройки. Имеется 
возможность также выполнить оптимизацию различными методами. 

Следующие примеры иллюстрируют некоторые из основных особенностей линейного 
моделирования в Microwave Office. 

2.1. Моделирование ФНЧ на сосредоточенных элементах 
Этот пример показывает, как использовать Microwave Office для моделирования ФНЧ на 

базовых сосредоточенных элементах, используя линейное моделирование. Такое моделирование 
включает следующие основные шаги: 

 
o Создание схемы; 
o Добавление графиков и измеряемых величин; 
o Анализ схемы; 
o Настройка схемы; 
o Создание переменных для оптимизации; 
o Оптимизация схемы. 

 
Создание нового проекта. 

 
Сначала нужно создать новый проект. Для его создания сделайте следующее: 
 

1. Выберите File > New Project (Файл > Новый проект) в выпадающем меню. 
2. Выберите File > Save Project As (Файл > Сохранить проект как) в выпадающем меню. 

Откроется диалоговое окно Save As. 
3. Наберите имя проекта (например, linear-example) и нажмите Сохранить. 

 
Примечание. По умолчанию Microwave Office обычно предлагает сохранить проект в папке 
Мои документы. Чтобы изменить папку, предлагаемую по умолчанию, нажмите Options 
(Опции) в выпадающем меню и выберите Environment Options… (Опции среды…). Нажмите на 
панель File Locations (Размещение файлов) в верхней части открывшегося окна и в текстовом 
поле Default Design Directory: (Директория, назначаемая по умолчанию:) введите путь к нужной 
папке, например, E:\USER\MWOFFICE, или нажмите кнопку Browse (Просмотр) справа от этого 
поля и выберите нужную папку. 
 

Установка единиц измерения, используемых по умолчанию. 
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пользоваться 
Чтобы установить единицы 

измерения, которые будут ис
в проекте по умолчанию: 
 

1. Выберите Options > 
Project Options (Опции > 
Опции проекта) в выпадающем 
меню. Откроется диалоговое 
окно Project Options. 

2. Нажмите панель Global 
Options (Глобальные опции) в 
верхней части диалогового 
окна. 

3. Установите нужные 
единицы измерения, щёлкая по 
стрелкам, справа от поля ввода 
соответствующей единицы так, 
чтобы они соответствовали 
показанным на рис. 2.1, 



снимите флажок в поле Metric units (Метрические единицы), установите mil в поле Length 
type и нажмите OK. 

 
Создание схемы. 

 
Чтобы создать схему: 

 
1. Выберите Project > Add Schematic > New Schematic (Проект > Добавить схему > Новая 

схема) в выпадающем меню или щёлкните по значку New Schematic  на панели 
инструментов. Откроется диалоговое окно Create New Schematic (Создание новой 
схемы). 

2. Наберите имя схемы, например, lpf и нажмите OK. Откроется окно схемы на рабочем 
поле и схема появится, как подгруппа в группе Circuit Schematics (Схемы цепи) в окне 
просмотра проекта. 

 
Размещение элементов в схеме. 

 
Чтобы разместить элементы в схеме: 

 
 

1. Нажмите панель 
Elem в нижней части левого 
окна, чтобы открыть окно 
просмотра элементов (см. 
рис. 2.2). 
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2. Разверните группу 
сосредоточенных элементов 
(Lumped Element), щёлкн
по значку + слева от этой 
группы. 

ув 

подключая каждую индуктивность, как показано на рисунке 2.3. 

римечание. Чтобы соединить один элемент с другим элементом, вы должны поместить 

ть 

6. Теперь щёлкните по 
по у

а 
а 

ов. 

ко н

щёлкните прав  
повернуть элемент, поместите его, как показано на рисунке 2.4 и зафиксируйте, щёлкнув левую 
кнопку мышки. 

3. Щёлкните левой 
кнопкой мышки по 
подгруппе Индуктивности 
(Inductor) в окне просмотра 
элементов. В нижней части 
окна появятся изображения 
доступных индуктивностей. 

4. Нажмите левой кнопкой мышки на модель индуктивности IND и, не отпуская кнопки 
мышки, перетащите её в окно схемы. Отпустите кнопку мышки, поместите элемент, как 

показано на рисунке 2.3 и 
зафиксируйте, щёлкнув 
левую кнопку мышки. 

5. Повторите шаг 4 три 
раза, совмещая и 

 
П
элемент так, чтобы его узел присоединился к узлу другого элемента. При правильном 
соединении узел отображается в виде маленького синего квадрата. Если сразу соедини
элементы не удалось, нажмите нужный элемент левой кнопкой мышки и, не отпуская 
кнопки, переместите элемент в надлежащее место. 

 

дгр ппе Конденсаторы 
(Capacitor) в окне просмотр
элементов. В нижней части окн
появятся изображения 
доступных конденсатор

7. Нажмите на модель 
нде сатора CAP и, не 

отпуская кнопки мышки, 
ой кнопкой мышки, чтобыперетащите её в окно схемы, отпустите кнопку, 
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 полосы скроллинга справа и внизу окна схемы, чтобы отобразить в 
окне ту часть схемы, с которой вы работаете. 

 
Примечания. 

 Используйте

 Чтобы увеличить часть схемы, щёлкните по значку View Area  (Показать 
область) на панели инструментов, курсор будет отображаться в виде лупы с крестиком. 
Переместите курсор в окно схемы, поместите курсор крестиком в левый верхний угол 
уч тк шк кая ас а схемы, который надо увеличить, нажмите на левую кнопку мы и и, не отпус
кнопки, переместите курсор в правый нижний угол выделяемого участка (выделяемая 
часть схемы будет обводиться прямоугольником). Отпустите кнопку мышки. 

 Чтобы уменьшить изображение схемы, щёлкните по значку Zoom Out  
(Уменьшить масштаб) на панели инструментов. 

 Чтобы отобразить всю схему, щёлкните по значку View All  (Показ вс
панели инструментов. 

ать ё) на 

 Чтобы удалить элемент из схемы, щелкните левой кнопкой мышки по этому 
эл ен

 
8. в о на 

рис
 
Соединен п

 клеммы конденсаторов: 
рсор возле нижней клеммы первого конденсатора C1. Курсор будет 

отображаться в виде соленоида, как показано на рисунке 2.5. 
й кнопкой мышки, чтобы зафиксировать 

 
Размещ

 
Чтобы разместить порты (входы): 

 
1. Выберите Schematic > 

Add Port (Схема > Добавить 
порт) в выпадающем меню или 
щё и 

ем ту в схеме и нажмите клавишу Delete. 

По торите шаг 7 дважды, совмещая и соединяя каждый конденсатор, как показан
унке 2.4. 

ие роводом. 
 

Чтобы соединить нижние
1. Поместите ку

2. Щёлкните (т. е. нажмите и отпустите) лево

начало провода, перетащите курсор к нижней клемме второго конденсатора С2, затем к нижней 
клемме последнего конденсатора C3 и снова щёлкните левой кнопкой мышки (см. рис. 2.6). 

ение портов. 

лкните левой кнопкой мышк

по значку Add Port  на 
панели инструментов. 

2. Двигайте курсор в 
схемы, поместите порт на ле  
ки, чтобы зафиксировать ег

окно 
вой

кнопкой мыш о. 
3. Повторите шаги 1 и 2, чтобы подключить порт к последней

перемещения его в окно схемы, щёлкните два раза правой кноп

щ
 
 
 

клемме первой индуктивности и щёлкните левой 
 индуктивности, но после 

кой мышки, чтобы развернуть 
его на 180 градусов, подведите к правой клемме последней индуктивности и зафиксируйте, 
ёлкнув левой кнопкой (см. рис. 2.7). 
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азмещение земли. 

 землю: 

1. Выберите Schematic > Add Ground (Схема > Добавить землю) в выпадающем меню или 

 мышки по значку Add Ground

Р
 

Чтобы поместить
 

  щёлкните левой кнопкой на панели инструментов. 

зафиксируйте
 
Редактир

 
Чтобы отредактировать параметры элементов: 

1. Поместите курсор на элемент IND L1 (на катушку) в окне схемы. Курсор должен 
лкните левой кнопкой мышки, откроется 

диалоговое окно Element Options (Опции элемента) 

ения 
индуктивности (L), введите 
15 о чение) 

е 

 
Примеча
щёлкнуть
ачению параметра в схеме (в 

1 nH 

значение параметра непосредственно в схеме. 
 

, 
чт рисунке 2.8. (Чтобы редактировать ёмкости, 
выберите C в окне списка параметров). 

 
Задание

Чтобы задать частоты для моделирования: 
 

1. Нажмите панель 
Proj в нижней части левого 
окна, чтобы открыть окно 
пр

От  

eqency 

00 в поле 
St

 
ча

 
 

 шаг 

ать, щёлка  
 Tab. 

 

2. Двигайте курсор к схеме, поместите землю на нижней клемме конденсатора C1 и 
, щёлкнув левой кнопкой мышки (см. рис. 2.7). 

ование параметров элементов. 

 

отображаться в виде перекрестия. Дважды щё

2. Нажмите на 
текстовое поле знач

 в п ле Value (Зна
и нажмите OK. Изменени
будет отражено на схеме. 

ние. Можно дважды 
 левой кнопкой мышки по 

зн
данном случае по параметру L=
я, которое позволяет изменить 

3. По аналогии с шагами 1 и 2 редактируйте значения индуктивностей и емкостей так
обы их значения были такими, как показано на 

индуктивности ID=L1). Откроется окно редактировани

 частот для моделирования. 
 

осмотра проекта. 
2. Дважды щёлкните 

по группе Project Options 
(Опции проекта). 

кроется диалоговое окно
Project Options. 

3. Нажмите Fr
Values (Значения частот). 

4. Наберите 1
art (Начальная частота), 

1000 в поле Stop (Конечная
стота) и 10 поле Step 

(Шаг). Нажмите Apply 
(Применить). В окне 
Current Range (Текущий
диапазон) отображается
частотный диапазон и

я левой кнопкой мышки по
нужному полю или нажимая клавишу

по частоте (см. Рис. 2.9). Нажмите OK. 
 
Примечание. Переход между полями ввода можно дел
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Создание

афик: 
 

1. Щёлкните правой 
кнопкой мышки по 
группе Graphs 
(Г

 
raph 
во 

ли 
dd 

 графика. 
 

Чтобы создать гр

рафики) в окне 
просмотра проекта и
выберите Add G
(Добавить график) 
всплывающем меню и
щёлкните по значку  A

Graph . Откроется 

ите радиокнопку 
фика) и мите OK. 

График отображается в окне на рабочем поле и появл

диалоговое окно Create Graph (Создание графика). 
2. Наберите S21 and S11 в поле Graph Name (Имя графика). Выбер

Rectangular (Прямоугольный) в переключателе Graph Type (Тип гра наж
яется как подгруппа в группе Graph в 

ок
 
Добавл

 
: 

 
1. Щёлкните правой 

кнопкой мышки по 
подгруппе S21 and S11 в 
ок  

. 
о 

иска с 
по о eas 

 с полосо
Measurement (Измеряемая величина). Выберите lpf (т.е. имя схемы ле 
Data Source Name (Имя источника данных, т. е. имеется ввиду имя 

го порта), 

g 

 
11 в окне просмотра проекта. 

 
Анализ сх ы
 

лнить анализ схемы: 

1. Выберите Simulate > Analyze (Моделирование > Анализ) в выпадающем меню или 

щёлкните левой кнопкой мышки по значку Analyze

не просмотра проекта (см. рис. 2.10). 

ение измеряемых величин. 

Чтобы добавить измеряемые величины

не просмотра проекта и
выберите Add 
Measurement (Добавить 
измеряемую величину) во 
всплывающем меню
Откроется диалоговое окн
Add Measurement (см. 
рис. 2.11). 

2. Выберите Port 
Parameters (Параметры 
порта) в окне сп
лос й скроллинга M

й скроллинга 
, которое вы ей дали) в по
схемы), нажимая на 

стрелку, справа от этого поля. Выберите 1 как в поле To Port Index (Индекс входно
так и в поле From Port Index (Индекс выходного порта), нажимая на стрелки, справа от этих 
полей. Отметьте DB в области Result Type (Тип результата) и отметьте радиокнопку Ma
(Модуль) в переключателе Complex Modifier (Представление комплексной величины) и 
нажмите Apply (Применить). 

3. Измените значение в поле To Port Index на 2 и нажмите Apply. 
4. Нажмите OK. Измеряемые величины lpf.DB(|S[1,1]|) и lpf.DB(|S[2,1]|) появятся как

подгруппы в группе S21 and S

Type (Тип измеряемых величин). Выберите S в окне списка

ем . 

Чтобы выпо
 

  на панели инструментов. 
Результаты анализа отображаются на графике рис. 2. 12. 
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Примечания. 
 На графике в 

прямоугольнике 
отображается, какая 
кривая какой измеряемой 
величине соответствует. 
Размеры этого 
прямоугольника можно 
изменять, если установить 
курсор на ромбик в 
середине любой стороны 
или на квадратик в углу 
(курсор при этом должен 
отображаться в виде 
двойной стрелки), нажать 
левую кнопку мышки и, не 
отпуская её, двигать 
курсор. Весь этот 

прямоугольник можно переместить в любое место графика, если поместить курсор в 
прямоугольник (курсор при этом должен отображаться в виде перекрестия) и затем, нажав 
левую кнопку мышки и не отпуская её, двигать курсор. 

 При желании можно распечатать график, нажав левой кнопкой мышки на значок 
Print на панели инструментов при активном окне схемы. 

 
Настройка схемы. 
 

Примечание. Когда вы помещаете инструмент настройки поверх элемента схемы, курсор 
отображается как перекрестие, что указывает на то, что параметр можно настроить, используя 
команду Simulate > Tune (Моделирование > Настройка) в выпадающем меню. 

Чтобы настроить схему: 
 

1. Щёлкните по окну 
схемы, чтобы сделать его 
активным. 

2. Сначала нужно указать, 
параметры каких элементов 
необходимо изменять при 
настройке. Чтобы сделать это, 

щёлкните по значку Tune Tool  
(Инструмент настройки) на панели 
инструментов. 

3. Поместите курсор на параметр 
L индуктивности L1. Курсор должен 
отображаться в виде перекрестия, как 
показано на рис. 2. 13 (белое 
перекрестие в чёрном кружке). 

4. Щёлкните левой кнопкой 
мышки, чтобы активизировать 
параметр L для настройки. 

5. Повторите шаги со 2-го по 4-ый 
для конденсаторов C1, C3 и 
индуктивности L4 (значения этих 
параметров будут отображаться синим 
цветом). 

6. Щёлкните по окну графика, чтобы сделать его активным. 

7. Выберите Simulate > Tune в выпадающем меню или щёлкните по значку Tune на 
панели инструментов. Откроется диалоговое окно Variable Tuner (Блок настройки 
переменных), показанное на рис. 2.14. 

8. Нажмите левой кнопкой мышки на бегунок настройки и, не отпуская кнопки, двигайте 
его вверх и вниз. Результаты настройки переменных наблюдайте на графике. 



9. Передвиньте бегунки настройки переменных в положения, указанные на рисунке 2.14, и 
посмотрите результаты настройки на графике. 

10. Закройте окно Variable Tuner. 
 
Создание переменных параметров для оптимизации. 
 

Фильтры – это типично симметричные схемы. Т.е. в процессе оптимизации параметры 
симметричных элементов должны изменяться на одинаковую величину. Поэтому оптимизируемый 
параметр каждой пары тех симметричных элементов, которые должны быть включены в процесс 
оптимизации, нужно заменить одним общим переменным параметром. Для этого сначала необходимо 
создать такой переменный параметр для каждой пары оптимизируемых симметричных параметров и 
затем заменить созданным параметром соответствующие параметры у обоих симметричных элементов. 
Для среднего элемента, если он в схеме один (в данном случае конденсатор C2) это делать не 
обязательно. 

Чтобы создать переменные параметры: 
 

1. Щёлкните по окну схемы, чтобы сделать его активным. 
2. Выберите Schematic > Add Equation (Схема > Добавить уравнения) в выпадающем 

меню или щёлкните по значку 

Add Equation  на панели 
инструментов. 

3. Переместите курсор на 
схему. Появится окошко 
редактора в виде небольшого 
квадрата. 

4. Поместите окошко 
редактора в верхнюю часть 
схемы и щёлкните левой 
кнопкой мышки, чтобы 
зафиксировать его. 

5. Наберите Lin=15 в окне редактора и щёлкните мышкой 
вне этого окна. 
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6. Повторите шаги со 2-го по 5-ый, чтобы открыть второе 
окно редактора, но наберите Cin=8, и щёлкните мышкой вне 
этого окна. Результат показан на рис. 2.15. 

7. Дважды щёлкните по параметру L значения 
индуктивности IND L1. Появится окно редактора. Наберите 
значение Lin. 

8. Повторите шаг 7, чтобы заменить параметр L 
индуктивности IND L4 на Lin, и параметры конденсаторов 
CAP C1 и CAP C3 на Cin, как показано на рисунке 2.15. 
Переменные Lin и Cin разрешены для оптимизации. 

9. Нажмите левой кнопкой мышки панель Var 
(Переменные) в нижней части левого окна. 

10. Щёлкните левой кнопкой мышки по символу +, чтобы 
раскрыть группу lpf (см. рис. 2.16). 

11. Щёлкните левой кнопкой мышки по lpf Equations 
(Уравнение lpf). В нижнем окне отображаются переменные Cin 
и Lin. 

12. Щёлкните левой кнопкой мышки переключатель 0 для 
обоих переменных. 

13. Щёлкните левой кнопкой мышки группу lpf в верхнем 
окне и щёлкните переключатель 0, соответствующий C2. 

 
Примечание. Выбор переключателя 0 указывает на то, что эта 

переменная должна изменяться при оптимизации. Для пары симметричных элементов схемы 
это делается в подгруппе lpf Equations. Если элемент в схеме не имеет симметричной пары 
(как конденсатор C2), то он включается в оптимизацию установкой 0 в группе lpf. Если в lpf 
установить 0 для симметричных элементов, то, видимо, при оптимизации их параметры 
будут изменяться не одинаково, что нарушит симметричность схемы. 

 
 
 
 



Добавление цели оптимизации. 
 
Под целью оптимизации подразумевается некоторая граница изменения какой-либо 

характеристики анализируемой схемы, к которой должен стремиться выбранный метод оптимизации при 
изменении определённых параметров элементов. 

 
Примечание. Всякий раз, когда вы устанавливаете цель оптимизации, она определяется в тех же 
самых модулях, в которых были ранее добавлены единицы измерения. 
 
Чтобы добавить цели оптимизации: 
 

1. Нажмите левой кнопкой мышки панель Proj (Проект). 
2. Правой кнопкой мышки щёлкните по Optimization Goals (Цели оптимизации) и 

выберите Add Opt Goal (Добавить цели оптимизации) во всплывающем меню. Откроется 
диалоговое окно New 
Optimization Goal (Новая 
цель оптимизации) (см. 
рис. 2.17). 
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3. Выделите 
lpf:DB(|S[1,1]|) в окне 
списка измеряемых 
величин Measurement. 
Выберите радиокнопку 
Meas < Goal (Измеряемая 
величина < Цель) в поле 
Goal Type (Тип цели), 
уберите галочку возле 
переключателя Max в поле 
Range (Предел), введите 
500 в поле Stop, введите –
17 в поле Goal (Цель), и 
нажмите OK. 

4. Повторите шаги 2 и 
3, но выделите lpf: 
DB(|S[2,1]|) в окне списка 
измеряемых величин, 
выберите радиокнопку 

Meas < Goal в поле Goal Type, уберите галочку возле переключателя Max в поле Range, 
введите 500 в поле Stop, введите –1 в поле Goal и нажмите OK. 

5. Повторите шаги 2 и 3 снова, но введите lpf: DB(|S[2,1]|) в окне списка измеряемых 
величин, выберите радиокнопку Meas < Goal в поле Goal Type, уберите галочку возле 
переключателя Min в поле Range, введите 700 в поле Start, введите –30 в поле Goal и нажмите 
OK. 

 
Примечание. Ведённые значения означают следующее: 

 500 MHz – это верхняя (максимальная) частота полосы пропускания, 700 MHz – это 
нижняя (минимальная) частота полосы заграждения. 

 -17 – желательное предельное значение коэффициента отражения S11 в полосе 
пропускания; -1 – желательное предельное значение коэффициента передачи S21 в полосе 
пропускания. 

 -30 – желательное предельное значение коэффициента передачи S21 в полосе 
заграждения. 

 
Цели оптимизации отображаются на графике в виде границ со штриховкой (см. рис. 2.18) и 

могут быть изменены или повторным вызовом диалогового окна New Optimization Goal и введением 
новых значений, как описано выше в пунктах 1 – 5, или непосредственно на графике. Чтобы изменить 
цели оптимизации непосредственно на графике, щёлкните по нужной цели левой кнопкой мышки. Затем 
поместите курсор на заштрихованный участок цели на графике (курсор отображается в виде 
перекрестия), или поместите курсор на квадратик в уголке цели (курсор отображается в виде двойной 
стрелки), нажмите левую кнопку мышки и, не отпуская её, двигайте в нужном направлении. Изменять 
цель при этом можно как по величине параметра, так и по частоте  
 
 
 
 



Оптимизация схемы. 
 

Чтобы выполнить оптимизацию: 
 

1. Выберите Simulate > Optimize (Моделирование > Оптимизация) в выпадающем меню. 
Откроется диалоговое окно Optimize. 

2. Выберите Random (Local) (Случайный (Локальный)) в поле Optimization Methods 
(Методы оптимизации), наберите 5000 в поле Maximum Iteration (Максимум итераций), 
щёлкая по стрелке справа от поля, и нажмите Start, чтобы начать оптимизацию. 

3. Когда оптимизация закончится, нажмите Close (Выход), чтобы выйти из диалогового 
окна Optimize. Результаты оптимизации отображаются на графике и на схеме, как показано на 
рисунках 2.18 и 2.19. 

 
 
 

 
 

В заключение вы можете, при желании, сохранить вашу работу, выбрав File > Save Project 
(Файл > Сохранить проект) в выпадающем меню. 

2.2. Моделирование микрополоскового заграждающего фильтра 
 

Создание нового проекта. 
 
Сначала нужно создать новый проект. Для его создания сделайте следующее: 
 

1. Выберите File > New Project (Файл > Новый проект) в выпадающем меню. 
2. Выберите File > Save Project As (Файл > Сохранить проект как) в выпадающем меню. 

Откроется диалоговое окно Save As. 
3. Наберите имя проекта (например, Fil-z) и нажмите Сохранить. 

 
Установка единиц измерения, используемых по умолчанию. 

 
Установите единицы измерения, которые будут использоваться по умолчанию, как описано в 

примере 2.1, но для частоты установите GHz и поставьте флажок в поле Metric units. 
 

Создание схемы. 
 
Чтобы создать схему: 

 

1. Щёлкните по значку New Schematic  на панели инструментов. 
2. Наберите имя схемы, например, zfil и нажмите OK. 
 

Размещение элементов в схеме. 
 

1. Нажмите панель Elem в нижней части левого окна. 
2. Щёлкните по значку + слева от группы Microstrip (Микрополоска) в окне просмотра 

элементов. 
3. Щёлкните по подгруппе Lines (Линии) в окне просмотра элементов. 
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4. Найдите модель MLIN, пользуясь полосой скроллинга, переместите её в окно схемы и 
зафиксируйте, щёлкнув левой кнопкой мышки. 

5. Щёлкните по подгруппе Junction (Соединения) в окне просмотра элементов. 
6. Найдите модель MTEE, переместите её окно схемы, подсоедините к правому концу 

элемента MLIN и зафиксируйте, щёлкнув левой кнопкой мышки. 
7. Щёлкните по подгруппе Lines (Линии) в окне просмотра элементов. 
8. Найдите модель MLEF, переместите её окно схемы, подсоедините к плечу 3 элемента 

MTEE и зафиксируйте, щёлкнув левой кнопкой мышки. 
9. Нажмите клавишу Shift и, не отпуская её, щелкните по очереди по моделям MLIN 

(ID=TL1), MTEE (ID=TL2) и MLEF (ID=TL3), затем отпустите клавишу Shift. 
10. Щёлкните по значку Copy (Копировать) на панели инструментов. 
11. Щёлкните по значку Paste (Вставить) на панели инструментов. 
12. Подключите скопированную группу к плечу 2 элемента MTEE (ID=TL2) и 

зафиксируйте её, щелкнув левой кнопкой мышки. 
13. Снова щёлкните по значку Paste на панели инструментов, подключите скопированную 

группу к плечу 2 элемента MTEE (ID=TL6) . и зафиксируйте её, щёлкнув левой кнопкой 
мышки. 

14. Щёлкните по подгруппе Lines (Линии) в окне просмотра элементов. 
15. Найдите модель MLIN, переместите её в окно схемы, подсоедините её к плечу 2 

последнего элемента MTEE (ID=TL6) и зафиксируйте её, щёлкнув левой кнопкой мышки. 
 
Размещение портов. 
 

1. Щёлкните по значку Add Port  на панели инструментов. 
2. Поместите порт на левом конце первого элемента MLIN. 
3. Снова щёлкните по значку Add Port на панели инструментов. 
4. Поместите порт на правом конце последнего элемента MLIN, предварительно развернув 

его на 180 градусов, щёлкая правой кнопкой мышки. 
 
Определение параметров подложки. 
 

1. Нажмите панель Elem в нижней части левого окна. 
2. Щёлкните по группе Substrates (Подложки) в окне просмотра элементов. 
3. Перетащите элемент MSUB в окно схемы, поместите его на свободном месте, например, 

ниже схемы. 
4. Дважды щёлкните по элементу MSUB в окне схемы. Откроется окно редактирования. 

Введите: 
 Er=10.8 – относительная диэлектрическая проницаемость; 
 H=0.5 – толщина подложки; 
 T=0.01 – толщина проводника; 
 Rho=1 – удельное сопротивление металла проводника, нормированное к золоту; 
 Tang=0 – тангенс угла потерь; 
 ErNom=10.8 – номинальная диэлектрическая проницаемость; 
 Name=SUB1 – имя подложки. 

 
Редактирование параметров элементов. 
 

1. Щёлкните по первому элементу MLIN, чтобы его выделить, затем дважды щёлкните по 
этому элементу. В открывшемся окне введите W=0.48 mm (т.е. введите 0.48 в поле Value 
параметра W) и нажмите OK. 

2. Аналогично введите W=0.3 mm, L=1.3 mm для второго и третьего элементов MLIN; 
W=0.48 mm для последнего элемента MLIN. 

3. Щёлкните по первому элементу MTEE, затем дважды щёлкните по этому элементу. 
Введите W1=0.48 mm, W2=0.3 mm, W3=0.2 mm. 

4. Аналогично для второго элемента MTEЕ введите W1=0.3 mm, W2=0.3 mm, W3=0.2 mm. 
5. Аналогично для третьего элемента MTEЕ введите W1=0.3 mm, W2=0.48 mm, W3=0.2 

mm. 
6. Щёлкните по первому элементу MLEF, затем дважды щёлкните по этому элементу. 

Введите W=0.2 mm, L=1.3 mm. 
7. Аналогично введите W=0.2 mm, L=1.25 mm для второго элемента MLEF и W=0.2 mm, 

L=1.2 mm для третьего. 
 

Полученная схема показана на рис. 2.20. 
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Задание частот для моделирования. 
 

1. Нажмите панель Proj в нижней части левого окна, чтобы открыть окно просмотра 
проекта. 

2. Дважды щёлкните по группе Project Options (Опции проекта). Откроется диалоговое 
окно Project Options. 

3. Нажмите Freqency Values (Значения частот). 
4. Наберите 10 в поле Start (Начальная частота), 30 в поле Stop (Конечная частота) и 0.5 

поле Step (Шаг), отметьте Replace (Заменять), отметьте Linear (Линейная). Нажмите Apply 
(Применить). В окне Current Range (Текущий диапазон) отображается частотный диапазон и 
шаг по частоте. Нажмите OK. 

 
Создание графика и добавление измеряемых величин. 
 

1. Щёлкните по значку Add Graph  на панели инструментов. 
2. Введите имя графика, например, Graph 1 в поле Graph name (Имя графика), выберите 

Rectangular (Прямоугольный) в области Graph Type (Тип графика) и нажмите OK. 
3. Нажмите панель Proj в нижней части левого окна. 
4. Щёлкните правой кнопкой мышки по подгруппе Graph 1 в окне просмотра проекта и 

выберите Add Measurement. 
5. Выберите Port Parameter в списке Meas. Type, S в списке Measurement, zfil в поле 

Data Source Name, 1 в полях To Port Index (Индекс входного порта), и From Port Index 
(Индекс выходного порта), нажимая на стрелки справа от этих полей, отметьте DB в области 
Result Type и Mag в области Complex Modifier, нажмите Apply. 

6. Выберите 2 в поле To Port Index и нажмите Apply. 
7. Нажмите OK. 

 
Анализ схемы. 

1. Щёлкните левой 
кнопкой мышки по 
значку Analyze 

 на панели 
инструментов. 
Результаты анализа 
отображаются на 
графике рис. 2. 21. 
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Вывод результатов в файл. 
 

1. Нажмите на панель Proj в нижней 
части левого окна. 

2. Щёлкните правой кнопкой мышки 
по группе Output Files (Выходные 
файлы). 

3. Выберите Add Port Parameter 
(Добавить параметр порта), откроется 
окно (см. рис. 2.22) Output Data File 
(Выходной файл данных). 

4. Выберите S Parameter в области 
Data Type (Тип данных). Выберите 
Mag/Ang в области Format. 

5. Нажмите на панель Set file 
name…(Установить имя файла…). 

6. В открывшемся окне укажите 
папку, где сохранить файл, и наберите 
имя файла или согласитесь с 
предлагаемым по умолчанию. 

7. Нажмите Сохранить. 
8. Нажмите OK в окне Output Data 

File. 
Вывод топологии в файл. 

 
1. Щёлкните левой кнопкой по 

значоку New Layout View (Показать 

новую топологию)  на панели 
инструмертов, чтобы открыть окно 
топологии на рабочем поле. 
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2. Нажмите Layout (Топология) в 
выпадающем меню и выберите 
Export Layout (Экспорт топологии). 
Откроется диалоговое окно 
Сохранение (рис. 2.23). 

3. Выберите DXF[DXF F
в поле Тип файла, щёлкнув стрелку
справа от этого поля. 

4. 

lat,*.dxf] 
 

Наберите имя файла, например, zfil в поле Имя файла. 
адо сохранить файл. 

 
ри желании можно сохранить проект, выбрав File > Save Project (Файл > Сохранить проект) в 

выпадаю

Создание нового проекта. 

начала нужно создать новый проект. Для его создания сделайте следующее: 

1. Выберите File > New Project (Файл > Новый проект) в выпадающем меню. 
ем меню. 

От
ажмите Сохранить. 

 
становка единиц измерения, используемых по умолчанию. 

Установите единицы измерения, которые будут использоваться по умолчанию, как описано в 
примере

5. В поле Папка введите путь к нужной папке, в которой н
6. Нажмите Сохранить. 

П
щем меню. 

2.3. Моделирование микрополоскового аттенюатора на 
резисторах 
 

 
С
 

2. Выберите File > Save Project As (Файл > Сохранить проект как) в выпадающ
кроется диалоговое окно Save As. 
3. Наберите имя проекта At20 и н

У
 

 2.2. 
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оздание схемы. 

1. Щёлкните по значку New Schematic  на панели инструментов. 

го окна. 
окне просмотра элементов. 

 её в окно схемы и 
за с

мпоненты) в окне просмотра элементов. 

по ю  

авишу Shift и, не отпуская её, щёлкните левой кнопкой мышки по элементам 
MLIN

те по значку Copy и затем по значку Paste на панели инструментов. 
равому 

вы

рованные элементы к правому 
вы

ючите её к правому выводу 
по

View All на панели инструментов, чтобы видеть всю схему. 
 
азмещение портов. 

1. Щёлкните по значку Add Port  на панели инструментов. 

ов. 
едварительно развернув 

ег
 
едактирование параметров элементов. 

1. Щёлкните левой кнопкой мышки по первому проводнику ID=TL1, чтобы выделить его, 
за  

следнего проводника ID=TL9. 
ы 

щ m, 

 такие же параметры введите для предпоследнего проводника ID=TL7. 

щ , 

те левой кнопкой мышки по первому резистору ID=TL2, затем дважды 
щ , 

ие же параметры введите для предпоследнего резистора ID=TL8. 
=0.4, 

L= 1
 
пределение параметров подложки. 

1. Нажмите панель Elem в нижней части левого окна. 
осмотра элементов. 

те, например, 
ни с

 щёлкните по элементу MSUB в окне схемы. Откроется окно редактирования. 
Вв

Er=10.55 – относительная диэлектрическая проницаемость; 

С
 

2. Наберите имя схемы atr20 и нажмите OK. 
3. Нажмите панель Elem в нижней части лево
4. Щёлкните по значку + слева от группы Microstrip в 
5. Щёлкните по подгруппе Lines в окне просмотра элементов. 
6. Найдите модель MLIN, пользуясь полосой скроллинга, переместите
фик ируйте, щёлкнув левой кнопкой мышки. 
7. Щёлкните по подгруппе Components (Ко
8. Найдите модель TFR, переместите её в окно схемы, отпустите кнопку мышки, 
дкл чите модель к правому выводу элемента MLIN и зафиксируйте, щёлкнув левой

кнопкой мышки. 
9. Нажмите кл

 и TFR. 
10. Щелкни
11. Переместите курсор в окно схемы, подключите скопированные элементы к п
воду элемента TFR и щёлкните левой кнопкой мышки, чтобы зафиксировать их. 
12. Щелкните по значку Paste на панели инструментов. 
13. Переместите курсор в окно схемы, подключите скопи
воду элемента TFR и щёлкните левой кнопкой мышки, чтобы зафиксировать их. 
14. Повторите п. 12 и 13, чтобы подключить ещё одну пару элементов. 
15. Щёлкните по подгруппе Lines в окне просмотра элементов. 
16. Найдите модель MLIN, переместите её в окно схемы и подкл
следнего элемента TFR. 
17. Щелкните по значку 

Р
 

2. Поместите порт на левом конце первого элемента MLIN. 
3. Снова щёлкните по значку Add Port на панели инструмент
4. Поместите порт на правом конце последнего элемента MLIN, пр
о на 180 градусов, щёлкая правой кнопкой мышки. 

Р
 

тем дважды щёлкните по этому проводнику. Откроется диалоговое окно Element Options. 
2. Введите W=0.456 mm, L=5 mm и нажмите OK. 
3. Аналогично такие же параметры введите для по
4. Щёлкните левой кнопкой мышки по второму проводнику ID=TL3, затем дважд
ёлкните по этому проводнику и, в открывшемся окне, введите W=1.009 mm, L=2.022 m

нажмите OK. 
5. Аналогично
6. Щёлкните левой кнопкой мышки по среднему проводнику ID=TL5, затем дважды 
ёлкните по этому проводнику и, в открывшемся окне, введите W=1.883 mm, L=1,953 mm

нажмите OK. 
7. Щёлкни
ёлкните по этому проводнику и, в открывшемся окне, введите W=0.4 mm, L=0.545 mm

RS=50, нажмите OK. 
8. Аналогично так
9. Аналогично для двух средних резисторов ID=TL4 и ID=TL6 введите параметры W
0.2 5, PS=50. 

О
 

2. Щёлкните по группе Substrates (Подложки) в окне пр
3. Перетащите элемент MSUB в окно схемы, поместите его на свободном мес
же хемы. 
4. Дважды
едите: 

 



 H=0.5 – толщина подложки; 
 T=0.02 – толщина проводника; 

е металла проводника, нормированное к золоту; 

электрическая проницаемость; 

 
Полученная схема показана на рис. 2.24. 

 Rho=1 – удельное сопротивлени
 Tang=0 – тангенс угла потерь; 
 ErNom=10.55 – номинальная ди
 Name=SUB1 – имя подложки. 

 
адание частот для моделирования. 

1. Нажмите панель Proj в нижней части левого окна, чтобы открыть окно просмотра 
пр т

ажды щёлкните по группе Project Options (Опции проекта). Откроется диалоговое 
ок P

cy Values (Значения частот). 
8 в поле Stop (Конечная частота) и 1 поле 

St Ш
азон и 

 
оздание графика и добавление измеряемых величин. 

1. Щёлкните по значку Add Graph на панели инструментов. 
e (Имя графика), выберите 

Re n

aph 1 в окне просмотра проекта и 
вы

er в списке Meas. Type, S в списке Measurement, atr20 в поле 
Da

сти 

 
нализ схемы. 

лкните левой кнопкой мышки по 

значку Analyze

З
 

оек а. 
2. Дв
но roject Options. 
3. Нажмите Freqen
4. Наберите 4 в поле Start (Начальная частота), 1
ep ( аг), отметьте Replace (Заменять), отметьте Linear (Линейная). Нажмите Apply 

(Применить). В окне Current Range (Текущий диапазон) отображается частотный диап
шаг по частоте. Нажмите OK. 

С
 

2. Введите имя графика, например, Graph 1 в поле Graph nam
cta gular (Прямоугольный) в области Graph Type (Тип графика) и нажмите OK. 
3. Нажмите панель Proj в нижней части левого окна. 
4. Щёлкните правой кнопкой мышки по подгруппе Gr
берите Add Measurement. 
5. Выберите Port Paramet
ta Source Name, 1 в полях To Port Index (Индекс входного порта), и From Port Index 

(Индекс выходного порта), нажимая на стрелки, справа от этих полей, отметьте DB в обла
Result Type и Mag в области Complex Modifier, нажмите Apply. 

6. Выберите 2 в поле To Port Index и нажмите Apply. 
7. Нажмите OK. 

А
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1. Щё

  на панели 
а 

 
 

инструментов. Результаты анализ
отображаются на графике рис. 2. 25.

 
 
 
 
 
 
 
 



Создание выходных параметров и уравнений. 

Список параметров по умолчанию, которые могут быть определены при анализе схемы, 
перечис  обычно 

ходным 
парамет

етров 
схемы, о

11=atr20: |S[1,1]|, где atr20 – имя схемы. 

акая запись означает, что переменной S11 поставлен в соответствие модуль элемента S[1,1] 
матрицы о 

вать 

S11= atr20:S[1,1] 

 
аметим, что здесь все переменные являются комплексными числами. Затем необходимо 

определ я 

 
атем записать уравнение для определения коэффициента отражения по входу схемы: 

G=S11+S12*S21*Gn/(1-S22*Gn) 
 

, наконец, уравнение для определения KstU: 

KstU=(1+abs(G))/(1-abs(G)) 
 
еременную KstU можно использовать для построения графика, вывода в виде таблицы или в 

файл. 

римечание. Более подробно о переменных и уравнениях, а так же о синтаксисе уравнений, об 
я 

 
 этом примере мы 

рассмот U и 

1. Дважды щёлкните 

е 

 окне 

 
 

 
ut 

Equations. 

 

лены в списке Measurement в окне Add Measurement (см. рис. 2.11). Для линейных схем
в качестве выходных параметров выбирают S-параметры схемы. Но часто бывает удобнее определить не 
элементы S-матрицы, а другие параметры, например, KstU и/или рабочее ослабление Ldb. 

В Microwave Office имеется возможность добавить к имеющимся по умолчанию вы
рам другие параметры и уравнения для их определения. Делается это следующим образом. 
Определяется какая-либо переменная и ставится в соответствие одному из выходных парам
пределяемому в процессе анализа, например, какому-либо элементу S-матрицы. Это делается 

вводом выражения типа: 
 
S
 
Т
, т.е. переменной S11 присваивается значение элемента S[1,1]. При этом может быть присвоен

комплексное значение, или только его действительная часть, или только мнимая, или модуль. 
Определённую новую переменную S11 уже можно использовать в любом уравнении. Использо
непосредственно значение S[1,1] в уравнениях нельзя, т.к. это значение не связано ни с какой 
переменной. Например, чтобы определить и построить график KstU при работе схемы на 
несогласованную нагрузку, нужно определить следующие переменные: 

 

S12= atr20:S[1,2] 
S21= atr20:S[2,1] 
S22= atr20:S[2,2] 

З
ить коэффициент отражения от нагрузки, т.е. присвоить значение коэффициента отражени

некоторой переменной, например 
Gn=0.01+j*0.05 

З
 

И
 

П

 
П
операторах и функциях, которые можно использовать в уравнениях, см. Руководство пользовател
Microwave Office 2002. 

В
рим определение Kst

Ldb для схемы аттенюатора atr20 
при работе на согласованную 
нагрузку. 
 

левой кнопкой 
мышки по групп
Output Equations 
(Выходные 
уравнения) в
просмотра 
проекта. На
рабочем поле
откроется окно
уравнений Outp
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2. ion в выпадающем меню. Откроется диалоговое окно 

S, 
 

ните 

 
S11=atr20: |S[1,1]| 

 
Это означает, что переменной S11 поставлен в соответствие модуль элемента S-матрицы 

3.  > Output Equation в выпадающем меню. В открывшемся окне в 

е atr20, 

ние 
 

S21=atr20: |S[2,1]| 
 

Щёлкните левой кнопкой мышки в любом месте окна уравнений за пределами 

4. ation в выпадающем меню или щёлкните левой кнопкой мышки по 

5. ом окне появится поле ввода. Установите 
, 

6. авнение: 
 

KstU=(1+S11)/(1-S11) 
 

и щёлкните левой кнопкой мышки вне этого поля или нажмите клавишу Enter. 
й 

ку 

стите 
х 

8. ле вода 

Ldb=20*log10(1/S21) 

и щёлкните левой кнопкой мышки вне 
этог

Окончательный вид окна уравнений 
показан

Создание графика и добавление измеряемых величин. 

1. Щёлкните по значку Add Graph на панели инструментов. 
e (Имя графика), выберите 

Re n

Выберите Add > Output Equat
Add New Measurement Equation (Добавит новую измеряемую величину уравнения), 
показанное на рис. 2.26. В текстовом поле Variable name (Имя переменной) введите 
S11, в списке Meas. Type отметьте Port Parameters, в списке Measurement отметьте 
в поле Data Source Name введите atr20, щёлкая по кнопке справа от этого поля, введите
1 в оба поля To Port Index и From Port Index, щёлкая по кнопкам справа от этих полей, 
установите переключатель Mag в области Complex Modifier, снимите галочку в 
переключателях Complex и DB области Result Type, если они установлены, щёлк
OK. В окне уравнений появится поле ввода с курсором в виде крестика. Двигая мышку, 
установите это поле в верхней части окна уравнений и щёлкните левой кнопкой мышки. 
Появится выражение 

S[1,1]. Щёлкните левой кнопкой мышки в любом месте окна уравнений за пределами 
выражения для S11. 
Снова выберите Add
текстовом поле Variable name введите S21, в списке Meas. Type отметьте Port 
Parameters, в списке Measurement отметьте S, в поле Data Source Name введит
щёлкая по кнопке справа от этого поля, введите 2 в поля To Port Index и 1 в поле From 
Port Index, щёлкая по кнопкам справа от этих полей, установите переключатель Mag в 
области Complex Modifier, снимите галочку в переключателях Complex и DB области 
Result Type, если они установлены, щёлкните OK. В окне уравнений появится поле 
ввода с курсором в виде крестика. Двигая мышку, установите это поле ниже 
предыдущего уравнения и щёлкните левой кнопкой мышки. Появится выраже

выражения для S21. 
Выберите Add > Equ
значку Equation на панели инструментов. 
Переместите курсор в окно уравнений. В эт
его, двигая мышкой, ниже предыдущего уравнения и щёлкните левой кнопкой мышки
чтобы зафиксировать. 
Введите в поле вода ур

7. Снова щёлкните лево
кнопкой мышки по знач
Equation на панели 
инструментов и поме
новое поле ниже предыдущи
уравнений. 
Введите в по
уравнение: 

 

 

о поля или нажмите клавишу Enter. 
 

 на рис. 2.27. 
 
 

 

2. Введите имя графика, например, Graph 2 в поле Graph nam
cta gular (Прямоугольный) в области Graph Type (Тип графика) и нажмите OK. 
3. Нажмите панель Proj в нижней части левого окна. 
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aph 2 в окне просмотра проекта и 
вы

tions в списке Meas. Type. В окне списка Equation Name 
вы plex 

 
нализ схемы. 

лкните левой 
о 

в. 

 

 
оздание нового проекта. 

1. Выберите File > New Project (Файл > Новый проект) в выпадающем меню. 
ем меню. 

О
жмите Сохранить. 

 
становка единиц измерения, используемых по умолчанию. 

становите единицы измерения, которые будут использоваться по умолчанию, как описано в 
примере

оздание эквивалентной схемы диода. 

1. Щёлкните по значку New Schematic на панели инструментов. 

о окна. 
ped Element), щёлкнув по значку + 

сл  
дгруппе Конденсаторы (Capacitor) в окне просмотра элементов. В 

ни е
ышки, перетащите её в 

ок с
ите по подгруппе Резисторы (Resistor) в окне просмотра элементов. В нижней 

части 
нопки мышки, перетащите её в окно 

схемы
нденсатора так, чтобы курсор отображался в 

ви

ните 
ле

4. Щёлкните правой кнопкой мышки по подгруппе Gr
берите Add Measurement. 
5. Выберите Output Equa
берите KstU, щёлкнув по кнопке справа. Отметьте переключатель Mag в области Com

Modifier. Уберите галочку в окне DB, если она установлена. Нажмите Apply. 
6. В окне списка Equation Name выберите Ldb и нажмите Apply. 
7. Нажмите OK. 

А
1. Щё

кнопкой мышки п
значку Analyze на 
панели инструменто
Результаты анализа 
отображаются на 
графике рис. 2. 28.

 
 
 
 
 
 
 
 
 
 
 

2.2. Моделирование микрополоскового 2-х диодного аттенюатора 

С
 

2. Выберите File > Save Project As (Файл > Сохранить проект как) в выпадающ
ткроется диалоговое окно Save As. 
3. Наберите имя проекта Atr и на

У
 
У
 2.1, но для частоты установите GHz и поставьте флажок в поле Metric units. 

 
С
 

2. Наберите имя схемы Diode и нажмите OK. 
3. Нажмите панель Elem в нижней части левог
4. Разверните группу сосредоточенных элементов (Lum
ева от этой группы. 
5. Щёлкните по по
жн й части окна появятся изображения доступных конденсаторов. 
6. Нажмите на модель конденсатора CAP и, не отпуская кнопки м
но хемы. 
7. Щёлкн

окна появятся изображения доступных резисторов. 
8. Нажмите на модель резистора RES и, не отпуская к

, поместите резистор ниже конденсатора. 
9. Поместите курсор возле левой клеммы ко
де соленоида. Щёлкните левой кнопкой мышки, чтобы зафиксировать начало провода, 

перетащите курсор к левой клемме резистора, и снова щёлкните левой кнопкой мышки. 
10. Аналогично соедините проводом правые клеммы конденсатора и резистора. Щёлк
вой кнопкой мышки по значку Add Port на панели инструментов. Переместите курсор в 



окно схемы, поместите порт слева от схемы и щёлкните левой кнопкой мышки, чтобы 
зафиксировать его. 

11. Снова щёлкните 
левой кнопкой мышки по 
значку Add Port на панели 
инструментов. Переместите 
курсор в окно схемы, два 
раза щёлкните правой 
кнопкой мышки, чтобы 
развернуть порт, поместите 
порт справа от схемы и 
щёлкните левой кнопкой 
мышки, чтобы 
зафиксировать его. 

12. Поместите курсор 
возле первого порта PORT 
P1 так, чтобы курсор 
отображался в виде 
соленоида. Щёлкните левой 

кнопкой мышки, чтобы зафиксировать начало провода, перетащите курсор к проводу, 
соединяющему конденсатор и резистор, и щёлкните левой кнопкой мышки, чтобы 
зафиксировать его. 

13. Аналогично подключите к схеме второй порт. Полученная эквивалентная схема диода 
показана на рис. 2.29. 

 
Примечание. Параметры взяты для диода 2А553В-3. 

 
Редактирование параметров элементов в эквивалентной схеме диода. 
 

1. Поместите курсор на элемент CAP (конденсатор) в окне схемы. Курсор должен 
отображаться в виде перекрестия. Дважды щёлкните левой кнопкой мышки, откроется 
диалоговое окно Element Options (Опции элемента). 

2. Нажмите на текстовое поле значения ёмкости (C), введите 0.025 в поле Value (Значение) 
и нажмите OK. Изменение будет отражено на схеме. 

3. Поместите курсор на элемент RES (резистор) в окне схемы. Дважды щёлкните левой 
кнопкой мышки, откроется диалоговое окно Element Options. 

4. Нажмите на текстовое поле значения резистора (R), введите 0.6 в поле Value (Значение) 
и нажмите OK. 

 
Создание схемы аттенюатора. 
 

1. Щёлкните по значку New Schematic на панели инструментов. 
2. Наберите имя схемы At и нажмите OK. 
3. Нажмите панель Elem в нижней части левого окна. 
4. Щёлкните по значку + слева от группы Microstrip в окне просмотра элементов. 
5. Щёлкните по подгруппе Lines в окне просмотра элементов. 
6. Найдите модель MLIN, пользуясь полосой скроллинга, переместите её в окно схемы и 

зафиксируйте, щёлкнув левой кнопкой мышки. 
7. Щёлкните по группе Subcircuits (Подсхемы) в окне просмотра элементов. 
8. Переместите подсхему Diode в окно схемы и соедините её с правым узлом отрезка 

линии. 
9. Щёлкните по элементу MLIN, затем нажмите клавишу Ctrl и щёлкните по элементу 

SUBCKT (т.е. по подсхеме), чтобы выделить оба этих элемента. 
10. Щёлкните по значку Copy и затем по значку Paste на панели инструментов, чтобы 

скопировать и вставить оба выделенных элемента. 
11. Переместите курсор в окно схемы и подсоедините скопированные элементы к правому 

узлу схемы. 
12. Щёлкните по элементу MLIN, затем щёлкните по значку Copy и по значку Paste на 

панели инструментов, чтобы скопировать и вставить выделенный элемент. 
13. Переместите курсор в окно схемы и подсоедините скопированный элемент к правому 

узлу схемы. 
14. Щёлкните левой кнопкой мышки по значку Add Port на панели инструментов. 

Переместите курсор в окно схемы, поместите порт слева на левый узел схемы и щёлкните 
левой кнопкой мышки, чтобы зафиксировать его. 
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15. Снова щёлкните левой кнопкой мышки по значку Add Port на панели инструментов. 
Переместите курсор в окно схемы, два раза щёлкните правой кнопкой мышки, чтобы 
развернуть порт, поместите порт на правый узел схемы и щёлкните левой кнопкой мышки, 
чтобы зафиксировать его. 

16. Щёлкните по группе Substrates (Подложки) в окне просмотра элементов. 
17. Перетащите элемент MSUB в окно схемы, поместите его на свободном месте, например, 

ниже схемы. Полученная схема аттенюатора показана на рис. 2.30. 
 
Редактирование параметров элементов в схеме аттенюатора. 

 
1. Щёлкните по первому элементу MLIN, чтобы его выделить, затем дважды щёлкните по 

этому элементу. В открывшемся окне введите W=0.46 mm (т.е. введите 0.46 в поле Value 
параметра W) и нажмите OK. 

2. Аналогично отредактируйте параметры всех элементов MLIN и подложки MSUB так, 
чтобы их значения соответствовали значениям, указанным на схеме рис. 2.30. 

 
Задание частот для моделирования. 
 

1. Нажмите панель Proj в нижней части левого окна, чтобы открыть окно просмотра 
проекта. 

2. Дважды щёлкните по группе Project Options (Опции проекта). Откроется диалоговое 
окно Project Options. 

3. Нажмите Freqency Values (Значения частот). 
4. Наберите 8 в поле Start (Начальная частота), 12 в поле Stop (Конечная частота) и 0.5 

поле Step (Шаг), отметьте Replace (Заменять), отметьте Linear (Линейная). Нажмите Apply 
(Применить). В окне Current Range (Текущий диапазон) отображается частотный диапазон и 
шаг по частоте. Нажмите OK. 

 
Создание выходных параметров и уравнений. 
 

1. Дважды щёлкните левой кнопкой мышки по группе Output Equations (Выходные 
уравнения) в окне просмотра проекта. На рабочем поле откроется окно уравнений Output 
Equations. 

2. Выберите Add > Output Equation в выпадающем меню. Откроется диалоговое окно 
Add New Measurement Equation (Добавить новую измеряемую величину уравнения), 
показанное на рис. 2.26. В текстовом поле Variable name (Имя переменной) введите S11, в 
списке Meas. Type отметьте Port Parameters, в списке Measurement отметьте S, в поле Data 
Source Name введите atr20, щёлкая по кнопке справа от этого поля, введите 1 в оба поля To 
Port Index и From Port Index, щёлкая по кнопкам справа от этих полей, установите 
переключатель Mag в области Complex Modifier, снимите галочку в переключателях Complex 
и DB области Result Type, если они установлены, щёлкните OK. В окне уравнений появится 
поле ввода с курсором в виде крестика. Двигая мышку, установите это поле в верхней части 
окна уравнений и щёлкните левой кнопкой мышки. Появится выражение 

 
S11=At: |S[1,1]| 

 
Это означает, что переменной S11 поставлен в соответствие модуль элемента S-матрицы S[1,1]. 
Щёлкните левой кнопкой мышки в любом месте окна уравнений за пределами выражения для 
S11. 
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3. Снова выберите Add > Output Equation в выпадающем меню. В открывшемся окне в 
текстовом поле Variable name введите S21, в списке Meas. Type отметьте Port Parameters, в 
списке Measurement отметьте S, в поле Data Source Name введите atr20, щёлкая по кнопке 
справа от этого поля, введите 2 в поля To Port Index и 1 в поле From Port Index, щёлкая по 
кнопкам справа от этих полей, установите переключатель Mag в области Complex Modifier, 
снимите галочку в переключателях Complex и DB области Result Type, если они установлены, 
щёлкните OK. В окне уравнений появится поле ввода с курсором в виде крестика. Двигая 
мышку, установите это поле ниже предыдущего уравнения и щёлкните левой кнопкой мышки. 
Появится выражение 

 
S21=At: |S[2,1]| 

 
Щёлкните левой кнопкой мышки в любом месте окна уравнений за пределами выражения для 
S21. 

4. Выберите Add > Equation в выпадающем 
меню или щёлкните левой кнопкой мышки по значку 
Equation на панели инструментов. 
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5. Переместите курсор в окно уравнений. В этом 
окне появится поле ввода. Установите его, двигая 
мышкой, ниже предыдущего уравнения и щёлкните 
левой кнопкой мышки, чтобы зафиксировать. 

6. Введите в поле вода уравнение: 
 

Ldb=20*log10(1/S21) 
 
и щёлкните левой кнопкой мышки вне этого поля или нажмите 

клавишу Enter. 
7. Снова щёлкните левой кнопкой мышки по значку Equation на панели инструментов и 

поместите новое поле ниже предыдущих уравнений. 
8. Введите в поле вода уравнение: 

 
KstU=(1+S11)/(1-S11) 

 
и щёлкните левой кнопкой мышки вне этого поля или нажмите клавишу Enter. 
 
Окончательный вид окна уравнений показан на рис. 2.31. 

 
Создание графика вносимого ослабления и KstU, добавление измеряемых величин 
и проведение анализа. 
 

1. Щёлкните по значку Add Graph на панели инструментов. 
2. Введите имя графика Loss в поле Graph name (Имя графика), выберите Rectangular 

(Прямоугольный) в области Graph Type (Тип графика) и нажмите OK. 
3. Нажмите панель Proj в 

нижней части левого окна. 
4. Щёлкните правой кнопкой 

мышки по подгруппе Lossв окне 
просмотра проекта и выберите 
Add Measurement. 

5. Выберите Output 
Equations в списке Meas. Type. В 
окне списка Equation Name 
выберите KstU, щёлкнув по 
кнопке справа. Отметьте 
переключатель Mag в области 
Complex Modifier. Уберите 
галочку в окне DB, если она 
установлена. Нажмите Apply. 

6. В окне списка Equation 
Name выберите Ldb и нажмите 
Apply. 

7. Нажмите OK. 
8. Щёлкните левой кнопкой мышки по значку Analyze на панели инструментов. 

Результаты анализа отображаются на графике рис. 2. 32. 
 



Настройка аттенюатора. 
 

1. Щёлкните по окну эквивалентной схемы диода, чтобы сделать его активным. 

2. Щёлкните по  значоку Tune Tool  (Инструмент настройки) на панели инструментов. 
3. Поместите курсор на параметр R резистора. Курсор должен отображаться в виде белого 

перекрестия в чёрном кружке. 
4. Щёлкните левой кнопкой мышки, чтобы активизировать параметр R для настройки. 
5. Щёлкните по окну схемы аттенюатора, чтобы сделать его активным. 
6. Щёлкните по  значоку Tune Tool на панели инструментов. 
7. Поместите курсор на параметр L (длина отрезка) среднего отрезка линии MLIN ID=TL2 

и щёлкните левой кнопкой мышки. Выделенные для настройки параметры должны 
отображаться синим цветом. 

8. Щёлкните 
по значку Tune 

на панели 
инструментов. 
Откроется 
Variable Tuner 
(Блок настройки 
переменных), 
показанный на 
рис. 2.33. В полях 
ввода Max и Min 
введите 
допустимые 
пределы 
регулировки 
резистора и 

длины отрезка, как показано на рис. 2.33. 
9. Щёлкните левой кнопкой мышки по окну графика Loss, чтобы сделать его активным. 
10. Нажмите левой кнопкой мышки на бегунок настройки и, не отпуская кнопки, двигайте 

его вверх и вниз. Результаты настройки переменных наблюдайте на графике. Одновременно 
все изменения отображаются на обеих схемах. 

 
Примечание. Если при регулировке кривые на графике выходят за пределы графика, щёлкните 
левой кнопкой мышки по значку Analyze на панели инструментов, чтобы повторить анализ. 

 
Чтобы получить топологию аттенюатора, необходимо элементу эквивалентной схемы диода 
присвоить элемент топологии, представляющий собой зазор для пайки диода. В библиотеке 
элементов Microwave Office такого элемента нет. Поэтому его необходимо нарисовать и 
присвоить элементу схемы SUBCKT. Для этого можно воспользоваться библиотекой элементов 
топологии Cell Libraries, которая имеется в Microwave Office и в которую можно добавлять 
нарисованные элементы. 

 
Импортирование библиотеки элементов GDSII. 
 

Библиотеки элементов используются в Microwave Office, чтобы 
обеспечивать создание как многослойных физических структур, так и 
полосков печатных плат или обработки гибридных устройств, а так же для 
стандартных графических работ, используемых при обработке монолитных 
СВЧ микросхем (MMIC) и высокочастотных интегральных схемах (RFIC). 
Microwave Office поддерживает формат файлов GDSII для рисунков. 

 

Чтобы импортировать библиотеку элементов GDSII: 
 

1. Правой кнопкой мышки щёлкните по Cell Libraries 
(Библиотеки элементов) в менеджере топологии и выберите Rea
GDSII Library (Читать библиотеку GDSII) во всплыв
меню. 

d 
ающем 

2. Найдите папку …\AWR\MWO2002 и дважды щёлкните по 
ней левой кнопкой мышки, чтобы открыть папку. 

3. Дважды щёлкните левой кнопкой мышки по подпапке 
Examples (Примеры), затем дважды щёлкните левой кнопкой 
мышки по подпапке Quick Start. 
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4. Выделите файл packages.gds и нажмите Открыть. Откроется окно Warning: Different 
Database Unit (Предупреждение: Модуль различной базы данных). В этом окне сообщается, 
что некоторые пункты в этой библиотеке будут сокращены в текущем модуле базы данных при 
выполнении рисунка или сохранении в файле и перечисляются элементы из базы данных. 
Нажмите OK. Импортированная библиотека будет отображена в окне менеджера топологии, 
как показано на рис. 2.34. 

 
Рисование элемента топологии. 
 

Чтобы нарисовать элемент топологии: 
 

1. Нажмите левой кнопкой мышки на панель Layout в 
нижней части левого окна, чтобы активизировать менеджер 
топологии. 

2. Щёлкните правой кнопкой мышки по подгруппе 
packages (многослойные структуры) в группе Cell Libraries 
(Библиотеки элементов) и выберите New Layout Cell (Новый 
элемент топологии) во всплывающем меню. Откроется 
диалоговое окно Create New Layout Cell (Создание нового 
элемента топологии). 

3. Наберите D553 (диод 553) в поле Enter the name of the 
cell (Ввод имени элемента) и нажмите OK. На рабочем поле 
откроется окно для рисования. 

4. Щёлкните левой кнопкой мышки по квадрату 0-
>Copper (Медь) в нижней части окна менеджера, чтобы 
назначить медь для активного слоя, как показано на рис. 2.35 
(не щёлкайте по лампочке, т.к. такой щелчок определяет слой 
для показа или скрытия). 

5. Щёлкните левой кнопкой мышки по окну рисования на 
рабочем поле, чтобы сделать его активным. 

6. Щёлкните левой кнопкой мышки по кнопке справа от значка Set Grid Snap Multiple 
(Установка размера сетки) на панели инструментов и в выпавшем списке 
выберите 0.1x (Рис. 2.36). 

7. Щёлкните левой кнопкой мышки по значку View Area и в окне топологии 
выделите участок окна так, чтобы была видна сетка. Возможно это придётся 
сделать несколько раз. 

8. Щёлкните левой кнопкой мышки по значку Polygon  на панели 
инструментов. 

9. Переместите курсор в окно рисования и щёлкните левой кнопкой мышки, 
чтобы зафиксировать начало топологии. 

10. Переместите курсор вправо, пока будет отображено dx:0.16 и щёлкните левой кнопкой 
мышки. Переместите курсор вниз, пока будет отображено dx:0.1 и щёлкните левой кнопкой 
мышки. Переместите курсор влево, пока будет отображено dx:-0,15 и щёлкните левой кнопкой 

ет отображено dx:0.36 и щёлкните левой кнопко
мышки. Переместите курсор влево, пока будет 
отображено dx:-0.01 и щёлкните два раза левой 
кнопкой мышки, чтобы завершить рисование. 

11. Щёлкните левой кнопкой мышки по знач

мышки. Переместите курсор вниз, пока буд й 

ку 
Co

т. 

кнув 

py, и затем по значку Paste, чтобы скопировать 
и вставить элемент. Переместите курсор в окно 
топологии и два раза щёлкните правой кнопкой 
мышки, чтобы развернуть скопированный элемен
Поместите скопированный элемент напротив 1-го 
так, чтобы величина зазора была равна 0.4. 
Величину этого зазора можно измерить, щёл
левой кнопкой мышки по значку Layout Ruler  
(Линейка топологии). В этом случае линейка, 

зывающая размер отображается на топологии, 
как показано на рис. 2.37 полученной топологии. 

Чтобы удалить линейку из топологии, нужно щёлкнуть по линейке левой кнопкой мышки и 
затем нажать клавишу Delete. Величину зазора можно измерить и иначе, щёлкнув левой 

кнопкой мышки по значку Measure 

пока

 (Измерение величины) на панели инструментов. В 
этом случае линейки на топологии не отображается. 
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Добавление портов к нарисованному элементу. 
 

К нарисованному элементу топологии необходимо добавить входной и выходной порты. Чтобы 
сделать это: 
 

1. Выберите Layout > Cell Port (Топология > Порт элемента) в выпадающем меню или 
нажмите на значок Cell Port на панели инструментов. 

2. Переместите курсор в окно рисования. Нажав и удерживая клавишу Ctrl, поместите 
курсор на нижний левый угол  левого так, чтобы небольшой квадратик появился на этом углу. 
Не отпускайте клавишу Ctrl. 

 34

 
и 

3. Не отпуская клавишу 
Ctrl, нажмите левую кнопку 
мышки и, не отпуская её, 
двигайте курсор к верхнему 
левому углу проводника, пока 
другой квадрат появится на этом
углу. Отпустите кнопку мышк
и клавишу Ctrl. 

4. Повторите шаги с 1-го по 
3-ий, чтобы поместить порт на 
противоположной стороне 
рисунка, но начните с верхнего 
правого угла и двигайте курсор 

к правому нижнему углу. 
5. Закройте окно рисования. Будет выведен запрос, хотите ли вы сохранить нарисованный 

элемент. Нажмите Yes, чтобы сохранить. Полученная топология показана на рис. 2.38. 
 

Примечание. Полученный элемент в библиотеке Library не сохраняется, он действует только в 
том проекте, в котором создан. Но при желании библиотеку с полученным элементом топологии 
можно сохранить, чтобы его использовать в других проектах. Для этого щёлкните правой 
кнопкой мышки по подгруппе packages в левом окне просмотра топологии и в выпадающем 
меню выберите Save Cell Library (Сохранить библиотеку элементов). Откроется диалоговое 
окно Сохранение. В поле ввода Папка введите путь к папке, в которой хотите сохранить файл, 
или нажмите кнопку справа от этого поля и выберите нужную папку. В поле ввода Имя файла 
введите имя файла, например, MPLLibrary и нажмите Сохранить. 

 
Редактирование схемы и назначение элемента топологии D553 элементам схемы 
SUBCKT (т.е. диодам). 
 

Чтобы отредактировать схему и ввести элемент топологии D553: 
 

1. Щёлкните левой кнопкой мышки 
по окну схемы аттенюатора, чтобы 
сделать его активным. 

2. Дважды щёлкните левой кнопкой 
мышки по левому элементу схемы 
SUBCKT в окне схемы. Откроется окно 
Element Options (Опции элемента). 

3. Нажмите на панель Layout в 
верхней части этого окна. 

4. Выберите D553 в окне списка 
Compatible Cells (Совместимые 
элементы) и нажмите OK (рис. 2.39). 

5. Аналогично назначьте элемент 
топологии элементу второму элементу 
схемы SUBCKT. 

6. Выберите Schematic > View 
Layout (Схема > Показать топологию) в выпадающем меню или щёлкните левой кнопкой 
мышки по значку View Layout на панели инструментов. Новая топология будет отображена на 
рабочем поле (рис. 2.40). 



Вывод топологии в файл. 
 

1. Щёлкните левой 
кнопкой по значоку New 
Layout View (Показать новую 

топологию)  на панели 
инструмертов, чтобы открыть 
окно топологии на рабочем 
поле. 
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2. Нажмите Layout 
(Топология) в выпадающем 
меню и выберите Export 
Layout (Экспорт топологии). 
Откроется диалоговое окно 
Сохранение (рис. 2.40). 

3. Выберите DXF[DXF 
Flat,*.dxf] в поле Тип файла, 
щёлкнув стрелку справа от 

этого поля. 
4. Наберите имя файла Atr в поле Имя файла. 
5. В поле Папка введите путь к нужной папке, в которой надо сохранить файл. 
6. Нажмите Сохранить. 

 
При желании можно сохранить проект, выбрав File > Save Project (Файл > Сохранить проект) в 

выпадающем меню. 
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3. Нелинейное моделирование 
В нелинейном моделировании используется гармонический баланс или ряды Вольтера, как 

источник для возбуждения электрической схемы. Анализ с использованием гармонического баланса и 
рядов Вольтера – не взаимозаменяемые решения нелинейного устройства. Гармонический баланс лучше 
использовать для нелинейных устройств типа усилителей мощности, смесителей и умножителей. Анализ 
с помощью рядов Вольтера, который является линейным возмущающим методом, лучше использовать 
для устройств со слабо выраженной нелинейностью, подобных усилителям, на 1 дБ ниже точки 
компрессии. 

В Microwave Office моделирование с помощью гармонического баланса проводится просто. Ввод 
схемы, измеряемые величины и анализ выполняются аналогично линейному моделированию. Основное 
отличие в возбуждении портов. Здесь требуется добавлять порты, для которых необходимо определять 
мощность и частоту, а также опцию для изменения любого одного из этих параметров или обоих вместе. 
Имитатор гармонического баланса позволяет определять одночастотное и многочастотное возбуждение 
портов, чтобы выполнить одно- и многосигнальный анализ. Всякий раз, когда источник гармонического 
баланса определён в схеме, имитатор гармонического баланса вызывается автоматически при 
моделировании.  

Одночастотный анализ с использованием гармонического баланса включает в себя 
моделирование на одной основной частоте из множества частот и с постоянной составляющей тока. Этот 
анализ требует, чтобы вы определили основную частоту и общее количество гармоник. 

Двух- и трёхчастотный анализ с помощью гармонического баланса используется, чтобы 
определить реакцию на выходе схемы при возбуждении её портов разными частотами. Двухчастотный 
анализ используется для схем типа смесителей, на которые подаётся частота гетеродина и частота 
радиосигнала. Трёхчастотный анализ используется, чтобы определить искажения взаимной модуляции в 
смесителе при подаче сигнала гетеродина и двух частот радиосигналов. Трёхчастотный анализ в этой 
главе не описан. Для знакомства с ним обратитесь к руководству пользователя Microwave Office. 

Microwave Office позволяет создавать нелинейные измеряемые величины и во временной 
области и по частоте. Здесь предлагается полная система нелинейных измеряемых величин, которая 
включает в себя S-параметры при большом сигнале, мощность, напряжение и ток. Поскольку анализ с 
помощью гармонического баланса даёт решение для мощности и частоты в каждой гармонике, 
используются индексы, чтобы отличать различные параметры. 

Следующий пример иллюстрирует некоторые из основных особенностей нелинейного 
моделирования в Microwave Office. 

3.1. Моделирование усилителя мощности. 
 

Этот пример показывает, как использовать Microwave Office, чтобы моделировать схему 
усилителя мощности, используя нелинейный гармонический баланс. Для этого необходимы следующие 
шаги: 
 

o Использование нелинейных моделей из библиотеки элементов; 
o Создание измеряемых величин вольтамперной характеристики; 
o Создание цепи смещения транзистора и измеряемых величин напряжения и тока; 
o Добавление к схеме портов гармонического баланса; 
o Создание схемы с иерархической структурой, содержащей подсхемы; 
o Создание измеряемых величин выходной мощности; 
o Создание измеряемых величин характеристики динамической нагрузки; 
o Добавление двухчастотного порта гармонического баланса. 

 
Создание нового проекта. 

 
Чтобы создать новый проект: 
 

1. Выберите File > New Project (Файл > Новый проект) в выпадающем меню. 
2. Выберите File > Save Project As (Файл > Сохранить проект как) в выпадающем меню. 

Откроется диалоговое окно Save As. 
3. Наберите имя проекта (например, nonlinear-example) и нажмите Сохранить. 

 
 
 
 
 
 



Установка единиц измерения, используемых по умолчанию. 
 

Чтобы установить единицы 
измерения, которые будут использоваться в 
проекте по умолчанию: 
 

1. Выберите Options > 
Project Options (Опции > Опции 
проекта) в выпадающем меню. 
Откроется диалоговое окно 
Project Options. 

2. Нажмите панель Global 
Options (Глобальные опции) в 
верхней части диалогового окна. 

3. Установите нужные 
единицы измерения, щёлкая по 
стрелкам, справа от поля ввода 
соответствующей единицы так, 
чтобы они соответствовали 
показанным на рис. 3.1, снимите 
флажок в поле Metric units 
(Метрические единицы), 
установите mil в поле Length 
type и нажмите OK. 

 
Создание схемы. 

 
Чтобы создать схему: 

 
1. Выберите Project > Add Schematic > New Schematic (Проект > Добавить схему > Новая 

схема) в выпадающем меню или щёлкните по значку New Schematic  на панели 
инструментов. Откроется диалоговое окно Create New Schematic (Создать новую схему). 

2. Наберите имя схемы IV Curve (Вольтамперная характеристика) и нажмите OK. 
Откроется окно схемы на рабочем поле и схема появится, как подгруппа в группе Circuit 
Schematics (Схемы цепи) в окне просмотра проекта. 

 
Размещение нелинейной модели из библиотеки. 
 

Чтобы поместить нелинейную модель: 
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1. Нажмите панель 
Elem (Элементы) в 
нижней части левого 
окна, чтобы открыть окно 
просмотра элементов. 

2. В окне просмотра 
элементов найдите группу 
Library (Библиотека) и 
дважды щёлкните по ней 
левой кнопкой мышки, 
чтобы развернуть 
библиотеку. 

3. Дважды щёлкните 
левой кнопкой мышки по 
подгруппе Nonlinear 
(Нелинейные) в группе 
Library, чтобы 
развернуть её. 

4. Щёлкните левой 
кнопкой мышки по 
подгруппе Getting S
в дереве Nonlinea

5. Щёлк

tarted 
r. 

ните левой кнопкой мышки по подгруппе GBJT в дереве Getting Started. Модель 
будет отображена в нижней части левого окна. 
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шки, позиционируйте элемент как показано 
на с

 
Размещ йном элементе. 

 
оку: 

 
1. Найдите в окне 

просмотра элементов группу 
M D  

е 
шки, 

сти 

ель IV CURVEI 
и, 

ните 

IV CURV  
левой кнопкой мышки по текстовому полю с параметрами этого элемента, нажмите левую 

 
к, чтобы курсор 

отображался в виде соленоида. Щёлкните левой кнопкой мышки, чтобы зафиксировать начало 
пр д  

 к 

 
онируйте землю к узлу 3 транзистора GBJT и щёлкните левой 

кн
 
Редакти ольтамперной характеристики. 

параметры IV CURVEI: 
 

щёлкните 
левой кнопкой мышки по 
эл н

: 
 

ение 

по

 
 

6. Нажмите левой кнопкой мышки на модель BLT11_chip и, не отпуская кнопки мышки, 
перетащите её в окно схемы, отпустите кнопку мы

 ри . 3.2 и щёлкните левой кнопкой мышки, чтобы зафиксировать его. 

ение измерителя вольтамперной характеристики в нелине
 

Чтобы поместить измеритель вольтамперной характеристики в нелинейном элементе с шагом по
т

eas evices (Средства
измерения) и дважды щёлкнит
по ней левой кнопкой мы
чтобы развернуть группу. 
Щёлкните левой кнопкой 
мышки по подгруппе IV. 
Модели измерителей 
отображаются в нижней ча
левого окна. 

2. Нажмите левой кнопкой 
мышки на мод
не отпуская кнопки мышки, 

перетащите её в окно схемы, 
отпустите кнопку мышки, 
позиционируйте элемент как 
показано на рис. 3.3 и щёлк
левой кнопкой мышки, чтобы 
зафиксировать его. 

EI в другое место, щёлкните
 

Примечание. Чтобы переместить параметры элемента 

кнопку мышки и, не отпуская её, перетащите параметры в другое место. 

3. Поместите курсор возле узла Step (Шаг) элемента IV CURVEI та

ово а, затем перетащите курсор к узлу 1 транзистора GBJT и щёлкните левой кнопкой
мышки, чтобы зафиксировать провод. 

4. Повторите шаг 3, чтобы подключить узел Sweep (Смещение) элемента IV CURVEI
узлу 2 транзистора GBJT. 

5. Щёлкните левой кнопкой мышки по значку Ground на панели инструментов, двигайте
курсор в окно схемы, позици
опкой мышки, чтобы её зафиксировать. 

рование параметров измерителя в
 

Чтобы определить 

1. Дважды 

еме ту IV CURVEI в 
окне схемы. Откроется 
диалоговое окно Свойства
Element Options (Опции
элемента). 

2. Измените знач
поля Value (Значение), как 
казано на рис. 3.4 и 

нажмите OK. 
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обавление измеряемых величин к измерителю вольтамперной характеристики. 

Чтобы создать график и добавить измеряемые величины к измерителю вольтамперной 
характе

 
1. Нажмите 

ле  
ь 

на, 
 

кн о  
пе 

 

м 
я 

 

 
BJ  

берите 
Rectangular (Прямоугольный) и нажмите OK. График отобразится на рабо

е 
пр

as Type (Тип 
из я urve в 

 выпадающем меню. 
Ре ь

 
оздание электрической цепи смещения. 

Чтобы создать цепь смещения: 
 

1. Выберите Project > Add Schematic > New Schematic в выпадающем меню. Откроется 
ди г

 окна, чтобы открыть окно просмотра 
эл н

е просмотра элементов найдите группу Library и дважды щёлкните по ней левой 
кн

ment (Сосредоточенные 
эл н

дут 

 и щёлкните 

ак, чтобы курсор отображался в виде 
со о

 
зафиксировать конец провода. 

Д
 

ристики: 

вой кнопкой 
мышки на панел
Proj в нижней 
части левого ок
чтобы открыть окно
просмотра проекта. 

2. Правой 
опк й мышки

щёлкните по груп
Graphs (Графики) и 
выберите Add 
Graph (Добавить
график) во 
всплывающе
меню. Откроетс
окно Create Graph
(Создать график). 

3. Наберите IV
T в поле Graph 

Name (Имя 
графика), вы
чем поле. 

4. Щёлкните правой кнопкой мышки по подгруппе IV BJT в группе Graphs в окн
осмотра проекта и выберите Add Measurement (Добавить измеряемую величину) во 

всплывающем меню. Откроется диалоговое окно Add Measurement. 
5. Выберите Nonlinear Current (Нелинейный ток) в окне списка Me
мер емой величины), выберите IV Curve в окне списка Measurement, выберите IV C

поле Data Source Name (Имя источника данных) и нажмите OK. 
6. Выберите Simulate > Analyze (Моделирование > Анализ) в
зул тат моделирования отображается на графике рис. 3.5. 

С
 

ало овое окно New Schematic. Наберите DC Bias (Постоянный ток смещения) и нажмите 
OK. Окно схемы откроется на рабочем поле. 

2. Нажмите панель Elem в нижней части левого
еме тов. 
3. В окн
опкой мышки, чтобы развернуть библиотеку. Дважды щёлкните левой кнопкой мышки по 

подгруппе Nonlinear (Нелинейные) в группе Library, чтобы развернуть её. Щёлкните левой 
кнопкой мышки по подгруппе Getting Started в дереве Nonlinear. Щёлкните левой кнопкой 
мышки по подгруппе GBJT в дереве Getting Started. Модель будет отображена в нижней 
части левого окна. Нажмите левой кнопкой мышки на модель BLT11_chip и, не отпуская 
кнопки мышки, перетащите её в окно схемы, отпустите кнопку мышки, позиционируйте 
элемент и щёлкните левой кнопкой мышки, чтобы зафиксировать его. 

4. Дважды щёлкните левой кнопкой мышки по группе Lumped Ele
еме ты), чтобы развернуть её. Щёлкните левой кнопкой мышки по подгруппе Inductor 

(Индуктивности) в дереве Lumped Element. Доступные модели катушек индуктивности бу
отображены в нижней части левого окна. Нажмите левой кнопкой мышки на модель IND и, не 
отпуская кнопки мышки, перетащите её в окно схемы, отпустите кнопку мышки, 
позиционируйте элемент выше и левее транзистора GBJT, как показано на рис. 3.6,
левой кнопкой мышки, чтобы зафиксировать элемент. 

5. Поместите курсор на узле 1 транзистора GBJT т
лен ида. Щёлкните левой кнопкой мышки, чтобы зафиксировать начало провода, 

перетащите курсор к правому узлу элемента IND, щёлкните левой кнопкой мышки, чтобы
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ns. Введите 1 в поле Value для индуктивности (L) и нажмите 

 
ой мышки по 

по у

 

 

е её в 
тите 

й 
обы 

 
 показано на 

ть элем
8. Дважды щёлкните левой кнопкой мышки по элементу RES в окн  

. 
лкните левой кнопкой мышки по значку Ground на панели инструментов, двигайте 

курсор о 

 

мите левой 
кн

к 

 

йства измерения) в окне 
пр

уская кнопки 
мы

 

 
лкните левой кнопкой мышки, чтобы зафиксировать 

ко R 

нт IND на верхнем узле I_METER, как показано на рис. 3.6, и 
щ

клавиши 

D L2, как показано на рис. 3.6, и 
щ

. 

6. Дважды щёлкните левой кнопкой мышки по элементу IND в окне схемы. Откроется 
диалоговое окно Element Optio

OK. 
7. Щёлкните левой

кнопк
дгр ппе Resistor в 

дереве Lumped 
Element. Доступные 
модели резисторов
будут отображены в 
нижней части левого
окна. Нажмите левой 
кнопкой мышки на 
модель RES и, не 
отпуская кнопки 
мышки, перетащит
окно схемы, отпус
кнопку мышки, 
щёлкните право
кнопкой мышки, чт
повернуть элемент, 
позиционируйте его на 
узле 3 транзистора
GBJT, как
ент. 
е схемы. Откроется

диалоговое окно Element Options. Введите 0.5 в поле Value для резистора (R) и нажмите OK
9. Щё

рис. 3.6, и щёлкните левой кнопкой мышки, чтобы зафиксирова

 в окно схемы, позиционируйте землю к нижнему узлу резистора RES R1, как показан
на рис. 3.6, и щёлкните левой кнопкой мышки, чтобы зафиксировать землю. 

10. Найдите в окне просмотра элементов группу Sources (Источники) и дважды щёлкните 
по ней, чтобы развернуть. Щёлкните левой кнопкой мышки по подгруппе DC (Постоянный 
ток). Модели доступных источников отображаются в нижней части окна. Наж
опкой мышки на модель DCVS и, не отпуская кнопки мышки, перетащите её в окно схемы, 

отпустите кнопку мышки, позиционируйте элемент на левом узле индуктивности IND L1, ка
показано на рис. 3.6, и щёлкните левой кнопкой мышки, чтобы зафиксировать элемент. 

11. Щёлкните левой кнопкой мышки по значку Ground на панели инструментов, двигайте 
курсор в окно схемы, позиционируйте землю на нижнем узле элемента DCVS V1, как показано
на рис. 3.6, и щёлкните левой кнопкой мышки, чтобы зафиксировать. 

12. Дважды щёлкните левой кнопкой мышки по элементу DCVC в окне схемы. Откроется 
диалоговое окно Element Options. Введите 1 в поле Value для и нажмите OK. 

13. Щёлкните левой кнопкой мышки по группе MeasDevice (Устро
осмотра элементов. Доступные модели измерителей отображаются в нижней части левого 

окна. Нажмите левой кнопкой мышки на модель I_METER (Амперметр) и, не отп
шки, перетащите её в окно схемы, отпустите кнопку мышки, щёлкните правой кнопкой 

мышки, чтобы повернуть элемент, позиционируйте его на узле 2 транзистора GBJT, как 
показано на рис. 3.6, и щёлкните левой кнопкой мышки, чтобы зафиксировать элемент. Затем 
нажмите левой кнопкой мышки на модель V_METER (Вольтметр) и поместите его справа от
резистора RES, как показано на рис. 3.6. 

14. Поместите курсор на отрицательную клемму элемента V_METER так, чтобы курсор 
отображался в виде соленоида. Щёлкните левой кнопкой мышки, чтобы зафиксировать начало
провода, перетащите курсор к земле и щё
нец провода. Аналогично соедините проводом положительную клемму элемента V_METE

с узлом 2 транзистора GBJT. 
15. Щёлкните левой кнопкой мышки по элементу IND L1 в окне схемы. Нажмите клавиши 

Ctrl+C и затем Ctrl+V, чтобы скопировать и вставить его. Двигайте курсор, чтобы 
позиционировать новый элеме
ёлкните левой кнопкой мышки, чтобы зафиксировать. 
16. Щёлкните левой кнопкой мышки по элементу DCVS в окне схемы. Нажмите 

Ctrl+C и затем Ctrl+V, чтобы скопировать и вставить его. Двигайте курсор, чтобы 
позиционировать новый элемент DCVS на правом узле IN
ёлкните левой кнопкой мышки, чтобы зафиксировать. 
17. Дважды щёлкните левой кнопкой мышки по элементу DCVS V2 в окне схемы

Откроется диалоговое окно Element Options. Введите 6 в поле Value и нажмите OK. 



18. Щёлкните левой кнопкой мышки по значку Ground на панели инструментов, дв
курсор в окно схемы, позиционируйте землю на отрицательном узле элемента DCVC 

игайте 
V2, как 

по
 

П бы 
переместить параметры элемента в другое место, если это необходимо, нажмите на поле 
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ource Na ER 

x 
 поле Power Swp 

Ind

яжение) в окне списка 
Me T

 

 
измеряемой величины), как показано на рис. 3.8. 

казано на рис. 3.6, и щёлкните левой кнопкой мышки, чтобы зафиксировать. 

римечание. Возле каждого элемента располагается поле с его параметрами  Что

параметров левой кнопкой мышки (при этом курсор должен отображаться в виде пере
не отпуская кнопки мышки , перетащите параметры в другое место. 

ление измеряемых величин напряжения и тока. 
 

Чтобы создать таблицу и добавить измеряемые величины нап
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1. На

oj в нижней части лев
окна, чтобы открыть окно 
просмотра проекта. 

2. Правой кнопкой 
мышки щёлкните по 

aphs  и выберите Add
Graph во всплывающем 
меню. Откроется окно 
Create Graph. 

3. Наберите DC Bia
(Смещение пост
ком в поле Graph Nam

выберите Tabular 
(Таблица) в области Graph 
Type и нажмите OK
таблицы отобразится на 
рабочем поле. 

4. Щёлкните правой 
кнопкой мышки
дгр ппе DC BIAS в 

группе Graphs в окн
просмотра проекта и 
выберите Add 
Measurement во 
всплывающем меню
Откроется диалогов
Add Measurement (Ри
3.7). 

5. Выберите Nonlinea
Curre

eas ype, выберите I 
comp в окне списка 
выберите DC Bias в поле
me, выберите I_MET

AMP1 (Амперметр AMP1) в поле 
Measurement Component (Компонент 
измеряемой величины). 

6. Выберите 0 в поле Harmonic Inde
(Индекс гармоники) и 1 в

Data S

ex (Индекс проходящей мощности), 
щёлкая по стрелкам справа от этих полей. 
Нажмите Apply. 

7. Теперь выберите Nonlinear Voltage 
(Нелинейное напр

as ype, выберите V comp в окне 
списка Measurement, выберите DC Bias в
поле Data Source Name, выберите 
V_METER VM1 (Вольтметр VM1) в поле 
Measurement Component (Компонент
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ам 
справа

 late > Analyze (Моделирование > Анализ) в выпадающем меню. 
Св как 

 
обавление порта гармонического баланса. 

Перед добавлением порта гармонического баланса необходимо на входе и выходе транзистора 
добавит

1. Нажмите левой кнопкой мышки на панель Proj в нижней части левого окна, чтобы 
от

шки по значку + слева от группы Circuit Schematics 
(П

 подгруппе DC Bias в группе Circuit 
Schem

 части левого окна, чтобы 
от

ой мышки по группе Lumped Element (Сосредоточенные 
эл н

я в 

кой 

 мышки по элементу CAP в окне схемы. Откроется 
ди г

 
Ctrl+C

ки, 

ой клемме элемента CAP C2. Курсор должен отображаться в 
ви е 

 
Блокировочный конденсатор радиочастот необходимо также добавить параллельно резистору в 

цепи эм

8. Выберите 0 в поле Harmonic Index и 1 в поле Power Swp Index, щёлкая по стрелк
 от этих полей. Нажмите Apply. 

9. Нажмите OK. 
10. Выберите Simu
едённые в таблицу данные постоянного тока смещения отобразятся на рабочем поле, 

показано на рис. 3.9. 

Д
 

ь блокировочные конденсаторы. Чтобы сделать это: 
 

крыть окно просмотра проекта. 
2. Щёлкните левой кнопкой мы
ринципиальные схемы), чтобы развернуть её. 
3. Дважды щёлкните левой кнопкой мышки по

atics. На рабочем поле откроется окно схемы DC Bias. 
4. Нажмите левой кнопкой мышки на панель Elem в нижней
крыть окно просмотра элементов. 
5. Дважды щёлкните левой кнопк
еме ты), чтобы развернуть её. Щёлкните левой кнопкой мышки по подгруппе Capacitor 

(Конденсаторы) в дереве Lumped Element. Доступные модели конденсаторов отображаютс
нижней части левого окна. Нажмите левой кнопкой мышки на модель CAP и, не отпуская 
кнопки мышки, перетащите её в окно схемы. Отпустите кнопку мышки, позиционируйте 
элемент на клемме 1 транзистора GBJT, как показано на рис. 3.10, и щёлкните левой кноп
мышки, чтобы зафиксировать элемент. 

6. Дважды щёлкните левой кнопкой
ало овое окно Element Options. Введите 100 в поле Value для ёмкости (C) и нажмите OK. 
7. Щёлкните левой кнопкой мышки по элементу CAP C1 в окне схемы. Нажмите клавиши

 и затем Ctrl+V, чтобы скопировать и вставить элемент. Позиционируйте новый 
элемент CAP справа от схемы, как показано на рис. 3.10 и щёлкните левой кнопкой мыш
чтобы зафиксировать элемент. 

8. Поместите курсор на лев
де соленоида. Щёлкните левой кнопкой мышки и затем перетащите курсор к верхней клемм

элемента I_Meter, которая связана с IND L2, и щёлкните левой кнопкой мышки, чтобы 
зафиксировать провод. 

итора. Чтобы сделать это: 
 



9. Щёлкните левой кнопкой мышки по элементу CAP C1 в окне схемы. Нажмите клавиши 
Ctrl+C и затем Ctrl+V, чтобы скопировать и вставить элемент. Позиционируйте новый 
элемент CAP слева от RES R1, как показано на рис. 3.10, щёлкните правой кнопкой мышки, 
чтобы повернуть его и затем щёлкните левой кнопкой мышки, чтобы зафиксировать элемент. 

10. Поместите курсор на верхней клемме элемента CAP C3. Курсор должен отображаться в 
виде соленоида. Щёлкните левой кнопкой мышки и затем перетащите курсор к клемме 3 
транзистора GBJT и щёлкните левой кнопкой мышки, чтобы зафиксировать провод. 
Аналогично соедините проводом нижнюю клемму элемента CAP C3 с землёй. 

 
Чтобы добавить порт гармонического баланса: 

 
1. Дважды щёлкните левой кнопкой мышки по группе Ports в окне просмотра элементов, 

чтобы развернуть её. Щёлкните левой кнопкой мышки по подгруппе Harmonic Balance в 

группе Ports. Доступные модели портов отображаются в нижней части левого окна. Нажмите 
левой кнопкой мышки на модель PORT 1 и, не отпуская кнопки мышки, перетащите её в окно 
схемы. Отпустите кнопку мышки, позиционируйте элемент на левой клемме элемента CAP C1, 
как показано на рис. 3.11, и щёлкните левой кнопкой мышки, чтобы зафиксировать элемент. 

2. Дважды щёлкните левой кнопкой мышки по элементу PORT 1 в окне схемы. Откроется 
диалоговое окно Element Options. Введите 23 в строку Pwr в поле Value и нажмите OK. 

3. Щёлкните левой кнопкой мышки по значку PORT на панели инструментов. Двигайте 
курсор в окно схемы, щёлкните правой кнопкой мышки два раза, чтобы повернуть порт, 
позиционируйте его на правой клемме конденсатора CAP C2, как показано на рис. 3.11, и 
щёлкните левой кнопкой мышки, чтобы зафиксировать порт. Этот порт является выходным. 

 
Определение частот нелинейного моделирования. 

 
Частоты для нелинейного 

моделирования могут быть определены 
независимо от глобальных частот, 
определённых для проекта. Чтобы 
определить эти частоты: 
 

1. Нажмите левой кнопкой 
мышки на панель Proj в нижней 
части левого окна, чтобы открыть 
окно просмотра проекта. 

2. Щёлкните левой кнопкой 
мышки по значку + слева от 
группы Circuit Schematics, чтобы 
развернуть её. 

3. Щёлкните правой кнопкой 
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мышки по подгруппе DC BIAS и выберите Options во всплывающем меню. Откроется 
диалоговое окно Options. 

4. Нажмите левой кнопкой мышки на панель Nonlinear Frequencies в верхней части окна. 
5. Снимите галочку в переключателе Use Project Frequencies (Использовать частоты 

проекта). 
6. Установите GHz в поле Unit, щёлкая левой кнопкой мышки по стрелке справа от этого 

поля, введите 1.5 в поле Start, введите 2.5 в поле Stop, введите 0.2 в поле Step, выберите 
радиокнопку Replace (Заменить) и нажмите Apply (Применить). Диапазон частот отображается 
в окне списка Current Range (см. рис. 3.12). 

7. Нажмите OK. 
 
Создание диаграммы Смита и добавление измеряемой величины коэффициента 
отражения большого сигнала. 
 

Примечание. Коэффициент отражения большого сигнала может быть определён как S11 при 
большом сигнале. S-параметры большого сигнала – это общая форма коэффициентов отражения 
при большом сигнале. Например, S – параметры большого сигнала могут быть определены как 
S21 для гармоники 1 на порту 2 и гармоники 2 на порту 1. 

 
Чтобы создать диаграмму Смита: 

1. Нажмите 
левой кнопкой 
мышки на панель 
Proj в нижней 
части левого 
окна, чтобы 
открыть окно 
просмотра 
проекта. 

2. Щёлкните 
правой кнопкой 
мышки по группе 
Graphs 
(Графики) и 
выберите Add 
Graph (Добавить 
график) во 
всплывающем 
меню. Откроется 

диалоговое окно Create Graph (Создать график). 
3. Введите Input reflection (Коэффициент отражения по входу) в поле Graph Name (Имя 

графика), выберите радиокнопку Smith Chart (Диаграмма Смита) в области Graph Type (Тип 
графика) и нажмите OK. Диаграмма будет отображена на рабочем поле. 
 
Чтобы добавить измеряемую величину коэффициента отражения большого сигнала: 
 

4. Щёлкните правой кнопкой мышки 
по подгруппе Input reflection в группе 
Graphs в окне просмотра проекта и 
выберите Add measurement (Добавить 
измеряемую величину) во всплывающем 
меню. Откроется диалоговое окно Add 
measurement (Рис. 3.13). 

5. Выберите Nonlinear Parameters 
(Нелинейные параметры) в окне списка 
Meas Type (Тип измеряемых величин). 
Выберите Gcomp (Компонент 
отражённого сигнала) в окне списка 
Measurement (Измеряемая величина). 
Выберите DC Bias в поле Data Source 
Name (Имя источника данных), выберите 
PORT_1 в поле Measurement Component 
(Компонент измеряемой величины), 
выберите 1 в поле Harmonic Index 
(Индекс гармоники) и в поле Power Swp 
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Index (Индекс проходящей мощности), щёлкая по стрелкам справа от этих полей, и нажмите 
OK. 

6. Выберите Simulate > Analyze в выпадающем меню. Результаты анализа отображаются 
на диаграмме Смита рис. 3.14. 

 
Импортирование схемы. 

 
Входную и выходную согласующие схемы импортируем из схемы, созданной ранее. Чтобы 

импортировать входную согласующую схему: 
 

1. Нажмите левой кнопкой 
мышки на панель Proj в нижней 
части левого окна, чтобы 
открыть окно просмотра 
проекта. 
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ажды 
мышки 

 
римечание. Здесь указана папка, в которую по 

, 

4. Дважды щёлкните левой кнопкой 
мышки

те левой кнопкой мышки 
по

с. 

Чтобы импортировать выходную согласующую схему: 
 

6. Щёлкните правой кнопкой мышки по 
гр

т 

 Папка, 
ус о

левой 

 мышки 
по

файлу На 

 

2. Щёлкните правой 
кнопкой мышки по группе 
Circuit Schematics в окне 
просмотра проекта и выберите 
Import Schematic (Импорт 
схем) во всплывающем меню. 
Откроется диалоговое окно 
Открытие файла (Рис. 3.15). 

3. Щёлкнув кнопку справа 
от поля Папка, установите в 
этом поле папку C:\Program 
Files\AWR\MWO2002 и дв
щёлкните левой кнопкой 

по этой папке, чтобы открыть её. 

П
умолчанию инсталлируется Microwave Office. 
Если вы установили программу в другую папку
откройте её. 
 

 по подпапке Examples 
(Примеры), затем Дважды щёлкните 
левой кнопкой мышки по подпапке 
Quick Start. 

5. Щёлкни
 файлу input math.sch и нажмите 

Открыть. На рабочем поле будет 
отображена схема, показанная на ри
3.16. 

 

уппе Circuit Schematics в окне просмотра 
проекта и выберите Import Schematic (Импор
схем) во всплывающем меню. Откроется 
диалоговое окно Открытие файла. 

7. Щёлкнув кнопку справа от поля
тан вите в этом поле папку C:\Program 

Files\AWR\MWO2002 и дважды щёлкните 
кнопкой мышки, чтобы открыть папку. 

8. Дважды щёлкните левой кнопкой
 подпапке Examples, затем Дважды щёлкните 

левой кнопкой мышки по подпапке Quick Start. 
9. Щёлкните левой кнопкой мышки по 

outpit math.sch и нажмите Открыть. 
рабочем поле будет отображена схема, 
показанная на рис. 3.17. 
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обавление подсхем к схеме. 

Всякий раз, когда к n – ному порту схемы подключается другая созданная или импортированная 
схема, т

еской 

1. Щёлкните левой 
кн о

ы 

щё  
 

 

ёлкните левой 
кн о

е 

 
 
ри 

C1 будут в
рживайте 

кл

ы 
1 и 

мите на панель Elem в 
ни

ните левой кнопкой 
мышки

ены в 

кн о му 

о 

 

ой 
ать 

 Если узлы подсхемы не 
сое

 
тствующ

Д
 

о подключённая схема автоматически становится n – подсхемой. Такие подсхемы могут 
подключаться к другим подсхемам, создавая, таким образом, иерархическую структуру электрич
цепи. Чтобы добавить согласующие схемы на входе и выходе усилителя: 
 

опк й мышки по 
значку + слева от 
группы Circuit 
Schematics, чтоб
развернуть её. 

2. Дважды 
лкните левой

кнопкой мышки по
подгруппе DC Bias, 
чтобы отобразить эту
схему. 

3. Щ
опк й мышки по 

элементу PORT1 в 
окне схемы. Нажмит
клавишу Ctrl и, 
удерживая её, 
щёлкните левой
кнопкой мышки по
элементу CAP C1. П
этом и PORT1 и CAP 
ыделены. 

4. Нажмите и уде
авишу Ctrl снова, нажмите 

левой кнопкой мышки на 
выбранные элементы и, не 
отпуская кнопки мышки, 
перетащите их влево от 
электрической цепи, чтоб
разорвать связь между CAP C
транзистором, как показано на 
рис. 3.18. 

5. Наж
жней части левого окна, чтобы 

открыть окно просмотра 
элементов. 

6. Щёлк
 по группе Subcircuit 

(Подсхемы) в окне просмотра 
элементов. Доступные 
подсхемы будут отображ
нижней части левого окна. 

7. Нажмите левой 
опк й мышки подсхе

input match и, не отпуская 
кнопки, перетащите её в окн
схемы, отпустите кнопку 
мышки, позиционируйте 
подсхему между CAP C1 и
узлом 1 транзистора, 
щёлкните левой кнопк
мышки, чтобы зафиксиров
её. 

8.
динились должным 

образом с конденсатором и
ий элемент и, не отпуская транзистором, нажмите левой кнопкой мышки на соотве
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кните левой кнопкой мышки по элементу PORT2. Нажмите и , удерживая клавишу 
Ct щ

ите клавишу Ctrl снова, нажмите выделенные элементы левой кнопкой мышки и, 
не

левого окна, чтобы открыть окно просмотра 
эл

ните левой кнопкой мышки по группе Subcircuit (Подсхемы) в окне просмотра 
эл

ки, 
пе кой 

к, 
й 
те 
ы 

кл . 

 

е 

ды щёлкните 
ента PORT

енная 

 
оздание графика и добавление измеряемой величины выходной мощности. 

Чтобы создать график зависимости выходной мощности (в дБ/Мвт) в зависимости от частоты и 
добавит

1. Нажмите на панель Proj в 
ни

тра 

авой кнопкой мышки 
щё

роется 

мо о

raph 

4. Правой кнопкой мышки щёлкните по подгруппе Pout в  Graphs в окне просмотра 
пр т

кнопки , перетащите этот элемент так, чтобы получить нужное подключение, как показано на
рис. 3.19. 

9. Щёл
rl, ёлкните левой кнопкой мышки по элементу CAP C2. При этом PORT2 и CAP C2 будут 

выделены. 
10. Нажм
 отпуская кнопки мышки, перетащите их вправо от схемы, чтобы разорвать связь между 

CAP C2 и проводом, как показано на рис. 3.20. 
11. Нажмите на панель Elem в нижней части 
ементов. 
12. Щёлк
ементов. Доступные подсхемы будут отображены в нижней части левого окна. 
13. Нажмите левой кнопкой мышки подсхему output match и, не отпуская кноп
ретащите её в окно схемы, отпустите кнопку мышки, щёлкните два раза правой кноп

мышки, чтобы развернуть 
подсхему на 180 градусов, 
позиционируйте подсхему та
чтобы соединить её с право
клеммой CAP C2 и щёлкни
левой кнопкой мышки, чтоб
зафиксировать. 

14. Поместите курсор на 
емме 2 выходной подсхемы

Курсор должен отображаться 
в виде соленоида. Щёлкните 
левой кнопкой мышки и затем
перетащите курсор к элементу 
I_METER, щёлкните левой 
кнопкой мышки, чтобы 
зафиксировать соединени
проводом. 

15. Дваж
левой кнопкой мышки по значению параметра Pwr элем 1. Откроется окно 
редактирования значения. Наберите 18, чтобы изменить значение 23 на 18 dBm. Получ
схема показана на рис. 3.21. 

С
 

ь измеряемую величину выходной мощности: 
 

жней части левого окна, 
чтобы открыть окно просмо
проекта. 

2. Пр
лкните по группе Graphs и 

выберите Add Graph во 
всплывающем меню. Отк
диалоговое окно Create Graph. 

3. Наберите Pout (Выходная 
щн сть) в поле Graph Name, 

выберите радиокнопку 
Rectangular в области G
Type и нажмите OK. График 
будет отображён на рабочем 
поле. 
группе

оек а и выберите Add Measurement во всплывающем меню. Откроется диалоговое окно 
Add Measurement. 
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ле 

5. Выберите Nonlinear 
Power (Нелинейная 
мощность) в окне списка 
Meas Type. Выберите Pcomp 
в окне списка Measurement. 
Выберите DC Bias в поле 
Data Source Name, выберите 
PORT_2 в поле Measurement 
Component, выберите 1 в по
Harmonic Index и в поле Swp 
Index, выберите 
переключатель DBm в 
области Result Type и 
нажмите OK (Рис3.22). 

6. Выберите Simulate > 
Analyze в выпадающем меню. 
Результаты анализа 
отображаются на графике рис 
3.23. 

 
Создание графика и измеряемых величин динамической нагрузки. 
 

График динамической нагрузки наносятся на график вольтамперной характеристики устройства. 
Чтобы создать измеряемые величины динамической нагрузки: 

 
1. Нажмите на панель Proj в 

нижней части левого окна, чтобы 
открыть окно просмотра проекта. 

2. Дважды щёлкните левой 
кнопкой мышки по подгруппе IV 
BJT в группе Graph, чтобы 
открыть график вольтамперной 
характеристики на рабочем оле. 

3. Щёлкните правой кнопкой 
мышки по подгруппе IV BJT в 
группе Graphs и выберите Add 
Measurement во всплывающем 
меню. Откроется диалоговое окно 
Add Measurement. 

4. Выберите Nonlinear Power 
в окне списка Meas Type. 
Выберите IVDLL в окне 
списка Measurement. 
Выберите DC Bias в поле 
Data Source Name, 
выберите V_METER. 
VM1 в поле Voltage 
Measure Component, 
выберите I_METER. 
AMPI в поле Current 
Measure Component, 
выберите 1 в поле 
Frequency Swp Index и в 
поле Power Swp Index и 
нажмите Apply. (Рис. 
3.24). 

5. Нажмите OK. 
6. Выберите Simulate 

> Analyze в выпадающем 
меню. Результаты анализа 
отображаются на графике 
рис 3.25. 

 
 
 



Добавление двухчастотного порта гармонического баланса. 
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тавляющих 

бы 
ны, на 
зко 

рта 

1. Щёлкните левой 
кн о  

 

ды щёлкните левой кнопкой мышки по элементу PORT1 в окне схемы. Откроется 

нель 
Po  

ра  1&2, 
nce 

r type, 
ль 

ency 

ы) 
e excitation 

 
ве е

показано н

 
обавление измеряемой величины третьей составляющей интермодуляции. 

Чтобы добавить измеряемую величину третьей составляющей интермодуляции: 

1. Нажмите на панель Proj в 
ни

тра 

лкните правой 
кн о  

 

но 

 IM3 
(И р поле 

е 

 

отображён график. 

Обычно измеряемые 
величины, используемые для 
характеристики усилителя мощности, 
являются тремя 
последовательностями сос
интермодуляции относительно 
передаваемой мощности. Что
создать эти измеряемые величи
вход необходимо подать две, бли
расположенные частоты. Для 
добавления двухчастотного по
гармонического баланса: 
 

опк й мышки по окну
схемы DC Bias на рабочем
поле, чтобы сделать его 
активным. 

2. Дваж
диалоговое окно Element 
Options (Рис. 3.26). 

3. Нажмите на па
rt в верхней части 

диалогового окна. 
4. Выберите 
диокнопку Tone

выберите Harmonic Bala
в поле ввода Simulato
отметьте переключате
Swept power, выберите 
радиокнопку Excite 
fundamental frequ
(Возбуждение 
фундаментальной частот
в области Sourc
(Источник возбуждения). 

5. Нажмите на панель 
Parameters (Параметры) в
рхн й части диалогового 

а рис. 3.27. Затем нажмите 
OK. 
окна и установите значения полей Value (Значение), как 

Д
 

 

жней части левого окна, 
чтобы открыть окно просмо
проекта. 

2. Щё
опк й мышки по группе

Graphs и выберите Add Graph
во всплывающем меню. 
Откроется диалоговое ок
Create Graph. 

3. Наберите
нте модуляция 3) в 

ввода Graph Name, выберит
радиокнопку Rectangular в 
области Graph Type и нажмите
OK. На рабочем рполе будет 
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уппе IM3 в группе Graphs в окне просмотра 
пр т

5. Выберите 
No  окне 

t, выберите 

те 

берите 1 

IM иска 

K. 

Simula e в 
выпадающем меню. Результаты отображаются на графике рис. 3.29. 

 
При желании вы можете сохранить проект, выбрав File > Save Project в выпадающем меню. 

 
оздание нового проекта. 

1. Выберите File > New Project (Файл > Новый проект) в выпадающем меню. 
ем меню. 

От
r и нажмите Сохранить. 

 
становка глобальных частот проекта. 

тобы установить частоты моделирования, которые будут использоваться в проекте по 
умолчан

 
1. Выберите Options > 

Projec

. 
е окно 

анель 
Gl ные 

 части 

ния, как показано на 
ри .

 Values. Введите 
0 в л  

ска 
. 

4. Правой кнопкой мышки щёлкните по подгр
оек а и выберите Add Measurement во всплывающем меню. Откроется диалоговое окно 

Add Measurement (Рис 3.28). 

nlinear Power в
списка Meas Type, 
выберите IM1_SP в 
окне списка 
Measuremen
DC Bias в поле Data 
Source Name, выбери
PORT2 в поле 
Measurement 
Component, вы
в поле Frequency Swp 
Index (Индекс частоты 
проходящей мощности) 
и нажмите Apply. 

6. Выберите 
3_SP в окне сп

Measurement и 
нажмите Apply. 

7. Нажмите O
8. Выберите 

te > Analyz

3.2. Моделирование балансного смесителя на диодах. 

С
 

2. Выберите File > Save Project As (Файл > Сохранить проект как) в выпадающ
кроется диалоговое окно Save As. 
3. Наберите имя проекта BDMixe

У
 
Ч
ию: 

t Options (Опции > 
Опции проекта) в 
выпадающем меню
Откроется диалогово
Project Options. 

2. Нажмите п
obal Options (Глобаль

опции) в верхней
диалогового окна. 

3. Установите единицы 
измере
с. 3 30. 
4. Нажмите панель 

Frequency
 по е Start, 2.5 в поле

Stop, 0.05 в поле Step. 
Диапазон частот 
отображается в окне спи

5. Нажмите OK. 
Frequency Value, как показано на рис.3.30. Нажмите Apply
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Создание го смесителя. 

1. Выберите Project > Add Schematic > New Schematic (Проект > Добавить схему > Новая 
схема)

рабочем поле и 
схема 

мите панель Elem (Элементы) в нижней части левого окна, чтобы открыть окно 
пр

а элементов левой кнопкой мышки щёлкните по значку + слева от 
гр

по подгруппе PwrDiwider, нажмите левой кнопкой 
мы , 

осмотра элементов левой кнопкой мышки щёлкните по значку + слева от 
гр

руппе Phase, нажмите левой кнопкой мышки 
на

 

по элементу TLIN, чтобы выделить его, щёлкните по 
значку

и щёлкните по значку + слева от 
гр

 узлу 3 модели 
M

ните по значку Copy и затем по значку Paste на панели инструментов, переместите 
курсор

начку + слева от 
гр

 от 
мо

ите его снизу и слева от модели 
M

T_PS1. Курсор должен отображаться в виде 
со

кой 

те 

нтов, переместите 
ку

 правой 

тите 

 
лжен 

 схемы балансно
 

 в выпадающем меню или щёлкните по значку New Schematic на панели инструментов. 
Откроется диалоговое окно Create New Schematic (Создание новой схемы). 

2. Наберите имя схемы BDMix и нажмите OK. Откроется окно схемы на 
появится, как подгруппа в группе Circuit Schematics (Схемы цепи) в окне просмотра 

проекта. 
3. Наж
осмотра элементов. 
4. В окне просмотр
уппы Microstrip, чтобы раскрыть её. 
5. Левой кнопкой мышки щёлкните 
шки на модель MLANGE и, не отпуская кнопки мышки, перетащите модель в окно схемы

отпустите кнопку, щёлкните правой кнопкой мышки, чтобы развернуть её, и, двигая мышкой, 
установите модель в левой части окна схемы и щёлкните левой кнопкой мышки, чтобы 
зафиксировать. 

6. В окне пр
уппы Transmission Line, чтобы раскрыть её. 
7. Левой кнопкой мышки щёлкните по подг
 модель TLIN и, не отпуская кнопки мышки, перетащите модель в окно схемы, отпустите 

кнопку и, двигая мышкой, установите модель на узел 3 элемента MLANGE и щёлкните левой
кнопкой мышки, чтобы зафиксировать. 

8. Левой кнопкой мышки щёлкните 
 Copy и затем по значку Paste на панели инструментов, чтобы скопировать и вставить 

элемент. Переместите курсор в окно схемы, установите скопированный элемент на узел 1 
элемента MLANGE и щёлкните левой кнопкой мышки. 

9. В окне просмотра элементов левой кнопкой мышк
уппы Nonlinear, чтобы раскрыть её. Затем щёлкните по подгруппе Diode. 
10. Перетащите модель диода SDIODE в окно схемы и подсоедините её к
LANGE. 
11. Щёлк

 в окно схемы, дважды щёлкните правой кнопкой мышки, чтобы развернуть элемент и 
подсоедините скопированную модель диода к узлу 2 модели MLANGE. 

12. В окне просмотра элементов левой кнопкой мышки щёлкните по з
уппы Popt, чтобы раскрыть её. Затем щёлкните по подгруппе Harmonic Balance. 
13. Перетащите модель PORT_PS1 в окно схемы, расположите его сверху и слева
дели MLANGE и щёлкните левой кнопкой мышки. 
14. Перетащите модель PORTF в окно схемы, располож
LANGE и щёлкните левой кнопкой мышки. 
15. Поместите курсор на клемму порта POR

леноида. Щёлкните левой 
кнопкой мышки, чтобы 
зафиксировать начало 
провода, переместите курсор 
к узлу 4 элемента MLANGE 
и щёлкните левой кноп
мышки. Аналогично 
соедините проводом порт 
PORTF с узлом 1 элемента 
MLANGE. 

16. Аналогично соедини
проводом правые клеммы 
диодов. 

17. Щёлкните по значку 
PORT на панели 
инструме
рсор в окно схемы, 

щёлкните два раза
кнопкой мышки, чтобы 
развернуть порт, помес
его справа от провода, 
соединяющего диоды. 
Поместите курсор на клемму
порта PORT. Курсор до
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ound на панели инструментов, переместите курсор в окно 
сх  

und на панели инструментов и подсоедините землю 
к н

олученная схема показана на рис. 3.31. 

едактирование элементов схемы балансного смесителя. 

1. Щёлкните левой кнопкой мышки по порту PORT_PS1, затем дважды щёлкните левой 
кн

кн к, 

 
он о

 
обавление подложки к схеме балансного смесителя. 

1. Нажмите левой кнопкой мышки на панель Elem в нижней части левого окна. 
жки), 

чтобы
MSUB в окно схемы и поместите её на свободном месте возле 

схемы
важды щёлкните левой кнопкой мышки по этой модели и в открывшемся окне 

от .31. 
 
оздание схемы фильтра нижних частот. 

1. Щёлкните по значку New Schematic на панели инструментов. Откроется диалоговое 
ок C

PF и нажмите OK. Откроется окно схемы на рабочем поле и 
схема 

кно 
пр

а элементов левой кнопкой мышки щёлкните по значку + слева от 
гр

по подгруппе Lines, нажмите левой кнопкой мышки на 
мо

отображаться в виде соленоида. Щёлкните левой кнопкой мышки, чтобы зафиксировать начало 
провода, переместите курсор к проводу, соединяющему диоды, и щёлкните левой кнопкой 
мышки, чтобы зафиксировать соединение. 

18. Щёлкните по значку Add Gr
емы, щёлкните два раза правой кнопкой мышки, чтобы развернуть землю и подсоедините её

к верхнему узлу элемента TLIN ID=TL2. 
19. Снова щёлкните по значку Add Gro
ижнему узлу элемента TLIN ID=TL3. 
 
П

 
Р
 

опкой мышки по этому порту. В открывшемся окне отредактируйте параметры порта так, 
чтобы их значения соответствовали указанным на рис. 3.32, затем нажмите панель Port в 
верхней части окна и отметьте переключатель Tone 1 (если он не отмечен), нажмите OK.  

2. Щёлкните левой кнопкой мышки по порту PORTF, затем дважды щёлкните левой 
опкой мышки по этому порту. В открывшемся окне отредактируйте параметры порта та

чтобы их значения соответствовали указанным на рис. 3.33, затем нажмите панель Port в 
верхней части окна и отметьте переключатель Tone 2 (если он не отмечен), нажмите OK.  

3. Аналогично отредактируйте параметры всех остальных элементов в схеме так, чтобы
и с ответствовали указанным в схеме рис. 3.31. 

Д
 

2. Щёлкните левой кнопкой мышки по значку + слева от группы Substrates (Подло
 развернуть группу. 

3. Перетащите модель 
. 

4. Д
редактируйте параметры так, чтобы их значения соответствовали указанным на рис. 3

С
 

но reate New Schematic. 
2. Наберите имя схемы L

появится, как подгруппа в группе Circuit Schematics в окне просмотра проекта. 
3. Нажмите панель Elem (Элементы) в нижней части левого окна, чтобы открыть о
осмотра элементов. 
4. В окне просмотр
уппы Microstrip, чтобы раскрыть её. 
5. Левой кнопкой мышки щёлкните 
дель MLIN и, не отпуская кнопки мышки, перетащите модель в окно схемы, отпустите 



кнопку, и, двигая мышкой, установите модель в левой части окна схемы и щёлкните левой 
кнопкой мышки, чтобы зафиксировать. 

6. В окне просмотра элементов левой кнопкой мышки щёлкните по значку + слева от 
группы Lumped Element, чтобы раскрыть её. Затем щёлкните левой кнопкой мышки по 
подгруппе Inductor. 

7. Перетащите модель INDQ в окно схемы и подсоедините её к правому концу элемента 
MLIN. 

8. Щёлкните левой кнопкой мышки по значку Copy и затем по значку Paste на панели 
инструментов. Скопированную модель индуктивности подсоедините к правому концу 
индуктивности INDQ ID=L1. 

9. Левой кнопкой мышки щёлкните по подгруппе Capacitor. 
10. Перетащите модель CAP в окно схемы, щёлкните правой кнопкой мышки, чтобы 

повернуть модель и подсоедините её к левому узлу модели INDQ ID=L1. 
11. Щёлкните левой кнопкой мышки по значку Copy и затем по значку Paste на панели 

инструментов. Скопированную модель ёмкости подсоедините к правому узлу индуктивности 
INDQ ID=L1. 

12. Перетащите модель CAP в окно схемы из окна просмотра элементов и подсоедините её 
к правому узлу модели INDQ ID=L2. 

13. Поместите курсор на нижний узел ёмкости C1 так, чтобы он отображался в виде 
соленоида, и щёлкните левой кнопкой мышки, чтобы зафиксировать начало провода. 
Переместите курсор к нижнему узлу ёмкости C2 и щёлкните левой кнопкой мышки, чтобы 
зафиксировать провод. 

14. Щёлкните по значку Add Port на панели инструментов, переместите курсор в окно 
схемы, подсоедините его к левому узлу модели MLIN и щёлкните левой кнопкой мышки, 
чтобы зафиксировать. 

15. Снова щёлкните по значку Add Port на панели инструментов, переместите курсор в 
окно схемы, щёлкните два раза правой кнопкой мышки, чтобы повернуть модель и 
подсоедините её к правому узлу модели CAP C1. 

16. Щёлкните по значку Add Ground на панели инструментов, переместите курсор в окно 
схемы и поместите землю ниже провода, соединяющего ёмкости C1 и C2. 

17. Поместите курсор на узел земли так, чтобы он отображался в виде соленоида, и 
щёлкните левой кнопкой мышки, чтобы зафиксировать начало провода. Переместите курсор к 
проводу, соединяющему ёмкости C1 и C2, щёлкните левой кнопкой мышки, чтобы 
зафиксировать провод. 

 
Полученная схема фильтра нижних частот показана на рис. 3.34. 

 
Редактирование элементов схемы фильтра нижних частот. 
 

1. Щёлкните левой кнопкой мышки по элементу MLIN ID=1, затем дважды щёлкните 
левой кнопкой мышки по этому элементу. В открывшемся окне отредактируйте параметры 
элемента так, чтобы их значения соответствовали указанным на рис. 3.32. 

2. Аналогично отредактируйте параметры всех элементов в схеме. 
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Создание графика характеристики ФНЧ и добавление измеряемых величин. 
 

1. Щёлкните левой кнопкой мышки по значку Add Graphs на панели инструментов и в 
открывшемся окне введите имя графика LPF. Нажмите OK. Появится окно графика LPF. 

2. Щёлкните левой кнопкой мышки 
по значку Add Measurement на панели 
инструментов. Откроется диалоговое 
окно Add Measurement. 
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3. В окне списка Meas. Type 
отметьте Port Parameters, в окне списка 
Measurement отметьте S. в поле ввода 
Data Source Name введите LPF, в поле 
ввода To Port Index введите 2, в поле 
ввода From Port Index введите 1, 
щёлкните левой кнопкой мышки по 
переключателям DB и Mag, нажмите 
Apply. 

4. Введите 1 в поля ввода To Port 
Index и From Port Index, нажмите 
Apply. 

5. Нажмите OK. 
6. Щёлкните левой кнопкой мышки 

по значку Analyze на панели 
инструментов. Полученный график показан на рис. 3. 35. 

 
Добавление фильтра нижних частот к схеме смесителя. 
 

1. Щёлкните левой кнопкой мышки по окну схемы балансного смесителя, чтобы сделать 
его активным. 

2. Нажмите клавишу Ctrl и, не отпуская её, нажмите левой кнопкой мышки на порт 3. Не 
отпуская клавиши и кнопки мышки, оттащите порт 3 вправо, чтобы оборвать его соединение со 
схемой. 

 
3. Нажмите левой 

кнопкой мышки на 
панель Elem в 
нижней части левого 
окна, чтобы открыть 
окно просмотра 
элементов. 

4. Щёлкните 
левой кнопкой 
мышки по группе 
Subcircuits 
(Подсхемы). 

5. Перетащите 
подсхему LPF в окно 
схемы смесителя и 
подключите её между 
ёмкостью C3 и 
портом 3. 
Окончательная схема 
смесителя показана 
на рис. 3.36. 

 
 
 

Установка количества гармоник. 
 

1. Нажмите левой кнопкой мышки на панель Proj в нижней части окна, чтобы открыть 
окно просмотра проекта. 

2. Щёлкните правой кнопкой мышки по группе Circuit Schematics и выберите Options во 
всплывающем меню. Откроется диалоговое окно Circuit Options (рис 3.37). 



3. Введите 7 в поле ввода Number of tone 1 harmonics (Количество гармоник 1-ой 
частоты), введите 2 в поле 
ввода Number of tone 2 
harmonics, введите 9 в поле 
ввода Max order (Макс. 
Количество), введите 4 в поле 
ввода Samples rel. Nyquist 
(Коэффициент Найквиста), 
установите галочку в поле 
Limit harmonics order 
(Ограничить количество 
гармоник), снимите галочку в 
поле Use frequency mapping 
(использовать зеркальную 
частоту), если эта галочка 
стоит, введите 1000 в поле 
ввода Max number of 
iteration (Максимальное 
количество итераций). 
Нажмите OK. 

 
Установка частоты гетеродина. 
 

1. В окне просмотра проекта щёлкните правой кнопкой мышки по подгруппе BDMix в 
группе Circuit Schematics и выберите Options во всплывающем меню. В открывшемся окне 
Options уберите галочку в поле Use project frequency, введите 3.5 в поле Start, 4 в поле Stop и 
0.5 в поле Step. Нажмите Apply. Затем в окне списка Current Range выделите 4 и нажмите на 
панель Delete Selected (Удалить выделенное). В полях Start, Stop и Step удалите введённые 
значения, выделяя их левой кнопкой мышки и нажимая клавишу Delete. 

2. Нажмите OK. 
 
Создание графика потерь преобразования и добавление измеряемых величин. 

 
1. Щёлкните левой 

кнопкой мышки по значку 
Add Graphs на панели 
инструментов и в 
открывшемся окне введите 
имя графика Conversion Loss. 
Нажмите OK. Появится окно 
графика Conversion Loss. 

2. Щёлкните левой 
кнопкой мышки по значку 
Add Measurement на панели 
инструментов. Откроется 
диалоговое окно Add 
Measurement. 
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ле 
_3, в 

c 

 и 1, 

 
ите 

3. В окне списка Meas. Type 
отметьте Nonlinear Power, в окне 
списка Measurement отметьте 
LSSnm2SP, в поле ввода Data 
Source Name введите BDMix, в по
ввода Port (To) введите PORT
поле ввода Port (From) введите 
PORT_1, в верхних полях Harmoni
Index введите –1 и 1, в нижних 
полях Harmonic Index введите 0
щёлкая по стрелкам справа от этих 
полей, в поле ввода Frequency Swp
Index (3.5 GHz) введите 1, щёлкн
левой кнопкой мышки по 
переключателям DB и Mag, 
нажмите Apply (Рис.3.38). 

4. Нажмите OK. 



5. Щёлкните левой кнопкой мышки по значку Analyze на панели инструментов. 
Полученный график показан на рис. 3.39. 

 
Создание графика изменения тока промежуточной частоты во времени и 
добавление измеряемых величин. 
 

1. Щёлкните левой кнопкой мышки по значку Add Graphs на панели инструментов и в 
открывшемся окне введите имя графика Conversion Loss. Нажмите OK. Появится окно 

графика Conversion Loss. 
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2. Щёлкните левой кнопкой 
мышки по значку Add Measurement 
на панели инструментов. Откроется 
диалоговое окно Add Measurement. 

3. В окне списка Meas. Type 
отметьте Nonlinear Current, в окне 
списка Measurement отметьте Itime
в поле ввода Data Source Name 
введите BDMix, в поле ввода 
Measurement Component введите 
PORT_3, в поле ввода Frequency 
Swp Index (3.5 GHz) введите 1, в 
поле ввода Power Swp Index (0 
dBm) введите 1, нажмите Apply. 

4. В поле ввода Power Swp 
Index (0 dBm) введите 3, нажмите 
Apply. 

5. В поле ввода Power Swp Index (0 dBm) введите 5, нажмите Apply. 
6. Нажмите OK. 
7. Щёлкните левой кнопкой мышки по значку Analyze на панели инструментов. 

Полученный график показан на рис. 3.40. 
 
Создание графика развязки между радиочастотами и гетеродином, и между 
гетеродином и радиочастотами, добавление измеряемых величин. 
 

1. Щёлкните левой кнопкой мышки по значку Add Graphs на панели инструментов и в 
открывшемся окне введите имя графика Isolation. Нажмите OK. Появится окно графика 
Isolation. 

2. Щёлкните левой кнопкой 
мышки по значку Add Measurement 
на панели инструментов. Откроется 
диалоговое окно Add Measurement. 

3. В окне списка Meas. Type 
отметьте Nonlinear Power, в окне 
списка Measurement отметьте 
LSSnm2SP, в поле ввода Data Source 
Name введите BDMix, в поле ввода 
Port (To) введите PORT_1, в поле 
ввода Port (From) введите PORT_2, в 
верхних полях Harmonic Index 
введите 1 и 0, в нижних полях 
Harmonic Index введите 1 и 0, щёлкая 
по стрелкам справа от этих полей, в 
поле ввода Frequency Swp Index (3.5 
GHz) введите 1, щёлкните левой 
кнопкой мышки по переключателям 
DB и Mag, нажмите Apply. 

4. В поле ввода Port (To) введите 
PORT_2, в поле ввода Port (From) 
введите PORT_1, в верхних полях 

Harmonic Index введите 0 и 1, в нижних полях Harmonic Index введите 0 и 1, щёлкая по 
стрелкам справа от этих полей, нажмите Apply. 

5. Нажмите OK. 
6. Щёлкните левой кнопкой мышки по значку Analyze на панели инструментов. 

Полученный график показан на рис. 3.41. 



Спектральный анализ и добавление измеряемых величин. 
 

1. Щёлкните левой кнопкой мышки по значку Add Graphs на панели инструментов и в 
открывшемся окне введите имя графика Spectrum Analyzer. Нажмите OK. Появится окно 
графика Spectrum Analyzer. 

2. Щёлкните левой кнопкой мышки по значку Add Measurement на панели инструментов. 
Откроется диалоговое окно Add Measurement. 

3. В окне списка Meas. Type отметьте Nonlinear Power, в окне списка Measurement 
отметьте Pharm, в поле 
ввода Data Source 
Name введите BDMix, , 
в поле ввода 
Measurement 
Component введите 
PORT_3, в поле ввода 
Frequency Swp Index 
(3.5 GHz) введите 1, в 
поле ввода Power Swp 
Index (0 dBm) введите 
1, нажмите Apply. 

4. В поле ввода 
Power Swp Index (0 
dBm) введите 3, 
нажмите Apply. 

5. В поле ввода 
Power Swp Index (0 
dBm) введите 5, 
нажмите Apply. 

6. Нажмите OK. 
7. Щёлкните левой кнопкой мышки по значку Analyze на панели инструментов. 

Полученный график показан на рис. 3.42. 

3.3. Моделирование фазового модулятора с регулировкой 
смещения постоянным током. 

 
Этот пример показывает, как использовать Microwave Office, чтобы моделировать фазовый 

модулятор, используя ряды Вольтерра. 
 
Создание нового проекта. 

 
1. Выберите File > New Project (Файл > Новый проект) в выпадающем меню. 
2. Выберите File > Save Project As (Файл > Сохранить проект как) в выпадающем меню. 

Откроется диалоговое окно Save As. 
3. Наберите имя проекта FM и нажмите Сохранить. 

 
Установка единиц измерения, используемых по умолчанию. 

 
Чтобы установить единицы 

измерения, которые будут 
использоваться в проекте по умолчанию: 
 

1. Выберите Options > 
Project Options (Опции > 
Опции проекта) в выпадающем 
меню. Откроется диалоговое 
окно Project Options. 

2. Нажмите панель Global 
Options (Глобальные опции) в 
верхней части диалогового 
окна. 

3. Установите нужные 
единицы измерения, щёлкая по 
стрелкам, справа от поля ввода 
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соответствующей единицы так, чтобы они соответствовали показанным на рис. 3.43 и нажмите 
OK. 

 
Установка глобальных частот проекта. 

 
Чтобы установить частоты моделирования, которые будут использоваться в проекте по 

умолчанию: 
 

1. Выберите Options > 
Project Options (Опции > 
Опции проекта) в выпадающем 
меню. Откроется диалоговое 
окно Project Options. 
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а. 
Нажмите панель 

Fr те 80 в 

ся в 

оздание схемы фазового модулятора. 

1. Щёлкните левой кнопкой мышки по значку New Schematic на панели инструментов. 
От

ткроется окно схемы на рабочем поле и 
схема 

мите панель Elem (Элементы) в нижней части левого окна, чтобы открыть окно 
пр

а элементов левой кнопкой мышки щёлкните по значку + слева от 
гр

руппе Capacitor в группе Lumped Element. 

пе а ти окна 

те по значку + слева от 
гр

 по подгруппе Volterra Devices в группе Nonlinear. 

пе а й 
 

и щёлкните по значку + слева от 
гр

перетащите её в окно схемы. Отпустите кнопку мышки, три раза щёлкните правой кнопкой 

2. Нажмите панель Global 
Options (Глобальные опции) в 
верхней части диалогового окн

3. 
equency Values. Введи

поле Start, 160 в поле Stop, 2 в 
поле Step. Нажмите Apply. 
Диапазон частот отображает
окне списка Frequency Value, 
как показано на рис.3.44.  

4. Нажмите OK. 
 
 

С
 

кроется диалоговое окно Create New Schematic. 
2. Наберите имя схемы Tuner и нажмите OK. О

появится, как подгруппа в группе Circuit Schematics (Схемы цепи) в окне просмотра 
проекта. 

3. Наж
осмотра элементов. 
4. В окне просмотр
уппы Lumped Element, чтобы раскрыть её. 
5. Щёлкните левой кнопкой мышки по подг
6. Нажмите левой кнопкой мышки на модель CAP и, не отпуская кнопки мышки, 
рет щите её в окно схемы. Отпустите кнопку мышки, установите модель в левой час

схемы и щёлкните левой кнопкой мышки, чтобы зафиксировать. 
7. В окне просмотра элементов левой кнопкой мышки щёлкни
уппы Nonlinear, чтобы раскрыть её. 
8. Щёлкните левой кнопкой мышки
9. Нажмите левой кнопкой мышки на модель VCJCN и, не отпуская кнопки мышки, 
рет щите её в окно схемы. Отпустите кнопку мышки, три раза щёлкните правой кнопко

мышки, чтобы развернуть модель, подключите модель к правому концу конденсатора CAP и
щёлкните левой кнопкой мышки, чтобы зафиксировать. 

10. В окне просмотра элементов левой кнопкой мышк
уппы Lumped Element, чтобы раскрыть её. 

11. Щёлкните левой кнопкой мышки по подгруппе Inductor в группе Lumped Element. 
12. Нажмите левой кнопкой мышки на модель IND и, не отпуская кнопки мышки, 



мы те левой 

кнопку мышки, три раза щёлкните правой кнопкой 
мы  

в 
й мышки, чтобы зафиксировать начало провода. 

Пе

й мышки по значку Add Ground на панели инструментов. 
Пе и IND 
и 

моделям VCJCN, IND, CAP ID=C2, 
по

 
и элементы. Переместите курсор в окно схемы, подсоедините 

ск  

вой 
 по значку Paste, чтобы скопировать и вставить 

ко
, 

скрыть её. 

шки на модель PORT2V и, не отпуская кнопки мышки, 
пе й клемме 
ле

ра и 
а рис. 

 
Создани еменной для изменения напряжения смещения на элементе VCJCN. 

панели инструментов. 

оле ввода в удобном месте окна схемы, например, как показано на рис. 
3. и и щёлкните левой 
кн

 
Редакти . 

 
1. Щёлкните левой 

кнопкой мышки по 
эл н  

 этому 

они 

уйте значения 
па ого 

шки, чтобы развернуть модель, установите модель правее модели VCJCN и щёлкни
кнопкой мышки, чтобы зафиксировать. 

13. Нажмите левой кнопкой мышки на модель CAP и, не отпуская кнопки мышки, 
перетащите её в окно схемы. Отпустите 

шки, чтобы развернуть модель, установите модель правее модели IND и щёлкните левой
кнопкой мышки, чтобы зафиксировать. 

14. Поместите курсор на верхнюю клемму модели VCJCN. Курсор должен отображаться 
виде соленоида. Щёлкните левой кнопко

ретащите курсор к верхней клемме конденсатора CAP и щёлкните левой кнопкой мышки, 
чтобы зафиксировать провод. 

15. Аналогично соедините проводом нижние клеммы моделей VCJCN, IND и CAP. 
16. Щёлкните левой кнопко
реместите курсор в окно схемы, подсоедините землю к нижней клемме индуктивност
щёлкните левой кнопкой мышки, чтобы зафиксировать. 
17. Щёлкните левой кнопкой мышки по левой ёмкости CAP ID=C1, нажмите клавишу Ctrl 

и удерживая клавишу, щёлкните левой кнопкой мышки по 
 земле и по всем проводам, соединяющим элементы, чтобы выделить эти элементы, 

отпустите клавишу Ctrl. 
18. Щёлкните левой кнопкой мышки по значку Copy и затем по значку Paste, чтобы

скопировать и вставить эт
опированные элементы к верхней клемме конденсатора CAP ID=C2 и щёлкните левой

кнопкой мышки, чтобы зафиксировать. 
19. Щёлкните левой кнопкой мышки по левой ёмкости CAP ID=C1, затем щёлкните ле

кнопкой мышки по значку Copy и затем
нденсатор. Переместите курсор в окно схемы, подсоедините скопированный конденсатор к 

верхней клемме последнего конденсатора CAP ID=C2 и щёлкните левой кнопкой мышки
чтобы зафиксировать. 

20. В окне просмотра элементов левой кнопкой мышки щёлкните по значку + слева от 
группы Ports, чтобы ра

21. Щёлкните левой кнопкой мышки по подгруппе Volterra в группе Ports. 
22. Нажмите левой кнопкой мы
ретащите её в окно схемы. Отпустите кнопку мышки, подключите порт к лево
вого конденсатора в схеме и щёлкните левой кнопкой мышки, чтобы зафиксировать. 
23. Щёлкните левой кнопкой мышки по значку Add Port на панели инструментов, 

переместите курсор в окно схемы, два раза щёлкните правой кнопкой мышки, чтобы 
звернуть порт, подсоедините его к правой клемме последнего конденсатора в схеме 

щёлкните левой кнопкой мышки, чтобы зафиксировать. Полученная схема показана н
3.45. 

е пер
 

1. Щёлкните левой кнопкой мышки по значку Add Equation (Добавить уравнение) на 

2. Переместите курсор в окно схемы, появится небольшое поле ввода. 
3. Поместите это п

 45  щёлкните левой кнопкой мышки. Введите в поле ввода Vbias=-0.08 
опкой мышки вне этого поля. 

рование элементов схемы

еме ту VCJCN и затем
дважды щёлкните по
элементу. В открывшемся 
окне Element Options 
отредактируйте значения 
параметров так, чтобы 
соответствовали 
значениям, указанным на 
рис. 3.46. 

2. Аналогично 
отредактир
раметров для втор

элемента VCJCN. 
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я параметров для всех остальных элементов схемы 
та т

 
оздание графика коэффициента отражения от входа схемы и добавление 

1. Щёлкните по значку Add Graph на панели инструментов. 
афика), выберите 

Re
dd 

M

 Port Parameter в 
списке

ta 
 

 и 

ex 

й кнопкой 
мышки ли 

рис. 3.47. 
 
оздание графика выходной мощности интермодуляционных искажений. 

1. Щёлкните по 
значку  

гр к er 

 в 

те по 
значку

t на панели 

 
No  

 в 

 

. 

по

 Harmonic Index (360 MHz), нажмите Apply

3. Аналогично отредактируйте значени
к, ч обы они соответствовали значениям, указанным на схеме рис. 3.45. 

С
измеряемых величин. 
 

2. Введите имя графика Input RL в поле Graph name (Имя гр
ctangular (Прямоугольный) в области Graph Type (Тип графика) и нажмите OK. 

3. Щёлкните по значку A
easurement на панели 

инструментов. 
4. Выберите

 Meas. Type, S в списке 
Measurement, Tuner в поле Da
Source Name, введите 1 в полях To
Port Index (Индекс входного порта),
From Port Index (Индекс выходного 
порта), нажимая на стрелки справа от 
этих полей, отметьте DB в области 
Result Type и Mag в области Compl
Modifier, нажмите Apply. 

5. Нажмите OK. 
6. Щёлкните лево

 по значку Analyze на пане
инструментов. Полученный график показан на 

С
 

 Add Graph на
панели инструментов. 

2. Введите имя 
афи а Output Pow

в поле Graph name, 
выберите Rectangular
области Graph Type и 
нажмите OK. 

3. Щёлкни
 Add 

Measuremen
инструментов. 

4. Выберите
nlinear Power в

списке Meas. Type, 
Pcomp2 в списке 
Measurement, Tuner
поле Data Source Name, 
введите 0 и 2 в полях 
Harmonic Index (360 
MHz), 1 в поле Power 
Swp Index (-50), 
нажимая на стрелки 
справа от этих полей, 
отметьте DB в области
Result Type и Mag в 
области Complex 
Modifier, нажмите 
Apply (см. рис. 3.48)

5. Введите 2 и 1 в 
 лях Harmonic Index 

6. Введите -1 и 2 в полях . 
(360 MHz), нажмите Apply. 

7. Нажмите OK. 
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й кнопкой мышки по значку Analyze на панели инструментов. 
По

 
астройка схемы изменением величины напряжения смещения. 

1. Щёлкните по окну 
схемы

ните по значку 

Tune Tool

8. Щёлкните лево
лученный график показан на рис. 3.49. 

Н
 

, чтобы сделать его 
активным. 

2. Щёлк

  
(Инструмен
панели инструментов. 

3. Поместите курсо

т настройки) на 

р на 
пе

м 
ой 

ройки. 

Tune

ременную Vbias в окне 
схемы. Курсор должен 
отображаться в виде 
перекрестия (белое 
перекрестие в чёрно
кружке). Щёлкните лев
кнопкой мышки, чтобы 
активизировать эту 
переменную для наст

4. Щёлкните по значку 

 на панели 
 

е на 

ерите Window > 
еменно оба а

ки, двигайте 
ег

е окончания настройки, закройте окно Variable Tuner. 
 

Примечание. Пределы регулировки при желании можно изменить, введя соответствующие 
 и 

инструментов. Откроется
диалоговое окно Variable 
Tuner (Блок настройки 
переменных), показанно
рис. 3.50. 

5. Выб
Tile Horizontal в выпадающем меню, чтобы видеть одновр  гр фика. 

6. Нажмите левой кнопкой мышки на бегунок настройки и, не отпуская кноп
о вверх и вниз. Результаты настройки изменением напряжения смещения наблюдайте на 

графиках. 
7. Посл

значения максимальной и минимальной величины напряжения смещения в поля ввода Max->
Min-> в окне Variable Tuner. 



4. Электромагнитное моделирование 
Электромагнитное моделирование (EM) использует уравнения Максвелла для определения 

характеристик устройства по его заданной физической геометрии. С помощью электромагнитного 
моделирования можно анализировать произвольные структуры и обеспечивать очень точные результаты. 
Кроме того, электромагнитное моделирование свободно от ограничений, имеющихся в моделях 
электрических цепей, т.к. использует фундаментальные уравнения для вычисления характеристик. 
Недостатком такого моделирования является то, что, в зависимости от сложности структуры, 
увеличивается необходимый объём оперативной памяти и увеличивается время моделирования по 
экспоненте. Поэтому важно минимизировать сложность структуры, чтобы время моделирования было 
приемлемым, а требуемый объём оперативной памяти не превышал имеющийся на компьютере. 

Электромагнитное и схемотехническое моделирования – это дополняющие друг друга методы 
для проектирования интегральных схем. Используя комбинации этих методов, можно решить многие 
проблемы проекта. 

Блок электромагнитного моделирования в Microwave Office, известный как EMSight, способен 
моделировать планарные трёхмерные структуры, содержащие множество металлических и 
диэлектрических слоёв. Структуры могут иметь межслойные переходы или заземления. EMSight 
использует метод моментов Галёркина в спектральной области, который является чрезвычайно точным 
для анализа полосковых, микрополосковых, компланарных, а также других произвольных структур. 
Используемая должным образом, эта методика может обеспечивать точные результаты моделирования 
до 100 ГГц и выше. 

Следующие примеры показывают некоторые из основных особенностей электромагнитного 
моделирования в Microwave Office. 

4.1. Моделирование стержневого микрополоскового фильтра 
Этот пример показывает, как использовать электромагнитное моделирование в Microwave Office 

для проектирования стержневого микрополоскового фильтра. Такое моделирование включает 
следующие основные шаги: 
 

o Создание электромагнитной структуры; 
o Определение корпуса; 
o Добавление параметров подложки: 
o Создание топологии; 
o Моделирование межслойных переходов; 
o Определение портов и площадок для токов возбуждения; 
o Просмотр плотности тока и электрических полей. 

 
Создание нового проекта. 

 
Чтобы создать новый проект: 
 

1. Выберите File > New Project (Файл > Новый проект) в выпадающем меню. 
2. Выберите File > Save Project As (Файл > Сохранить проект как) в выпадающем меню. 

Откроется диалоговое окно Save As. 
3. Наберите имя проекта (например, EM-example) и нажмите Сохранить. 

 
Создание электромагнитной структуры. 
 
Чтобы создать новую электромагнитную структуру: 
 

1. Выберите Project > Add EM Structure > New EM Structure… в выпадающем меню или 

щёлкните левой кнопкой мышки по значку New EM Structure  на панели инструментов. 
2. Наберите Interdigital Filter (Стержневой фильтр) в поле Enter EM Structure Name 

(Ввод имени электромагнитной структуры) и нажмите OK. На рабочем поле откроется окно 
электромагнитной структуры (рис. 4.1). 
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Определение корпуса. 

 
Примечание. EMSight использует прямоугольную сетку для представления структуры. Для 
проекта лучше использовать по возможности более грубую сетку, поскольку это уменьшает 
время моделирования. Здесь нужно искать компромисс между временем моделирования и 
точностью. 
 
При определении корпуса задаются все диэлектрические материалы для каждого из слоёв в 

электромагнитной структуре, краевые условия, все физические размеры структуры и минимальные 
размеры сетки, которые будут использоваться. 

Чтобы определить корпус: 
 

1. Дважды щёлкните левой кнопкой мышки по подгруппе Enclosure (Корпус) в дереве 
стержневого фильтра 
Interdigital Filter (в 
группе EM 
Structures) в окне 
просмотра проекта 
(см. рис. 4.1) или 
щёлкните левой 
кнопкой мышки по 
значку Enclosure 

 на панели 
инструментов. 
Откроется диалоговое 
окно Substrate 
Information 
(Информация о 
подложке), 
показанное на рис. 
4.2. Нажмите панель 
Enclosure в верхней 

части окна. 
2. В области Units (Единицы) установите переключатель Metric (Метрические) и, щёлкая 

по стрелкам справа, установите единицы измерения mm. 
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3. В области Box Dimension (Размер корпуса) наберите 10 в поле X – Dimension (размер по 
X), наберите 50 в поле X – Divisions (количество делений по оси X), наберите 10 в поле Y – 
Dimension, наберите 50 в поле Y – Divisions. В поле Cell Size (Размер ячейки) показывается 
размер сетки по X и Y. 

 
Чтобы определить диэлектрические слои корпуса: 

 
4. Нажмите на панель Dielectric Layers (Диэлектрические слои) в верхней части 

диалогового окна Substrate Information (см. рис. 4.3). 
5. Щёлкните левой кнопкой мышки по Layer 1 (Слой 1) в зоне Dielectric Layers 

Parameters (Параметры 
диэлектрических слоёв). 
Введите 3 в окне 
редактирования ниже 
поля Thickness 
(Толщина). Введите 1 в 
окне редактирования 
ниже поля Er ( rε ). 
Оставьте значения по 
умолчанию для 
оставшихся полей (см. 
рис. 4. 3). 
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Примечание. Моделирование 
будет выполняться тем быстрее, 
чем меньше потери. Чтобы 
использовать это преимущество, 
устанавливают тангенс потерь 
равным нулю и используют 

идеальные проводники и межслойные переходы в электромагнитной структуре. 
 

6. Щёлкните левой кнопкой мышки по Layer 2 (Слой 2) в зоне Dielectric Layers 
Parameters. Введите 0.635 в окне редактирования ниже поля Thickness. Введите 9.8 в окне 
редактирования ниже поля Er. Введите 0.001 в поле ввода Loss Tangent (Тангенс угла потерь). 
Введите 4 в поле ввода View Scale (Масштаб просмотра), это увеличит толщину этого слоя в 
четыре раза при просмотре 3-х мерного изображения. 

 
Примечание. В окне рис. 4.3 по умолчанию устанавливается два слоя. Чтобы добавить ещё 
слой, надо нажать кнопку Add Above или Add Below. Чтобы удалить слой, надо нажать кнопку 
Delete. Слои удаляются поочерёдно, начиная с последнего слоя. Верхние два слоя не удаляются 
никогда. 

 
Краевые условия для боковых стенок – всегда идеальные проводники и не могут изменяться. 

Верхняя и нижняя крышки по умолчанию так же идеальные проводники, но по желанию могут быть 
заданы и с потерями. В этом 
примере мы не будем изменять 
краевые условия, заданные по 
умолчанию. 

 
Чтобы просмотреть 

краевые условия: 
 

7. Нажмите 
Boundaries (Границы) в 
верхней части 
диалогового окна 
Substrate Information и, 
просмотрев (рис. 4.4), 
нажмите OK, чтобы 
завершить определение 
корпуса. 

 
 
 



Создание топологии. 
 

Чтобы создать физические структуры для моделирования, можно использовать имитатор 
электромагнитных структур, имеющийся в Microwave Office. Можно так же импортировать структуры 
непосредственно из инструмента топологии Applied Wave Research’s (Прикладное волновое 
исследование) или импортировать структуры из файлов формата AutoCAD DXF, GDSII или Sonnet GEO. 
В этом примере мы введём топологию микрополоскового стержневого фильтра, используя имитатор 
электромагнитных структур. 

Microwave Office поддерживает абсолютные координаты и относительные. Абсолютные 
координаты относятся ко всему корпусу (подложке) электромагнитной структуры, а относительные 
только к отдельному элементу структуры, например, к прямоугольному проводнику. Абсолютная 
координата x=0 соответствует левому краю корпуса электромагнитной структуры, а координата y=0 – 
верхнему краю корпуса. Относительная координата x=0 соответствует левому краю элемента, например, 
прямоугольного проводника, а y=0 – верхнему краю элемента. 

Чтобы ввести топологию: 
 

1. Выберите Draw > Add Rectangular 
Conductor (Рисовать >Добавить 
прямоугольный проводник) в выпадающем 
меню или щёлкните левой кнопкой мышки 

по значку Add Rect Conductor  на 
панели инструментов. 

2. Поместите курсор в окно 
стержневого фильтра и нажмите клавишу 
Tab на клавиатуре. Откроется диалоговое 
окно Enter Coordinates (Ввод координат), 
показанное на рис. 4.5. 

3. Введите 0 в поле x, введите 2.2 в поле 
y и нажмите OK. 

 
Примечание. Переход между полями ввода можно 
делать, щёлкая левой кнопкой мышки по нужному 
полю ввода или нажимая клавишу Tab на клавиатуре. 
 

4. Нажмите клавишу Tab снова, чтобы открыть диалоговое окно Enter Coordinates. 
Установите флажок в переключателе Re, чтобы активизировать относительные координаты. 
Введите 2.2 в поле dx, 0.6 в поле dy и нажмите OK. Проводник прямоугольного сечения 
отображается в окне электромагнитной структуры (Рис. 4.6). 

 
Примечание. Чтобы удалить неверно вставленный проводник, щёлкните по нему левой кнопкой 
мышки и нажмите клавишу Delete. 

 
Введите второй проводник 

прямоугольного сечения: 
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5. Выберите Draw > 
Add Rectangular 
Conductor в выпадающем 
меню или щёлкните левой 
кнопкой мышки по значку 
Add Rect Conductor на 
панели инструментов. 

6. Поместите курсор в
окно стержневого фи
и нажмите клавишу Tab
Откроется диалоговое 
окно Enter Coordinates. 
Введите 4 в поле x, 
введите 2 в поле y и 
нажмите OK. 

 
льтра 

. 

7. Нажмите клавишу 
Tab, чтобы снова открыть 
диалоговое окно Enter 

Coordinates. Установите флажок в переключателе Re, чтобы активизировать относительные 



координаты. Введите 1.2 в поле dx, 7.2 в поле dy и нажмите OK. Второй проводник 
прямоугольного сечения отображается в окне электромагнитной структуры (рис. 4.6). 

8. Щёлкните левой кнопкой мышки по второму проводнику в окне электромагнитной 
структуры. Квадратные площадки появятся в углах проводника (рис. 4 6). 

9. Двигайте курсор по проводнику, пока вид курсора будет отображаться в виде 
перекрестия. 

10. Нажмите и удержите левую кнопку мышки. пока появятся значения dx и dy в окне. 
11. Не отпуская кнопки мышки, двигайте курсор, пока значения dx и dy не будут 

отображать dx:-2 и dy:-1 (рис. 4.6). При этом отпустите кнопку мышки, чтобы зафиксировать 
проводник. 

Примечание. Щёлкните по значку Ruler (Линейка)  на панели инструментов, чтобы 
измерить размеры проводников, смещения или зазоры в топологии электромагнитной 
структуры. 

 
Добавление межслойных переходов (металлизированных отверстий). 
 

Межслойные переходы осуществляют связь между слоями структуры. Мы должны добавить 
заземление одной стороны большого проводника на основание корпуса. Чтобы сделать это: 
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1. Выберите Draw > Add Via 
(Рисовать > Добавить 
межслойный переход) в 
выпадающем меню или щёлкните 
левой кнопкой мышки по значку 

Add Via  на панели 
инструментов. 

2. Поместите курсор в окно 
Interdigital Filter и нажмите 
клавишу Tab. Откроется 
диалоговое окно Enter 
Coordinates. Введите 2.4 в поле x, 
введите 1.2 в поле y и нажмите 
OK. 

3. Нажмите клавишу Tab снова, 
чтобы открыть диалоговое окно 
Enter Coordinates. Установите 

флажок в переключателе Re, чтобы активизировать относительные координаты. Введите 
0.4 в поле dx, 0.8 в поле dy и 
нажмите OK. Межслойный 
переход появится в окне 
Interdigital Filter в виде синих 
квадратов в угле проводника, что 
указывает на то, что переход 
выбран (см. рис. 4.7). 

4. Выберите Edit > Copy (Редактор 
> Копировать) в выпадающем 
меню и затем выберите Edit > 
Paste (Редактор > Вставить) или 
нажмите левой кнопкой мышки на

значок Copy 

 

 и затем на 

значок Paste  на панели 
инструментов. 

5. Поместите курсор мышки в окно 
электромагнитной структуры. 
Контур скопированного 

межслойного перехода будет отображаться в окне. 
6. Щёлкните правой кнопкой мышки, чтобы его развернуть. 
7. Нажмите клавишу Tab, чтобы отобразить диалоговое окно Enter Coordinates. Снимите 

галочку в переключателе Re, чтобы установить абсолютные координаты. Введите 2.2 в 
поле x, введите 1.8 в поле y и нажмите OK. Новая электромагнитная структура показана 
на рис. 4.8. 



Примечание. Не обязательно использовать мелкую сетку (рис. 4.9), чтобы аппроксимировать 
круглое отверстие межслойного перехода. 
Точность моделирования будет достаточной, если 
цилиндрическое отверстие  межслойного 
перехода аппроксимировать пирамидой в виде 
двух, “вписанных” в окружность, 
пересекающихся прямоугольников (рис. 4.10). 
Центр пирамиды должен совпадать с центром 
отверстия. Длину и ширину прямоугольников, 
видимо, желательно брать кратными размерам 
сетки, заданным для структуры. 

 
Просмотр 3-х мерной структуры. 
 

Примечание. Изменить вид отображения 3-х мерной структуры можно, щёлкнув правой 
кнопкой мышки в окне 3-х мерной структуры, и затем используя Zoom Area (Увеличить 
область), Zoom Out (Уменьшить область) и Auto View (Показать всё) во всплывающем меню, 
или щёлкая по соответствующим значкам на панели инструментов. 
Чтобы вращать 3-х мерную структуру, нажмите её левой кнопкой мышки и, не отпуская кнопки, 
перемещайте мышку. 

 
В Microwave Office поддерживается 2-х мерное и 3-х мерное представления электромагнитных 

структур. Чтобы создать 3-х мерное представление: 
1. Выберите View > 3D View 

(Просмотр > 3-х мерный) в 
выпадающем меню или 

нажмите значок 3D View  
на панели инструментов. На 
рабочем поле появится 
трёхмерное изображение, как 
показано на рис. 4. 11. 
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2. Выберите Window > Tile 
Vertical (Окно > Не 
перекрывающееся вертикальное 
расположение) в выпадающем 
меню. Окна с 3-х мерным и 2-х 
мерным изображениями 
отображаются рядом. Затем 
выберите Window > Cascade. 

 
 
Добавление портов и площадок для возбуждения поверхностных токов. 
 

При электромагнитном моделировании можно определять электрические порты на краю платы 
(т.е. внешние порты) или как зонд, проходящий через нижнюю или верхнюю крышки (т.е. внутренние 
порты). 

Чтобы определить внешний порт: 
 

1. Щёлкните левой кнопкой мышки по меньшему проводнику в окне 
электромагнитной структуры. Обратите внимание, что этот проводник 
должен быть позиционирован точно на левом краю подложки (X:0; Y:2.2) 
прежде, чем добавлять внешний порт. Дело в том, что для возбуждения и 
согласования собственных волн в линии источник тока необходимо 
включать в разрыв между проводниками линии и боковыми стенками. 
Поэтому порт моделируется с помощью площадок с вспомогательными 
поверхностными источниками тока. Один край этой площадки должен быть 
замкнут на корпус, а другой – на проводник  

2. Выберите Draw > Add Edge Port (Начертить > Добавить внешний 
порт) в выпадающем меню или щёлкните левой кнопкой мышки по значку 

Add Edge Port  на панели инструментов. 
3. Поместите курсор на левый край меньшего проводника, пока не отобразится квадрат, и 

щёлкните левой кнопкой мышки, чтобы зафиксировать порт. Маленькая площадка с номером 1 
появится на левом краю проводника (рис. 4.12). 



 
Чтобы образовать площадку для поверхностных токов возбуждения, референсную плоскость 

порта необходимо отодвинуть от края подложки. Для образования такой площадки на порте 1: 
 
4. Щёлкните правой кнопкой мышки в окне электромагнитной структуры и выберите 

Zoom Area (Увеличить размер области) во всплывающем меню или нажмите значок Zoom 

Area  на панели инструментов. Курсор будет отображаться в виде лупы. 
5. Поместите курсор чуть выше и левее верхнего левого угла меньшего проводника, 

нажмите левую кнопку мышки и, не отпуская кнопки, переместите курсор к правому нижнему 
углу этого проводника так, чтобы выделить весь проводник с портом и отпустите кнопку 
мышки. 

6. Щёлкните левой кнопкой мышки по порту 1. По углам отобразятся четыре квадрата. 
7. Установите 

курсор мышки на 
правый край порта 
так, чтобы курсор 
отображался в виде 
двойной стрелки. 

8. Нажмите 
левую кнопку мышки 
и удерживайте её, 
пока будут 
отображены значения 
dx, dy. 

9. Не отпуская 
кнопки мышки, 
перетащите курсор 
вправо, пока не будет 
отображено dx:1 (рис. 
4.13). Отпустите 
кнопку мышки, чтобы 
зафиксировать 
площадку. 

 
Определение частот для моделирования. 
 

Чтобы определить частоты: 

4. Снимите галочку (если она стоит) на переключателе Use Project q

тановите GHz в поле Unit, щёлкая стрелки справа от этого поля. 
ите 1 в поле Step 

(Ш
 Apply (Применить). В окне списка Current Range (Текущий диапазон) 

отображается частотный диапазон и частотные точки с шагом, которые вы только что 
определили. 

 
1. Нажмите панель 

Proj в нижней части 
левого окна, чтобы 
открыть окно просмотра 
проекта. 

2. Правой кнопкой 
мышки щёлкните по 
объекту  Interdigital 
Filter в группе EM 
Structures и выберите 
Options во всплывающем 
меню. Откроется 
диалоговое окно Options. 

3. Щёлкните панель 
Frequency Values 
(Значения частот) в 
верхней части окна. 

Fre uency (Рис. 4.14) 
(Использовать частоты проекта), чтобы локальные частоты имели преимущество перед 
глобальными частотами проекта. 

5. Ус
6. Введите 1 в поле Start (Начало), ведите 5 в поле Stop (Конец) и введ
аг). 

7. Щёлкните
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П icrowave Office позволяет определять частоты моделирования глобально (через 
Proj F  просмотра проекта Project Browser) или локально для каждой схемы и 
электромагнитной структуры. Для электромагнитной структуры лучше использовать локальные 

 
Выпол
 

Электромагнитное моделирование  выполняется очень быстро для небольших электрических 
 фильтра, можно выполнить 

лектромагнитное моделирование для одного резонатора стержневого фильтра. Чтобы выполнить 
моделир

ните 
левой кнопкой мышки по 
подгруппе Information 
(Инфо

ctures. 

ия 

йства). 
рис. 4.15) 

 виде 
емая 

ремя 

). В области 
ts 

 сетки (
Elements), оценочное время решения на частоту (Estimated Solve Tim я 
решения (Total Estimated Solve Time),требуемое количество памяти t), 

ю или щёлкните 
ле  чку 

ты 

 
Примеча
памяти не для решения задачи, 
обы добавить оперативной памяти. 

 
Отображение результатов на графике. 
 

обходимо построить график коэффициента отражения 
: 

 на панели инструментов. Откроется диалоговое 
окно Create Graph (Создать график). 

8. Нажмите OK. 

римечание. M
ect requency в окне

частоты с количеством частотных точек меньшим, чем для линейных схем. 

нение электромагнитного моделирования. 

структур. Чтобы найти резонансную частоту первого резонатора
э

ование структуры: 
 

1. Дважды щёлк

рмация) 
стержневого фильтра 
(Interdigital Filter) в 
группе EM Stru
Откроется диалоговое 
окно EM Solver 
Information (Информац
электромагнитного 
решающего устро
В этом окне (
отображается в
гистограмм использу
память на частоту 
(Memory 
Usage/Frequency) и в
моделирования на частоту 
(Simulation Time/ 
Frequency
Resource Requiremen

Number of Mesh 
e/Freq.), полное врем

 (Memory Requiremen
полная физическая память (Total Physical Memory), доступная на компьютере. 
Ознакомившись с этими данными, закройте окно, нажав OK. 

2. Выберите Simulate > 
Analyze (Моделирование > Анализ) 
в выпадающем мен

(Требования к ресурсам) отображается количество элементов

вой кнопкой мышки по зна
Analyze на панели инструментов. 
Индикатор хода работы показывает, 
на какой частоте и на каком шаге 
выполняется анализ (рис. 4.16). 
Когда индикатор хода рабо
исчезает, моделирование 
закончено. 

ние. Если объём оперативной 
 достаточен 

чтпопробуйте изменить конфигурацию компьютера, 

Для определения резонансной частоты не
в электромагнитной структуре. Чтобы сделать это
 

1. Выберите Project > Add Graph (Добавить график) в выпадающем меню или щёлкните 
левой кнопкой мышки по значку Add Graph
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2. Выберите радиокнопку Rectangular (Прямоугольный) в области Graph Type (Тип 
графика) и нажмите OK. График будет отображён на рабочем поле (рис. 4.17). 

 
3. Щёлкните левой кнопкой мышки по окну Graph 1 на рабочем поле, чтобы сделать его 

активным. 
4. Выберите Project > Add Measurement (Добавить измеряемую величину) в выпадающем

левой кнопкой 

 
меню или щёлкните 

мышки по значку Add 

Measurement  на
панели инструмент
Откроется диалогов
окно Add 

surement (ри
4.18). 

5. Выберите Port 
Parameter
списка Meas. Type, 
выбери

 
ов. 
ое 

Mea с. 

s в окне 

те S в окне 
списка

 
 

точника 
), отм

Mag (Модуль) в области Complex Modifier (Представление комплексной е 
Apply (Применить). 

й мышки 
 отображаются на графике, как 

по .19. 
 

Ч
и шаг по 

 Measurement 
(Измеряемая 
величина), выберите
Interdigital Filter в
поле Data Source 
Name (Имя ис
етьте переключатель 
 величины) и нажмит

6. Нажмите OK. 
7. Выберите Simulate > Analyze в выпадающем меню или щёлкните левой кнопко

по значку Analyze на панели инструментов. Результаты анализа

данных), отметьте DB в переключателе Result Type (Тип результата

казано на рисунке 4

тобы определить резонансную частоту более точно, необходимо изменить частотный диапазон 
частоте. Чтобы сделать это: 
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екта. 
лкните правой кнопкой 

мышки l Filter 
 

 в верхней 
ча

op и 0.1 в 
по

, 

оп

или щёлкните левой  

8. Нажмите панель Proj в 
нижней части левого окна, чтобы 
открыть окно просмотра про

9. Щё
 объект Interdigita

в группе EM Structures и
выберите Options. Откроется 
диалоговое окно Options. 

10. Нажмите панель 
Frequency Values
сти этого окна. 
11. Введите 3 в поле Start, 

введите 5 в поле St
ле Step. Нажмите Apply. В 

окне списка Current Range 
будет отображён новый 
частотный диапазон с шагом
которые вы только что 
ределили. 
12. Нажмите OK. 
13. Выберите Simulate > 

Analyze в выпадающем меню 
 кнопкой

мышки по значку Analyze  
на панели инструментов, чтобы 
выполнить новый ана
Результаты анализа 
отображаются на графике, как 

лиз схемы. 

показано на рисунке рис. 4.20. 
 
 

Просмотр анимации токов и Е – поля. 
 

Просмотр токов и полей электромагнитной структуры может быть полезен при изучении её 
физических характеристик. Чтобы просмотреть токи на проводниках: 
 

1. Щёлкните левой кнопкой мышки по окну 3D (Трёхмерное) электромагнитной структуры 
Interdigital Filter, чтобы сделать его активным. 

2. Выберите Animate > Animate Play (Анимация > 
Показать анимацию) в выпадающем меню или щёлкните 
левой кнопкой мышки по значку Animate Play  на панели 
инструментов. Анимация токов в трёхмерном п влении 
будет отображена на рабочем поле. 

редста

3. Выберите Animate > Animate Stop (Анимация > 
Прекратить) или щёлкните левой кнопкой мышки по значку 
Animate Stop  на панели инструментов, чтобы закрыть 
анимацию. 

4. Выберите Animate > E – Field Settings (Анимация > 
Установки Е – поля) в выпадающем меню. Откроется 
диалоговое окно E – Field Computation (Вычисление Е – 

поля), показанное на рис. 4.21. 
5. Отметьте переключатель Layer 2 (Слой 2) и нажмите OK. 
6. Выберите Simulate > Analyze в выпадающем меню или щёлкните левой кнопкой мышки 

по значку Analyze на панели инструментов, чтобы вычислить электрические поля. 
7. Выберите Animate > Animate Play в выпадающем меню или щёлкните левой кнопкой 

мышки по значку Animate Play на панели инструментов, чтобы просмотреть токи и поля. 
 

Примечание. Этот вид зависит от конфигурации вашего компьютера. 
 

8. Выберите Animate > Stop (Анимация > Прекратить) в выпадающем меню или щёлкните 
левой кнопкой мышки по значку Animate Stop на панели инструментов, чтобы закрыть 
анимацию. 

 



Чтобы прекратить вычисление электрического поля: 
 
9. Выберите Animate > E – Field Settings в выпадающем меню, откроется диалоговое окно 

E – Field Computation. 
10. Уберите флажок с переключателя Layer 2 и нажмите OK. 

 
Завершение топологии фильтра. 
 

Чтобы завершить топологию фильтра, 
показанную на рис. 4.22, мы будем использовать 
некоторые усовершенствованные особенности 
редактирования в окне рисунка. 
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Чтобы добавить небольшой проводник на конце 
входного резонатора: 
 

1. Щёлкните по окну Interdigital Filter, 
чтобы сделать его активным. 

2. Выберите Draw > Add Rectangular 
Conductor (Рисовать > Добавить 
прямоугольный проводник) в выпадающем 
меню или щёлкните левой кнопкой мышки по 
значку Add Rect Conductor на панели 

инструментов. 
3. Поместите курсор в окно Interdigital Filter и нажмите клавишу Tab 

на клавиатуре. Откроется диалоговое окно Enter Coordinates (Ввод 
координат). 

4. Введите 2 в поле x, введите 8.2 в поле y и нажмите OK. 
5. Нажмите клавишу Tab снова, чтобы открыть диалоговое окно Enter 

Coordinates. Отметьте переключатель Re, чтобы установить относительные 
координаты. Введите -0.4 в поле dx, dведите -0.2 в поле dy и нажмите OK. 
Прямоугольный проводник будет отображён  в окне электромагнитной 
структуры (рис. 4.23). 

 
Чтобы нарисовать выходной резонатор: 

6. Выберите Edit > Select All 
(Редактировать > Выделить всё) в 
выпадающем меню. Выберите Edit > Copy 
(Редактировать > Копировать) в выпадающем 
меню, затем выберите Edit > Paste 
(Редактировать > Вставить). Появится контур 
входного резонатора. 

7. Переместите курсор так, чтобы 
поместить контур скопированного образца 
поверх входного резонатора и щёлкните левой 
кнопкой мышки. Скопированный образец всё 
ещё является выбранным, как показано на рис. 
4.24. 

8. Выберите Draw > Flip (Рисовать > 
Зеркальное изображение) в выпадающем 

меню. 
9. Поместите курсор в середину окна 

электромагнитной структуры. Нажмите левую 
кнопку мышки и, не отпуская её, двигайте курсор 
вправо, затем отпустите кнопку. Выбранный 
образец отображается зеркально. Оставьте 
зеркально отображаемый образец выбранным (Рис. 
4.25). 

 
Мы должны переместить зеркально отображаемый 

образец так, чтобы край выходного проводника совпал с 
краем подложки. Чтобы сделать это: 
 

10. Поместите курсор на зеркальный образец, пока курсор не будет отображаться в виде 
перекрестия. 



11. Нажмите левую кнопку мышки и, не отпуская её, перетащите курсор вправо, пока край 
выходного проводника не совпадёт с краем подложки, как показано на рис. 4.25. Отпустите 
кнопку мышки. 

 
Чтобы создать средний резонатор: 

 
12. Нажмите левой кнопкой мышки несколько 

выше верхнего левого угла входного резонатора и, 
не отпуская кнопки, тащите курсор к правому 
нижнему углу резонатора так, чтобы выделение 
охватило весь резонатор, и отпустите кнопку 
мышки. Большой проводник с межслойным 
переходом выбран (4.26). 

13. Выберите Edit > Copy в выпадающем меню, 
затем выберите Edit > Paste. Появится контур 
скопированного проводника. 

14. Двигайте курсор к середине окна 
электромагнитной структуры, чтобы переместить 

скопированный образец в середину 
окна, затем дважды щёлкните правой 
кнопкой мышки, чтобы повернуть 
образец на 180 градусов. 

 73

оле 
гия 

. 

15. Нажмите клавишу Tab, Чтобы 
открыть окно Enter Coordinates. 

16. Уберите галочку (если она есть) 
на переключателе Re, чтобы 
установить абсолютные координаты. 
Введите 5.6 в поле x, введите 9.2 в п
y и нажмите OK. Новая тополо
показана на рис. (4.27). 

 
Для завершения электромагнитной 

структуры, необходимо добавить порт к 
выходному проводнику. Чтобы добавить порт и 
площадку для поверхностных токов 
возбуждения: 
 

17. Щёлкните левой кнопкой 
мышки по выходному проводнику в 

окне электромагнитной структуры. 
18. Выберите Draw > Add Edge Port в выпадающем меню или щёлкните левой кнопкой 

мышки по значку Add Edge Port на панели инструментов. 
19. Двигайте курсор к правому краю проводника, пока не будет отображён квадрат, и 

щёлкните левой кнопкой мышки, чтобы зафиксировать порт. Небольшой квадрат  с цифрой 2 
будет отображён на правом краю проводника. 

20. Правой кнопкой мышки щёлкните в окне электромагнитной структуры и выберите 
Zoom Area во всплывающем меню или щёлкните левой кнопкой мышки по значку Zoom Area 
на панели инструментов. Курсор будет отображаться в виде лупы. 

21. Поместите курсор чуть выше и левее верхнего левого угла меньшего выходного 
проводника, нажмите левую кнопку мышки и, не отпуская кнопки, переместите курсор к 
правому нижнему углу этого проводника так, чтобы выделить весь проводник с портом и 
отпустите кнопку мышки. 

22. Щёлкните левой кнопкой мышки по порту 2
В его углах отобразятся четыре квадрата. 

23. Установите курсор на левый край порта так, 
чтобы он отображался в виде двойной стрелки. 

24. Нажмите и удерживайте левую кнопку 
мышки, пока отобразятся значения dx и dy. 

25. Не отпуская кнопки мышки, передвиньте 
курсор налево, пока значение dx будет dx:-1. 
Отпустите кнопку мышки, чтобы зафиксировать 
площадку. Законченная топология показана на рис. 
4.28. 

26. Щёлкните по окну графика (Graph 1) на 
рабочем поле, чтобы сделать его активным. 



27. Выберите Project > Add Measurement в выпадающем меню или щёлкните левой 
кнопкой мышки по значку Add Measurement на панели инструментов. Откроется окно Add 

Measurement (4.29). 
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arameters 

 

ort 

ль 
ype, 
и 

ажмите OK. 
late > Analyze 

в в кните 

аются 

 
На этом заканчивается пример 

моделир туры. 

Этот пр делировании в Microwave Office 
использ  

оздание нового проекта. 

1. Выберите File > New Project (Файл > Новый проект) в выпадающем меню. 
ем меню. 

От
анить. 

 
Создание шаблона транслятора электромагнитной структуры. 

ри импортировании электромагнитной структуры из файла, она должна быть оттранслирована 
из форм

тры 

ии 

римечание. Будьте очень внимательны при создании шаблона транслятора или при 
об 

28. Выберите S в окне 
списка Measurement, 
выберите Port P
в окне списка Meas Type, 
выберите Interdigital 
Filter в поле Data Source 
Name, введите 2 в 
текстовое поле To Port
Index, введите 1 в 
текстовое поле From P
Index, щёлкая стрелки 
справа от этих полей, 
отметьте переключате
DB в области Result T
отметьте Mag в област
Complex Modifier и 

нажмите Apply. 
29. Н
30. Выберите Simu
ыпадающем меню или щёл

левой кнопкой мышки по значку 
Analyze на панели инструментов. 
Результаты анализа отображ
на графике, как показано на рис. 
4.30. 

ования электромагнитной струк
При желании вы можете сохранить 
проделанную вами работу, выбирая File > 
Save Project в выпадающем меню. 
 
 

4.2. Моделирование микрополоскового фильтра с 
электромагнитными связями 
имер показывает, как при электромагнитном мо

овать импортирование топологии электромагнитной структуры из файла в формате DXF,
полученной при синтезе фильтра в другой программе. 
 
С

 

2. Выберите File > Save Project As (Файл > Сохранить проект как) в выпадающ
кроется диалоговое окно Save As. 
3. Наберите F10-3 и нажмите Сохр

 
П
ата файла в формат Microwave Office. Делается это с помощью транслятора электромагнитной 

структуры. Параметры этого транслятора можно использовать по умолчанию или изменить в 
зависимости от особенностей транслируемой структуры. Обычно приходится изменять параме
транслятора, чтобы получить верную оттранслированную структуру. Транслятор с изменёнными 
параметрами можно запомнить в виде шаблона и затем пользоваться этим шаблоном для трансляц
структур близкого вида. Количество шаблонов не ограничивается. 

 
П
редактировании его параметров. Файлы в формате DXF содержат только информацию 
относительных координатах элементов топологии и не содержат никакой информации о 
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аты 

 

тобы создать шаблон транслятора: 
 

1. Выберите File > EM File Translators 
(Файл 

 Откроется 

ните кнопку справа от поля 
Tr l  

нель Make New Template 
(Созда

rties 

физических единицах измерения и о масштабе, в котором нарисована топология. Координ
элементов не обязательно привязаны к начальной координате (0,0), ось Y может в файле быть 
направленной как сверху вниз, так и снизу вверх, что не совпадает с направлением, принятым в
Microwave Office. Есть и другие нюансы (подробнее см. Руководство пользователя Microwave 
Office 2002). 
 
Ч

> Трансляторы файлов 
электромагнитной структуры).
диалоговое окно EM Structure Translator 
(рис. 4.31). 

2. Щёлк
ans ator и в выпадающем списке выберите

DXF Translator. 
3. Нажмите па

ть новый шаблон) в диалоговом окне 
EM Structure Translator. Откроется 
диалоговое окно EM Translator Prope
(Свойства транслятора электромагнитной 
структуры), см. рис. 4.32. 

 

 
4. В этом окне выделите слой Drawing_Layer_2, щёлкнув по нему левой кнопкой мы , 

и м
 

Примечание. В списке слоёв транслятора указывается количество слоёв металла. В нашем 

 
5. В полях ввода ниже списка слоёв введите: 

pe (Форма); 

шки
наж ите панель Delete Layer, чтобы удалить этот слой. 

случае это только один слой проводников на подложке. 

o No в поле Ignore (Игнорировать); 
o Conductor (Проводник) в поле Sha



o 1 в поле Substrate (Подложка); 
o Perfect Conductor (Идеальный проводник) в поле Material. 

6. Щёлкая левой 
кнопкой мышки, установите 
галочку в полях Y origin is 
at top (Начало координаты 
Y сверху), Join open 
polylinea (Соединять 
открытые ломаные линии), 
Auto join tolerance 
(Автоматически допуск 
соединения), Offset shape 
extents (Степени смещения 
формы). Снимите галочку в 
полях Auto enclosure size 
(Автоматически размер 
корпуса) и Auto offset 
distance (Автоматически 
размер смещения). Введите 
0 в поля X offset (смещение 
по X) и Y offset (смещение 
по Y). Установите галочку в 
поле Metric (Метрические) 

и установите mm в поле Units (Единицы измерения), щелкая по кнопке справа от этих полей. 
Остальные поля оставьте по умолчанию. 

7. Нажмите в диалоговом окне Edit Enclosure (Редактировать корпус). Откроется 
диалоговое окно Substrate Information и нажмите на панель Enclosure в верхней части этого 
окна (см. рис. 4.33). 

8. Введите 30 в поле X-Dimension, 300 – в поле X-Divisions, 7 – в поле Y-Dimension, 70 – в 
поле Y-Divisions. 

 
Примечание. Размеры ячеек в сетке должны быть кратны как размеру корпуса (платы), так и 
зазорам между входами фильтра и краем подложки, если такие зазоры есть. В данном случае 
зазоры равны 0.2 мм, а размер сетки по оси X выбран 0.1. 
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ayers 
рические слои) 

 
ion. 

ок

 

, 

 

ть), 1 в поле 

9. Нажмите на 
панель Dielectric L
(Диэлект
в верхней части 
диалогового окна
Substrate Informat

10. В открывшемся 
не (см. рис. 4.34) 

выделите 1-й слой 
Layer 1, щёлкнув по
нему левой кнопкой 
мышки. В поля ввода
расположенные ниже 
списка слоёв, введите 7
в поле Thickness, 1 в 
поле er, 0 в поля Loss 
Tangent и Bulk Cond 
(Объёмная 
проводимос
View Scale (Масштаб 

просмотра). 
11. Выделите 2-й слой Layer 2, щёлкнув по нему левой кнопкой мышки. Введите 0.5 в поле 

Thickness, 10.55 в поле er, 0 в поля Loss Tangent и Bulk Cond, 4 в поле View Scale и нажмите 
OK. 

12. В диалоговом окне EM Translator Properties наберите имя шаблона в поле ввода 
Template name (Имя шаблона), например, MPL05. Окончательный вид этого окна показан на 
рис. 4.35. Нажмите OK. 

 
 



 
 

13. Нажмите OK в диалоговом окне EM Structure Translator (см. рис. 4.36). 
 
 
Примечание. Вновь созданные шаблоны 
трансляторов хранятся в папке 
…\AWR\MWO2002\trntmplt. 
 
 
 
 
 
 
 
 
 
 
 

Импортирование электромагнитной структуры. 
 

1. Щёлкните правой кнопкой мышки
по группе EM Structures в окне 
просмотра проекта и выберите Import 
EM Structure. Откроется диалоговое 
окно Открытие файла (рис. 4.37). 

 

2. Щёлкните кнопку справа от поля 
Тип файлов и в выпадающем списке 
выберите AutoCAD DXF Files (*.dxf). 

3. Щёлкните кнопку справа от поля 
Папка и найдите папку, в которой 
находится файл F10-3.dxf. 

4. В окне со списком файлов 
выделите файл F10-3 и нажмите 
Открыть. Откроется окно транслятора 
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DXF Translator For File: (DXF транслятор для файла:) с полным именем выбранного файла в 
верхней части окна (рис. 4.38). 
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 списке 
тр л

ствуют тем, которые были установлены в 
ш

ectric 
mation все значения соответствуют тем, которые были 

устано
тора. На 

рабочем поле появится окно с топологией электромагнитной структуры (рис. 4.39). 

5. Щёлкните по кнопке справ от поля Template name и в выпадающем
анс яторов выберите MPL05. 
6. Убедитесь, что все поля в этом окне соответ
аблоне, в противном случае отредактируйте их. 
7. Нажмите панель Edit Enclosure и убедитесь, что в подокнах Enclosure и Diel

Layers окна Substrate Infor
влены в шаблоне. 

8. Нажмите OK в окне Substrate Information, затем нажмите OK в окне трансля

 
Примечание. Если данные транслятора редактировались, откроется окно File Translator с 
сообщением, что транслятор был модифицирован и с запросом, сохранить изменения в шаблоне 
ли нет. Нажмите Да, если вы хотите сохранить изменённые параметры  

 
. 

шу Delete, чтобы удалить металлический слой, 
занимающий всю поверхность подложки. 

 

лические 

и

9. Щёлкните левой кнопкой мышки в любом месте подложки, только не на проводнике
Подложка будет выделена. Нажмите клави

Примечание. На рис. 4.39 видно, что заштрихованы не только проводники, но и вся подложка. 
Дело в том, что все элементы, описанные в DXF файле, воспринимаются или как метал
проводники, или как межслойные переходы. В файле F10-3.dxf содержится не только 
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вы 
, удалив из него координаты подложки до импортирования 

файла в проект Microwave Office. 

едактирование топологии. 
 

 случае края проводников отстоят от края подложки на 0.2 мм. Чтобы 
тредактировать топологию: 

 

выделите левую часть левого входного проводника вместе с краем подложки  (рис. 4.40). 

информация о проводниках, но и о размерах подложки, т.е. её координаты. Транслятор эти 
координаты воспринимает как координаты металлического проводника и накладывает слой 
металла на всю поверхность подложки. Этот слой необходимо удалить. В качестве альтернати
можно отредактировать DXF файл

 
Р

Края входного и выходного проводников должны точно совпадать с левым и правым краями 
подложки соответственно. В нашем
о

1. Щёлкните левой кнопкой мышки по значку Zoom Area на панели инструментов и 

 
2. Щёлкните левой кнопкой мышки по проводнику. 
3. Поместите курсор на левый край проводника так, чтобы он отображался в виде 

перекрестия. Нажмите левую кнопку мышки и двигайте курсор влево, пока край проводника не 
со д

 кнопкой мышки по значку Auto View на панели инструментов, чтобы 
от а

а, чтобы он совпадал с 
правым краем подложки. Полученная топология показана на рис. 4.41. 

 

впа ёт с левым краем подложки. 
4. Щёлкните левой
обр зить всю плату. 
5. Аналогично отредактируйте правый конец выходного проводник

Примечание. Щёлкнув левой кнопкой мышки по значку Ruler (Линейка) на панели 
инструментов, можно измерить размеры элементов топологии, чтобы убедиться в отсутствии 
ошибок. 

обавление портов и площадок для возбуждения поверхностных токов. 
 

Чтобы определить внешний порт: 
 

ачку Zoom Area на панели инструментов и 
вы

пока не отобразится квадрат, и 
щ

курсор мышки на правый край порта так, чтобы курсор отображался в виде 
дв о

 Нажмите левую кнопку мышки и удерживайте её, пока будут отображены значения dx, 
dy

о, пока не будет отображено dx:1. 
От

 кнопкой мышки по значку Auto View на панели инструментов, чтобы 
от

 Zoom Area на панели инструментов и 
вы

11. Щёлкните левой кнопкой мышки по значку Add Edge Port  на панели инструментов. 

 
Д

1. Щёлкните левой кнопкой мышки по зн
делите левую часть входного проводника. 
2. Щёлкните левой кнопкой мышки по этому проводнику, чтобы выделить его. 
3. Щёлкните левой кнопкой мышки по значку Add Edge Port  на панели инструментов. 
4. Поместите курсор на левый край входного проводника, 
ёлкните левой кнопкой мышки, чтобы зафиксировать порт. 
5. Щёлкните левой кнопкой мышки по порту 1. По углам отобразятся четыре квадрата. 
6. Установите 
ойн й стрелки. 
7.
. 
8. Не отпуская кнопки мышки, перетащите курсор вправ
пустите кнопку мышки, чтобы зафиксировать площадку. 
9. Щёлкните левой
образить всю плату. 
10. Щёлкните левой кнопкой мышки по значку
делите правую часть выходного проводника. 



12. Поместите курсор на правый край выходного проводника, пока не отобразится квадрат, 
и щёлкните левой кнопкой мышки, чтобы зафиксировать порт. 

13. Щёлкните левой кнопкой мышки по порту 2. По углам отобразятся четыре квадрата. 
14. Установите курсор мышки на левый край порта так, чтобы курсор отображался в виде 

двойной стрелки. 
15. Нажмите левую кнопку мышки и удерживайте её, пока будут отображены значения dx, 

dy. 
16. Не отпуская кнопки мышки, перетащите курсор влево, пока не будет отображено dx:-1. 

Отпустите кнопку мышки, чтобы зафиксировать площадку. 
17. Щёлкните левой кнопкой мышки по значку Auto View на панели инструментов, чтобы 

отобразить всю плату. 
 

Определение частот для моделирования. 
 

1. Нажмите панель Proj в нижней части левого окна, чтобы открыть окно просмотра 
проекта. 

2. Правой кнопкой мышки щёлкните по подгруппе F10-3 в группе EM Structures и 
выберите Options во всплывающем меню. Откроется диалоговое окно Options. 

3. Щёлкните панель Frequency Values (Значения частот) в верхней части окна. 
4. Снимите галочку (если она стоит) на переключателе Use Project Frequency 

(Использовать частоты проекта), чтобы локальные частоты имели преимущество перед 
глобальными частотами проекта. 

5. Установите GHz в поле Unit, щёлкая стрелки справа от этого поля. 
6. Введите 9.9 в поле Start (Начало), ведите 10.6 в поле Stop (Конец) и введите 0.05 в поле 

Step (Шаг). 
7. Щёлкните Apply (Применить). В окне списка Current Range (Текущий диапазон) 

отображается частотный диапазон и частотные точки с шагом, которые вы только что 
определили. 

8. Нажмите OK. 
 
Создание графика и добавление измеряемых величин. 
 

1. Щёлкните по значку Add Graph на панели инструментов. 
2. Введите имя графика, например, Graph 1 в поле Graph name (Имя графика), выберите 

Rectangular (Прямоугольный) в области Graph Type (Тип графика) и нажмите OK. 
3. Нажмите панель Proj в нижней части левого окна. 
4. Щёлкните правой кнопкой мышки по подгруппе Graph 1 в окне просмотра проекта и 

выберите Add Measurement. 
5. Выберите Port Parameter в списке Meas. Type, S в списке Measurement, F10-3 в поле 

Data Source Name, 1 в полях To Port Index (Индекс входного порта), и From Port Index 
(Индекс выходного порта), нажимая на стрелки, справа от этих полей, отметьте DB в области 
Result Type и Mag в области Complex Modifier, нажмите Apply. 

6. Выберите 2 в поле To Port Index и нажмите Apply. 
7. Нажмите OK. 

 
Анализ фильтра без учёта потерь. 
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1. Щёлкните левой 

кнопкой мышки по значку
Analyze на панели 
инструментов. Результаты 
анализа отображаются на 
графике рис. 4. 42. 

 
 
 
 
 
 
 
 
 
 
 
 



Создание и добавление к проекту новых материалов проводников. 
 

Чтобы учесть потери в проводниках, необходимо каждому проводнику топологии назначить 
материал проводника. Материалы проводника можно также присвоить верхней и нижней крышке 
корпуса. Список материалов проводников, определённых в проекте, отображаются в виде подгруппы в 
группе Conductor Materials (Материалы проводника) в окне просмотра проекта. Чтобы просмотреть 
доступные материалы, щёлкните левой кнопкой мышки по значку + слева от этой группы. По умолчанию 
в проекте определён только один материал Perfect Conductor (Идеальный проводник). Все необходимые 
материалы с их свойствами необходимо создать и добавить к проекту. Чтобы сделать это: 
 

1. Щёлкните правой кнопкой мышки по группе Conductor Materials в окне просмотра 
проекта и выберите Add New Material (Добавить новый материал) во всплывающем меню. 
Откроется диалоговое окно Create New Material (Создать новый материал), показанное на рис. 

4.43. 
2. В текстовом поле 

Material name (Имя 
материала) введите PP-17 
(паста ПП-17 для толстых 
плёнок, но вводить нужно 
латинскими буквами, т.к. 
кириллицу Microwave Office 
не уважает). 
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3. Отметьте 
переключатель Physical 
Parameters (Физические 
параметры). 

4. Введите 0.015 в поле 
Conductors thickness 
(Толщина проводников), 
введите 2e7 (удельная 
проводимость пасты 2*107 
см/м) в поле Material 

5. В поле Material colo
conductivity (Удельная проводимость материала). 

r (Цвет материала) отображается цвет, каким будет отображаться 
пр д

uctor 
M

, но в поле Material name введите Copper (Медь), 
от ь

 по 6-ой, но в поле Material name введите Aluminum 
(А м

 
азначение материала проводникам. 

Чтобы назначить материал проводникам: 
 

1. Щёлкните левой кнопкой мышки 
по

ки 
по

этому 

ы). 
 

ните левой кнопкой мышки 
по

-17. 
Нажмите OK. 

ово ник из этого материала в топологии. Вы можете оставить цвет, предлагаемый по 
умолчанию, или выбрать любой другой, нажав на панель Edit рядом с этим полем. 

6. Нажмите OK. Новый материал PP-17 отображается как подгруппа в группе Cond
aterials в окне просмотра проекта. 
7. Повторите пункты с 1-го по 6-ой
мет те переключатель Physical Parameters, введите 0.02 в поле Conductors thickness и 

5.88e7 в поле Material conductivity. 
8. Снова повторите пункты с 1-го
лю иний), отметьте переключатель Physical Parameters, введите 0.1 в поле Conductors 

thickness и 3.53e7 в поле Material conductivity. 

Н
 

 окну топологии, чтобы сделать его 
активным, если оно не активно. 

2. Щёлкните левой кнопкой мыш
 входному проводнику, чтобы 

выделить его. Затем щёлкните по 
проводнику правой кнопкой мышки и 
выберите Edit Shape Props. 
(Редактировать свойства форм
Откроется окно Conductor Material
(рис. 4.44). 

3. Щёлк
 кнопке рядом с полем ввода Selected 

Material (Выбор материала) и в 
выпадающем списке выберите PP
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 топологии фильтра. 
 
азначение материала крышкам корпуса. 

Чтобы назначить материал верхней и нижней крышкам корпуса: 
 

1. Щёлкните левой кнопкой мышки по окну топологии, чтобы сделать его активным, если 

 левой кнопкой 
мышки

Bound верхней 

nclosure Top 
(В  

terial. 

 

области Enclosure Bottom (Низ корпуса) выберите переключатель Specify material. 
Щ н

 
чёт потерь в диэлектрике. 

Чтобы учесть потери в диэлектрике: 
 

1. Щёлкните левой кнопкой мышки по значку Enclosure на панели инструментов. 
От

 в верхней части этого окна. 
и, и в поле Loss Tangent 

вв т
 OK. 

 
нализ фильтра с учётом потерь. 

те 
кой 

мышки
ли 

 
 

 
 
 

4. Повторите пункты 2 и 3 для всех проводников

Н
 

оно не активно. 
2. Щёлкните

 по значку Enclosure на 
панели инструментов. 
Откроется окно Substrate 
Information (Рис. 4.45). 

3. Нажмите панель 
aries (Границы) в 

части этого окна. 
4. В области E
ерх корпуса) выберите 

переключатель Specify ma
Щёлкните по кнопке справа от 
поля ввода Top ground plane 
material (Материал верхнего 
основания) и выберите 
Aluminum в выпадающем

5. В 
списке. 

ёлк ите по кнопке справа от поля ввода Bottom ground plane material (Материал нижнего 
основания) и выберите Copper в выпадающем списке. 

6. Нажмите OK. 

У
 

кроется окно Substrate Information. 
2. Нажмите панель Dielectric Layers
3. Выделите слой Layer 2, щёлкнув по нему левой кнопкой мышк
еди е 0.001. 
4. Нажмите

А
1. Щёлкни

левой кноп
 по значку 

Analyze на пане
инструментов. 
Результаты анализа
отображаются на
графике рис. 4. 46. 
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4.3. Моделирование микрополоскового аттенюатора 
Этот пример показывает, как выполнить электромагнитное моделирование для структуры с 

напылёнными р а, которая 
использовалась ьтаты 
линейно

1. Выберите File > New Project (Файл > Новый проект) в выпадающем меню. 
ave Project As (Файл > Сохранить проект как) в выпадающем меню. 

Откроется диалоговое окно Save As. 

 
Создани ых материалов проводников. 
 

1. Щёлкните правой кнопкой мышки по группе Conductor Materials в окне просмотра 
вающем меню. 

Откроется диалоговое окно Create New Material (Создать новый материал). 

дите 5.88e7  в 
по

иала. 

 введите Aluminum 
(А м tors 
th ле Material conductivity. 

тьте 
ле 

 
Создани

 значку New EM Structure

езисторами. Здесь выполняется моделирование такой же структуры аттенюатор
для линейного моделирования в примере 2.3, чтобы можно было сравнить резул

го и электромагнитного моделирования. Однако размеры элементов топологии несколько 
изменены (округлены) так, чтобы все размеры были кратны размерам ячеек сетки. 
 
Создание нового проекта. 

 

2. Выберите File > S

3. Наберите At20 и нажмите Сохранить. 

е и добавление к проекту нов

проекта и выберите Add New Material (Добавить новый материал) во всплы

2. В текстовом поле Material name (Имя материала) введите Copper. 
3. Отметьте переключатель Physical Parameters (Физические параметры). 
4. Введите 0.02 в поле Conductors thickness (Толщина проводников), вве
ле Material conductivity (Удельная проводимость материала). 
5. В поле Material color (Цвет материала) установите желаемый цвет матер
6. Нажмите OK. 
7. Повторите пункты с 1-го по 6-ой, но в поле Material name
лю иний), отметьте переключатель Physical Parameters, введите 0.1 в поле Conduc
ickness и 3.53e7 в по
8. Повторите пункты с 1-го по 6-ой, но в поле Material name введите Resist, отме

переключатель Physical Parameters, введите 0.3e-3 в поле Conductors thickness и 6.7e4 в по
Material conductivity. 

е электромагнитной структуры. 

  1. Щёлкните левой кнопкой мышки по на панели 

2. Наберите Atr20 в поле Enter EM Structure Name (Ввод имени электромагнитной 
ст т ры. 

 
Определение

1. Щёлкните левой кнопкой мышки по значку Enclosure

инструментов. 

рук уры) и нажмите OK. На рабочем поле откроется окно электромагнитной структу

 корпуса. 

  на панели инструментов. 
ое окно Substrate Information (Информация о подложке). Нажмите панель 

Enclosure в верхней части окна. 
Met я 

Размер корпуса) наберите 13.4 в поле X – Dimension (размер 
по , 

ll Size (Размер ячейки) показывается 
размер

кнопкой мышки по Layer 1 (Слой 1) в зоне Dielectric Layers 
Pa же поля 

Откроется диалогов

2. В области Units (Единицы) установите переключатель ric (Метрические) и, щёлка
по стрелкам справа, установите единицы измерения mm. 

3. В области Box Dimension (
 X) наберите 134 в поле X – Divisions (количество делений по оси X), наберите 6.9 в поле Y 

– Dimension, наберите 138 в поле Y – Divisions. В поле Ce
 сетки по X и Y. 

4. Нажмите на панель Dielectric Layers (Диэлектрические слои) в верхней части 
диалогового окна Substrate Information. 

5. Щёлкните левой 
rameters (Параметры диэлектрических слоёв). Введите 7 в окне редактирования ни

Thickness (Толщина). Введите 1 в окне редактирования ниже поля Er ( rε ). Оставьте 
по умолчанию для оставшихся полей. 

6. Щёлкните левой кнопкой мышки по Layer 2 (Слой 2) в зоне Dielectric Layers 
Parameters. Введите 0.5 в окне редактирования ниже поля Thickness. Введите 10.55 в окне 
редактирования ниже поля Er. Введите

значения 

 0.001 в поле ввода Loss Tangent (Тангенс угла потерь). 
Введите 4 в поле ввода View Scale (Масштаб просмотра). 

7. Нажмите Boundaries (Границы) в верхней части диалогового окна Substrate 
Information. 
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terial. 
кнопке справа от поля ввода Top ground plane material (Материал верхнего 

ос а
l. 

plane material (Материал нижнего 
ос а

 
Создание

левой кнопкой мышки по значку Add Rect Conductor

8. В области Enclosure Top (Верх корпуса) выберите переключатель Specify ma
Щёлкните по 
нов ния) и выберите Aluminum в выпадающем списке. 
9. В области Enclosure Bottom (Низ корпуса) выберите переключатель Specify materia

Щёлкните по кнопке справа от поля ввода Bottom ground 
нов ния) и выберите Copper в выпадающем списке. 
10. Нажмите OK. 

 топологии. 
  1. Щёлкните на панели 

 кл  
роется диалоговое окно Enter Coordinates (Ввод координат). 

ordinates. 
У  относительные координаты. 
Вв

dx и 0.4 

 dy. 

. 
  

 dy. 
 

 
Добавле ов и площадок для возбуждения поверхностных токов. 

нтов и 
выделите левую часть входного проводника. 

ачку Add Edge Port  на панели инструментов. 
вадрат, и 

щ

обы курсор отображался в виде 
дв о

устите кнопку мышки, чтобы зафиксировать площадку. 

 
 выходного проводника. 

в. 
ого проводника, пока не отобразится квадрат, 

и 

ы курсор отображался в виде 
дв

устите кнопку мышки, чтобы зафиксировать площадку. 

инструментов. 
2. Поместите курсор в окно электромагнитной структуры и нажмите авишу Tab на

клавиатуре. Отк
3. Введите 0 в поле x, введите 3.2 в поле y и нажмите OK. 
4. Нажмите клавишу Tab снова, чтобы открыть диалоговое окно Enter Co
становите флажок в переключателе Re, чтобы активизировать
едите 3 в поле dx, 0.5 в поле dy и нажмите OK. Проводник прямоугольного сечения 

отображается в окне электромагнитной структуры. 
5. Повторите пункты с 1-го по 4-ый, но введите 3 в поле x, 3.25 в поле y, 0.5 в поле 

в поле dy. 
6. Повторите пункты с 1-го по 4-ый, но введите 3.5 в поле x, 2.95 в поле y, 2 в поле dx и 1 в 

поле dy. 
7. Повторите пункты с 1-го по 4-ый, но введите 5.5 в поле x, 3.25 в поле y, 0.2 в поле dx и 

0.4 в поле
8. Повторите пункты с 1-го по 4-ый, но введите 5.7 в поле x, 2.5 в поле y, 2 в поле dx и 1.9 

в поле dy. 
9. Повторите пункты с 1-го по 4-ый, но введите 7.7 в поле x, 3.25 в поле y, 0.2 в поле dx и 

0.4 в поле dy
10. Повторите пункты с 1-го по 4-ый, но введите 7.9 в поле x, 2.95 в поле y, 2 в поле dx и 1 в

поле dy. 
11. Повторите пункты с 1-го по 4-ый, но введите 9.9 в поле x, 3.25 в поле y, 0.5 в поле dx и 

0.4 в поле
12. Повторите пункты с 1-го по 4-ый, но введите 10.4 в поле x, 3.2 в поле y, 3 в поле dx и 0.5

в поле dy. 

ние порт
 

1. Щёлкните левой кнопкой мышки по значку Zoom Area на панели инструме

2. Щёлкните левой кнопкой мышки по этому проводнику, чтобы выделить его. 
3. Щёлкните левой кнопкой мышки по зн
4. Поместите курсор на левый край входного проводника, пока не отобразится к
ёлкните левой кнопкой мышки, чтобы зафиксировать порт. 
5. Щёлкните левой кнопкой мышки по порту 1. По углам отобразятся четыре квадрата. 
6. Установите курсор мышки на правый край порта так, чт
ойн й стрелки. 
7. Нажмите левую кнопку мышки и удерживайте её, пока будут отображены значения dx, 

dy. 
8. Не отпуская кнопки мышки, перетащите курсор вправо, пока не будет отображено dx:1. 

Отп
9. Щёлкните левой кнопкой мышки по значку Auto View на панели инструментов, чтобы 

отобразить всю плату. 
10. Щёлкните левой кнопкой мышки по значку Zoom Area на панели инструментов и 

выделите правую часть
11. Щёлкните левой кнопкой мышки по значку Add Edge Port  на панели инструменто
12. Поместите курсор на правый край выходн
щёлкните левой кнопкой мышки, чтобы зафиксировать порт. 
13. Щёлкните левой кнопкой мышки по порту 2. По углам отобразятся четыре квадрата. 
14. Установите курсор мышки на левый край порта так, чтоб
ойной стрелки. 
15. Нажмите левую кнопку мышки и удерживайте её, пока будут отображены значения dx, 

dy. 
16. Не отпуская кнопки мышки, перетащите курсор влево, пока не будет отображено dx:-1. 

Отп
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Назнач водникам. 

и по окну топологии, чтобы сделать его активным, если 
оно не активно. 

му проводнику правой кнопкой мышки и выберите Edit Shape Props. 
(Р к

ial 

 Selected 
M

 
О ы аттенюатора показан на рис. 4.47. 

17. Щёлкните левой кнопкой мышки по значку Auto View на панели инструментов, чтобы 
отобразить всю плату. 

ение материала про
 

1. Щёлкните левой кнопкой мышк

2. Щёлкните левой кнопкой мышки по входному проводнику, чтобы выделить его. Затем 
щёлкните по это
еда тировать свойства формы). Откроется окно Conductor Material (рис. 4.44). 
3. Щёлкните левой кнопкой мышки по кнопке рядом с полем ввода Selected Mater

(Выбор материала) и в выпадающем списке выберите Copper. Нажмите OK. 
4. Повторите пункты 2 и 3 для всех проводников топологии аттенюатора. 
5. Затем аналогично назначьте материал всем резисторам, но в поле ввода
aterial выберите Resist. 

кончательный вид структур

 
 
Создание выходных параметров и уравнений. 

о группе Output Equations (Выходные 
уравнения) в окне просмотра проекта. На рабочем поле откроется окно уравнений Output 
Eq t

 
easurement Equation (Добавить новую измеряемую величину уравнения). В 

те о е 
, 

, 

 

Щёлкни ышки в любом месте окна уравнений за пределами 
выражения для S11. 

3. окне в 
тексто me введите S21, в списке Meas. Type отметьте Port Parameters, в 
списке

ы, 

 
20: |S[2,1]| 

Щёлкни ышки в любом месте окна уравнений за пределами 
выражения для S21. 

4. ышки по 
значку инструментов. 

 
1. Дважды щёлкните левой кнопкой мышки п

ua ions. 
2. Выберите Add > Output Equation в выпадающем меню. Откроется диалоговое окно

Add New M
кст вом поле Variable name (Имя переменной) введите S11, в списке Meas. Type отметьт

Port Parameters, в списке Measurement отметьте S, в поле Data Source Name введите atr20
щёлкая по кнопке справа от этого поля, введите 1 в оба поля To Port Index и From Port Index
щёлкая по кнопкам справа от этих полей, установите переключатель Mag в области Complex 
Modifier, снимите галочку в переключателях Complex и DB области Result Type, если они 
установлены, щёлкните OK. В окне уравнений появится поле ввода с курсором в виде 
крестика. Двигая мышку, установите это поле в верхней части окна уравнений и щёлкните 
левой кнопкой мышки. Появится выражение 

S11=atr20: |S[1,1]| 
 

те левой кнопкой м

Снова выберите Add > Output Equation в выпадающем меню. В открывшемся 
вом поле Variable na
 Measurement отметьте S, в поле Data Source Name введите atr20, щёлкая по кнопке 

справа от этого поля, введите 2 в поля To Port Index и 1 в поле From Port Index, щёлкая по 
кнопкам справа от этих полей, установите переключатель Mag в области Complex Modifier, 
снимите галочку в переключателях Complex и DB области Result Type, если они установлен
щёлкните OK. В окне уравнений появится поле ввода с курсором в виде крестика. Двигая 
мышку, установите это поле ниже предыдущего уравнения и щёлкните левой кнопкой мышки. 
Появится выражение 

S21=atr
 

те левой кнопкой м

Выберите Add > Equation в выпадающем меню или щёлкните левой кнопкой м
 Equation на панели 



5. Переместите курсор в окно уравнений. В этом окне появится поле ввода. Установите 
его, двигая мышкой, ниже предыдущего уравнения и щёлкните левой кнопкой мышки, чтобы 
зафиксировать. 

6. Введите в поле вода уравнение: 
 

KstU=(1+S11)/(1-S11) 
 

и щёлкните левой кнопкой мышки вне этого поля или нажмите клавишу Enter. 
7. Снова щёлкните левой кнопкой мышки по значку Equation на панели инструментов и 

поместите новое поле ниже предыдущих уравнений. 
8. Введите в поле вода уравнение: 

 
Ldb=20*log10(1/S21) 

 
и щёлкните левой кнопкой мышки вне этого поля или нажмите клавишу Enter. 

 
Определение частот для моделирования. 
 

1. Нажмите панель Proj в нижней части левого окна, чтобы открыть окно просмотра 
проекта. 

2. Правой кнопкой мышки щёлкните по подгруппе atr20 в группе EM Structures и 
выберите Options во всплывающем меню. Откроется диалоговое окно Options. 

3. Щёлкните панель Frequency Values (Значения частот) в верхней части окна. 
4. Снимите галочку (если она стоит) на переключателе Use Project Frequency 

(Использовать частоты проекта), чтобы локальные частоты имели преимущество перед 
глобальными частотами проекта. 

5. Установите GHz в поле Unit, щёлкая стрелки справа от этого поля. 
6. Введите 4 в поле Start (Начало), ведите 18 в поле Stop (Конец) и введите 1 в поле Step 

(Шаг). 
7. Щёлкните Apply (Применить). В окне списка Current Range (Текущий диапазон) 

отображается частотный диапазон и частотные точки с шагом, которые вы только что 
определили. 

8. Нажмите OK. 
 
Создание графика и добавление измеряемых величин. 
 

1. Щёлкните по значку Add Graph на панели инструментов. 
2. Введите имя графика, например, Graph 1 в поле Graph name (Имя графика), выберите 

Rectangular (Прямоугольный) в области Graph Type (Тип графика) и нажмите OK. 
3. Нажмите панель Proj в нижней части левого окна. 
4. Щёлкните правой кнопкой мышки по подгруппе Graph 1 в окне просмотра проекта и 

выберите Add Measurement. 
5. Выберите Output Equations в списке Meas. Type. В окне списка Equation Name 

выберите KstU, щёлкнув по кнопке справа. Отметьте переключатель Mag в области Complex 
Modifier. Уберите галочку в окне DB, если она установлена. Нажмите Apply. 

6. В окне списка Equation Name выберите Ldb и нажмите Apply. 
7. Нажмите OK. 

 
 

 86

 
Анализ схемы. 

1. Щёлкните левой кнопкой 
мышки по значку Analyze на 
панели инструментов. Результаты 
анализа отображаются на графике 
рис. 4.48. 
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Вывод результатов в файл. 
 

1. Нажмите на панель Proj в нижней части левого окна. 
2. Щёлкните правой кнопкой мышки по группе Output Files (Выходные файлы). 
3. Выберите Add Port Parameter (Добавить параметр порта), откроется окно Output Data 

File (Выходной файл данных). 
4. Выберите S Parameter в области Data Type (Тип данных). Выберите dB Mag/Ang в 

области Format. 
5. Нажмите на панель Set file name…(Установить имя файла…). 
6. В открывшемся окне укажите папку, где сохранить файл, и наберите имя файла или 

согласитесь с предлагаемым по умолчанию. 
7. Нажмите Сохранить. 
8. Нажмите OK в окне Output Data File. 

 

4.4. Моделирование микрополоскового двухсекционного 
делителя мощности. 

 
Создайте новый проект и сохраните его, присвоив имя Divider, как описано в примере 4.3. 
Создайте и добавьте к проекту новые материалы проводников Copper, Aluminum и Resist, как 

описано в примере 4.3, но для Resist введите толщину 0.25e-3 в поле Conductor thickness. При этом в 
области Electrical parameters в поле ввода Low frequency будет отражено поверхностное сопротивление 
59.7 ом на квадрат. 

Создайте электромагнитную структуру, как описано в примере 4.3, присвоив ей имя Div. 
Определите корпус, как описано в примере 4.3. В области Box Dimension (Размеры корпуса) 

введите 10 в поле X-Dimension, 100 в поле X-Division, 5.1 в поле Y-Dimension, 102 в поле Y-Division. 
Все остальные параметры оставьте как в примере 4.3. 
 
Создание топологии входного проводника. 
 

1. Щёлкните левой кнопкой мышки по значку Zoom Area и выделите среднюю часть 
платы возле левого края так, чтобы хорошо была видна сетка. Это облегчит рисование. 

2. Выберите Draw > Add Conductor (Рисовать >Добавить проводник) в выпадающем 
меню или щёлкните левой кнопкой мышки по значку Add Conductor на панели инструментов. 

3. Переместите курсор в окно электромагнитной структуры, поместите его в близи левого 
края подложки примерно в центре по высоте платы и щёлкните левой кнопкой мышки, чтобы 
зафиксировать начало рисунка топологии. Возле курсора будет отображаться x:0, y:0. 

4. Не нажимая кнопки мышки, двигайте курсор вправо так, чтобы было отражено dx:2, 
dy:0. Щёлкните левой кнопкой мышки, чтобы зафиксировать эту точку. После этого снова 
возле курсора будет отображаться x:0, y:0. 

5. Не нажимая кнопки мышки, двигайте курсор вправо и вверх так, чтобы было отражено 
dx:0.3, dy:-0.15. Щёлкните левой кнопкой мышки. 

6. Продолжайте аналогично: 
o двигайте курсор вправо, пока будет dx:0.1 dy:0; 
o двигайте курсор вниз, пока будет dx:0 dy:0.15; 
o двигайте курсор влево, пока будет dx:-0.1 dy:0; 
o двигайте курсор влево и вниз, пока будет dx:-0.4 dy:0.25; 
o двигайте курсор вправо и вниз, пока будет dx:0.4 dy:0,25; 
o двигайте курсор вправо, пока будет dx:0.1 dy:0; 
o двигайте курсор вниз, пока будет dx:0 dy:0.15; 
o двигайте курсор влево, пока будет dx:-0.1 dy:0; 
o двигайте курсор влево и вверх, пока будет dx:-0,3 dy:0,15; 
o двигайте курсор влево, пока будет dx:-2 dy:0; 
o двигайте курсор вверх, пока будет dx:0 dy:-0,5, чтобы замкнуть контур. 

Примечание. Вместо последнего пункта можно после выполнения предпоследнего 
дважды щёлкнуть левой кнопкой мышки. Контур замкнётся автоматически. 

7. Щёлкните левой кнопкой мышки по входному проводнику, чтобы его выделить, если он 
не выделен. 

8. Поместите курсор на входной проводник, курсор должен отображаться в виде 
перекрестия. 

9. Нажмите левую кнопку мышки и, не отпуская кнопки, двигайте проводник влево так, 
чтобы левый край проводника совпал с левым краем подложки. Отпустите кнопку мышки. 



10. Поместите курсор в любое место окна электромагнитной структуры. В нижней части 
основного окна проекта с правой стороны отображаются координаты курсора, например, x:1.5     

y:3    mm. Поместите курсор на 
верхний левый угол входного 
проводника. Чтобы проводник 
располагался по центру платы, 
координаты этого угла должны быть 
x:0  y:2.3. Если эти координаты 
другие, например, x:0  y:2.5, то 
проводник надо сдвинуть в данном 
случае на 0.2 мм вверх. Для этого 
выделите проводник, нажмите левую 
кнопку мышки и двигайте проводник 

вверх, пока будет отображено x:0   y:-0.2. 
 

Полученная топология входного проводника показана на рис. 4.49. 
 

Примечание. Если щёлкнуть левой кнопкой по проводнику, чтобы выделить его, и затем 
дважды щёлкнуть левой кнопкой по этому проводнику, в срединах ограничивающих 
проводник линиях и в углах появятся тёмно-синие точки. Поместив курсор на такую точку так, 
чтобы он отображался в виде двойной стрелки, можно, нажав левую кнопку мышки, двигать 
линию или угол топологии и, таким образом, редактировать топологию. 

 
Создание топологии проводников плеч делителя. 
 

1. Щёлкните левой кнопкой мышки по значку Add Rect Conductor (Добавить 
прямоугольный проводник) на панели инструментов. 

2. Поместите курсор в окно электромагнитной структуры и нажмите клавишу Tab на 
клавиатуре. Откроется диалоговое окно Enter Coordinates (Ввод координат). 

3. Введите 2.3 в поле x, введите 2.15 в поле y и нажмите OK. 
4. Нажмите клавишу Tab снова, чтобы открыть диалоговое окно Enter Coordinates. 

Установите флажок в переключателе Re, чтобы активизировать относительные координаты. 
Введите 2.4 в поле dx, 0.15 в поле dy и нажмите OK. 

5. Повторите пункты с 1-го по 4-ый, но введите 2.3 в поле x, введите 2.8 в поле y, 2.4 в 
поле dx, 0.15 в поле dy. 

6. Повторите пункты с 1-го по 4-ый, но введите 4.6 в поле x, введите 2 в поле y, 2.9 в поле 
dx, 0.3 в поле dy. 

7. Повторите пункты с 1-го по 4-ый, но введите 4.6 в поле x, введите 2.8 в поле y, 2.9 в 
поле dx, 0.3 в поле dy. 

 
Создание топологии выходных проводников. 
 

1. Щёлкните левой кнопкой мышки по значку Auto View на панели инструментов, чтобы 
отобразить всю плату. 

2. Щёлкните левой кнопкой мышки по значку Zoom Area на панели инструментов и 
выделите правую часть обоих последних проводников делителя так, чтобы была видна сетка. 

3. Щёлкните левой кнопкой мышки по значку Add Conductor на панели инструментов. 
4. Переместите курсор в окно электромагнитной структуры, поместите его на верхнюю 

границу верхнего последнего проводника левее правого края на одну ячейку сетки (0.1 мм), 
щёлкните левой кнопкой мышки, переместите курсор вправо, пока будет отображено dx:0.1 
dy:0 (т.е. до правого верхнего угла верхнего проводника) и щёлкните левой кнопкой мышки. 

5. Не нажимая кнопки мышки, двигайте курсор вверх, пока будет отображено dx:0 dy:-0.1 
и щёлкните левой кнопкой мышки. 

6. Продолжайте аналогично: 
o Двигайте курсор вправо, пока будет dx:0.5 dy:0; 
o Двигайте курсор вниз, пока будет dx:0 dy:0.1; 
o Двигайте курсор вниз и влево, пока будет dx:-0.5 dy:0.3; 
o Двигайте курсор влево, пока будет dx:-0.1 dy:0; 
o Двигайте курсор вверх, пока будет dx:0 dy:-0.3; 

7. Щёлкните левой кнопкой мышки по значку Add Conductor на панели инструментов. 
8. Переместите курсор в окно электромагнитной структуры, поместите его на нижнюю 

границу нижнего последнего проводника левее правого края на одну ячейку сетки, щёлкните 
левой кнопкой мышки, переместите курсор вправо, пока будет отображено dx:0.1 dy:0 и 
щёлкните левой кнопкой мышки. 
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9. Не нажимая кнопки мышки, двигайте курсор вниз, пока будет отображено dx:0 dy:0.1 и 
щёлкните левой кнопкой мышки. 

10. Продолжайте аналогично: 
o Двигайте курсор вправо, пока будет dx:0.5 dy:0; 
o Двигайте курсор вверх, пока будет dx:0 dy:-0.1; 
o Двигайте курсор вверх и влево, пока будет dx:-0.5 dy:-0.3; 
o Двигайте курсор влево, пока будет dx:-0.1 dy:0; 
o Двигайте курсор вниз, пока будет dx:0 dy:0.3; 

11. Щёлкните левой кнопкой мышки по значку Add Rect Conductor на панели 
инструментов. Переместите курсор в окно стержневого фильтра и нажмите клавишу Tab. 
Откроется диалоговое окно Enter Coordinates. Введите 7.5 в поле x, введите 0 в поле y и 
нажмите OK. Нажмите клавишу Tab снова, установите флажок в переключателе Re, введите 
0.5 в поле dx, 2 в поле dy и нажмите OK. 

12. Повторите п. 11, но введите 7.5 в поле x, введите 3,1 в поле y, 0.5 в поле dx, 2 в поле dy. 
 
Создание топологии резисторов. 
 

1. Щёлкните левой кнопкой мышки по значку Add Rect Conductor на панели 
инструментов. 

2. Поместите курсор в окно электромагнитной структуры и нажмите клавишу Tab на 
клавиатуре. Откроется диалоговое окно Enter Coordinates. 

3. Введите 4.5 в поле x, введите 2.1 в поле y и нажмите OK. 
4. Нажмите клавишу Tab снова. Установите флажок в переключателе Re, введите 0.3 в 

поле dx, 0.3 в поле dy и нажмите OK. 
5. Повторите пункты с 1-го по 4-ый, но введите 7.4 в поле x, введите 2.15 в поле y, 0.1 в 

поле dx, 0.8 в поле dy. 
6. Щёлкните по значку Auto View на панели инструментов. 

 
Добавление портов и площадок для 
возбуждения поверхностных токов. 
 

Добавьте порты площадки к входному 
проводнику, и затем к верхнему и нижнему выходным 
проводникам, как описано в примере 4.3. 
 
Назначение материала проводникам. 
 

Назначьте всем проводникам материал Copper, а 
обоим резисторам материал Resist, как описано в примере 
4.3. 

Полученная топология показана на рис. 4.50. 
 
Определение частот для моделирования. 
 

Определите частоты для моделирования, как описано в примере 4.3, но введите 4 в поле Start, 18 
в поле Stop и 1 в поле Step. 
 
Создание графика и добавление измеряемых величин. 

 
Создайте график Graph 1 и добавьте 

измеряемые величины, как описано в примере 4.3. В 
окне Add Measurement выберите Port Parameter в 
списке Meas. Type, S в списке Measurement, Del в 
поле Data Source Name, 2 в поле To Port Index, 1 в 
поле From Port Index, отметьте DB и Mag, нажмите 
Apply. Затем выберите 3 в поле To Port Index и 
нажмите Apply. Нажмите OK. 
 
Анализ делителя. 
 

1. Щёлкните левой кнопкой мышки по 
значку Analyze на панели инструментов. 
Результаты анализа отображаются на 
графике рис. 4. 51. 
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Создание второго графика и добавление измеряемых величин. 
 

Создайте график Graph 2 и добавьте измеряемые величины, как описано в примере 4.3. В окне 
Add Measurement выберите Port Parameter в списке Meas. Type, S в списке Measurement, Del в поле 
Data Source Name, 3 в поле To Port Index, 2 в поле From Port Index, отметьте DB и Mag, нажмите 
Apply. Нажмите OK. 
 
Анализ делителя. 
 

 
1. Щёлкните левой кнопкой 

мышки по значку Analyze на панели 
инструментов. Результаты анализа 
отображаются на графике рис. 4. 52. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Создание выходных параметров и уравнений. 
 

1. Дважды щёлкните левой кнопкой мышки по группе Output Equations в окне просмотра 
проекта. Откроется окно Output Equations. 

2. Щёлкните левой кнопкой мышки по значку Output Equation на панели инструментов. 
Откроется диалоговое окно Add New Measurement Equation (Добавить новую измеряемую 
величину уравнения). В текстовом поле Variable name (Имя переменной) введите S11, в 
списке Meas. Type отметьте Port Parameters, в списке Measurement отметьте S, в поле Data 
Source Name введите div, щёлкая по кнопке справа от этого поля, введите 1 в оба поля To Port 
Index и From Port Index, щёлкая по кнопкам справа от этих полей, установите переключатель 
Mag в области Complex Modifier, снимите галочку в переключателях Complex и DB области 
Result Type, если они установлены, щёлкните OK. В окне уравнений появится поле ввода с 
курсором в виде крестика. Двигая мышку, установите это поле в верхней части окна уравнений 
и щёлкните левой кнопкой мышки. Появится выражение S11=div: |S[1,1]|  

3. Щёлкните левой кнопкой мышки в любом месте окна уравнений за пределами 
выражения для S11. 

4. Аналогично создайте переменные S22=div: |S[2,2]| и S33=div: |S[3,3]|. 
5. Выберите Add > Equation в выпадающем меню или щёлкните левой кнопкой мышки по 

значку Equation на панели инструментов. 
6. Переместите курсор в окно уравнений. В этом окне появится поле ввода. Установите 

его, двигая мышкой, ниже предыдущего уравнения и щёлкните левой кнопкой мышки, чтобы 
зафиксировать. 

7. Введите в поле вода уравнение: KstU1=(1+S11)/(1-S11) и щёлкните левой кнопкой 
мышки вне этого поля или нажмите клавишу Enter. 

8. Аналогично добавьте уравнения KstU2=(1+S22)/(1-S22) и KstU3=(1+S33)/(1-S33). 
 
Создание третьего графика и добавление измеряемых величин. 
 

1. Щёлкните по значку Add Graph на панели инструментов. 
2. Введите имя графика, например, Graph 3 в поле Graph name, выберите Rectangular  в 

области Graph Type и нажмите OK. 
3. Щёлкните левой кнопкой мышки по значку Add Measurement на панели инструментов. 
4. Выберите Output Equations в списке Meas. Type. В окне списка Equation Name 

выберите KstU1, щёлкнув по кнопке справа. Отметьте переключатель Mag в области Complex 
Modifier. Уберите галочку в окне DB, если она установлена. Нажмите Apply. 

5. В окне списка Equation Name выберите KstU2. Нажмите Apply. 
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6. В окне списка Equation Name выберите KstU3. Нажмите Apply. 
7. Нажмите OK. 

 
Анализ делителя. 
 

1. Щёлкните левой кнопкой 
мышки по значку Analyze на панели 
инструментов. Результаты анализа 
отображаются на графике рис. 4. 53. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Вывод топологии в DXF файл. 
 

1. Щёлкните правой кнопкой мышки по подгруппе делителя мощности Div в группе EM 
Structures в окне просмотра проекта. Выберите Export EM Structure во всплывающем меню. 
Откроется окно Сохранение. 

2. Щёлкните левой кнопкой мышки по кнопке справа от поля ввода Тип файла и в 
выпадающем списке выберите AutoCAD DXF Files (*.dxf). 

3. В поле ввода Имя файла введите имя файла, например, Divider, или согласитесь с 
предлагаемым именем по умолчанию. 

4. В поле ввода Папка введите путь и имя папки, где вы хотите сохранить файл, или 
щёлкните по кнопке справа от этого поля ввода и выберите папку из выпадающего проводника, 
или согласитесь с папкой, предлагаемой по умолчанию. 

5. Нажмите кнопку Сохранить. Откроется окно транслятора. 
6. Щёлкните по кнопке справа от поля ввода Template name и в выпадающем списке 

трансляторов выберите подходящий транслятор, если он есть, или отредактируйте имеющийся 
так, как описано в примере 4.2. Отредактированный транслятор лучше сохранить в виде 
шаблона под другим именем. 

7. Нажмите OK. 
 

Примечание. Если при активном окне топологии щёлкнуть левой кнопкой мышки по значку 
Show Current (Показать ток) на панели инструментов, можно просмотреть распределение токов 
на проводниках. Чтобы закрыть этот просмотр, снова щёлкните по значку Show Current. 
Если щёлкнуть левой кнопкой мышки по значку Animate Play (Показать анимацию) на панели 
инструментов, можно просмотреть анимацию токов. Чтобы закрыть анимацию, щёлкните по 
значку Animate Stop (Остановить анимацию). 

 

4.4. Моделирование микрополоскового двухсекционного 
симметрированного направленного ответвителя. 

 
Создайте новый проект и сохраните его, присвоив имя NO11, как описано в примере 4.3. 
Создайте и добавьте к проекту новые материалы проводников Copper, Aluminum и Resist, как 

описано в примере 4.3. 
Создайте электромагнитную структуру, как описано в примере 4.3, присвоив ей имя no. 

 
Определение корпуса. 

1. Щёлкните левой кнопкой мышки по значку Enclosure  на панели инструментов. 
Откроется диалоговое окно Substrate Information. Нажмите панель Enclosure в верхней части 
окна. 

2. В области Units установите переключатель Metric и, щёлкая по стрелкам справа, 
установите единицы измерения mm. 
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3. В области Box Dimension наберите 7.65 в поле X – Dimension, наберите 153 в поле X – 
Divisions, наберите 4.6 в поле Y – Dimension, наберите 92 в поле Y – Divisions. В поле Cell Size 
показывается размер сетки по X и Y. 

4. Нажмите на панель Dielectric Layers в верхней части диалогового окна Substrate 
Information. 

5. Нажмите на панель Add Above в нижней части окна, чтобы добавить ещё один слой. 
6. Щёлкните левой кнопкой мышки по Layer 1 в зоне Dielectric Layers Parameters. 

Введите 6 в окне редактирования ниже поля Thickness. Введите 1 в окне редактирования ниже 
поля Er. Оставьте значения по умолчанию для оставшихся полей. 

7. Щёлкните левой кнопкой мышки по Layer 2 в зоне Dielectric Layers Parameters. 
Введите 0.5 в окне редактирования ниже поля Thickness. Введите 10.5 в окне редактирования 
ниже поля Er. Введите 0.001 в поле ввода Loss Tangent. Введите 4 в поле ввода View Scale. 

8. Щёлкните левой кнопкой мышки по Layer 3 и введите те же данные, что и для Layer 2. 
9. Нажмите Boundaries в верхней части диалогового окна Substrate Information. 
10. В области Enclosure Top выберите переключатель Specify material. Щёлкните по 

кнопке справа от поля ввода Top ground plane material и выберите Aluminum в выпадающем 
списке. 

11. Сделайте тоже самое в области Enclosure Bottom. 
12. Нажмите OK. 

 
Создание топологии. 

 
1. Нажмите левой кнопкой мышки по панели 

Layer 3 в окне электромагнитной структуры. 
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2. Щёлкните левой кнопкой мышки по значку 
Add Rect Conductor (Добавить прямоугольный 
проводник) на панели инструментов. 

3. Поместите курсор в окно электромагнитной 
структуры и нажмите клавишу Tab на клавиатуре. 
Откроется диалоговое окно Enter Coordinates 
(Ввод координат). 

4. Введите 0 в поле x, введите 2.55 в поле y и 
нажмите OK. 

5. Нажмите клавишу Tab снова, чтобы 
открыть диалоговое окно Enter Coordinates. 

Установите флажок в переключателе Re, чтобы активизировать относительные координаты. 
Введите 1.1 в поле dx, 0.45 в поле dy и нажмите OK. 

6. Повторите пункты с 1-го по 4-ый, но введите 1.1 в поле x, введите 1.5 в поле y, 2.15 в 
поле dx, 0.3 в поле dy. Щёлкните левой кнопкой мышки по этому проводнику, чтобы выделить 
его. 

7. Щёлкните левой кнопкой мышки по значку Copy и затем по значку Paste на панели 
инструментов. Скопированный проводник подключите к нижнему входному проводнику так, 
чтобы верхние границы совпадали, а левая граница скопированного проводника перекрывала 
правую границу входного проводника на две ячейки сетки. Дважды щёлкните левой кнопкой 
мышки по этому проводнику, установите курсор на синий ромбик в средине правой границы 
проводника так, чтобы он отображался в виде двойной стрелки, нажмите левую кнопку мышки 
и сдвиньте курсор вправо на две ячейки, чтобы края обоих проводников были на одном уровне, 
как показано на рис. 4.54. 

8. Щёлкните левой кнопкой мышки по значку Add Conductor на панели инструментов. 
9. Переместите курсор в окно электромагнитной структуры, поместите его на верхнюю 

границу верхнего проводника правее левого края на две ячейки и щёлкните левой кнопкой 
мышки, чтобы зафиксировать начало рисунка топологии. Возле курсора будет отображаться 
x:0, y:0. 

10. Не нажимая кнопки мышки, двигайте курсор влево так, чтобы было отражено dx:-0.1, 
dy:0. Щёлкните левой кнопкой мышки, чтобы зафиксировать эту точку. После этого снова 
возле курсора будет отображаться x:0, y:0. 

11. Не нажимая кнопки мышки, двигайте курсор вверх, пока будет отражено dx:0, dy:-0.1. 
Щёлкните левой кнопкой мышки. 

12. Продолжайте аналогично: 
o двигайте курсор влево, пока будет dx:-0.45 dy:0; 
o двигайте курсор вниз, пока будет dx:0 dy:0.1; 
o двигайте курсор влево и вниз, пока будет dx:0.45 dy:0.3; 
o двигайте курсор вправо, пока будет dx:0.1 dy:0; 
o дважды щёлкните левой кнопкой мышки или двигайте курсор вверх, пока будет dx:0 

dy:-0.3, чтобы замкнуть контур. 
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13. Повторите пункты с 1-го по 4-ый, но введите 0.65 в поле x, введите 0 в поле y, 0.45 в 
поле dx, 1.5 в поле dy. 

14. Щёлкните левой кнопкой мышки по значку Add Conductor на панели инструментов. 
15. Переместите курсор в окно электромагнитной структуры, поместите его на нижнюю 

границу верхнего проводника левее правого края на две ячейки и щёлкните левой кнопкой 
мышки, чтобы зафиксировать начало рисунка топологии.  

16. Не нажимая кнопки мышки, двигайте курсор вправо так, чтобы было отражено dx:0.1, 
dy:0. Щёлкните левой кнопкой мышки, чтобы зафиксировать эту точку. 

17. Не нажимая кнопки мышки, двигайте курсор вправо и вниз, пока будет отражено dx:0.3, 
dy:0.3. Щёлкните левой кнопкой мышки. 

18. Продолжайте аналогично: 
o двигайте курсор вправо, пока будет dx:0.1 dy:0; 
o двигайте курсор вверх, пока будет dx:0 dy:-0.25; 
o двигайте курсор влево, пока будет dx:-0.1 dy:0; 
o двигайте курсор влево и вверх, пока будет dx:-0.3 dy:-0.35; 
o двигайте курсор влево, пока будет dx:-0.1 dy:0; 
o дважды щёлкните левой кнопкой мышки или двигайте курсор вниз, пока будет dx:0 

dy:0.25, чтобы замкнуть контур. 
19. Щёлкните левой кнопкой мышки по значку Add Conductor на панели инструментов. 
20. Переместите курсор в окно электромагнитной структуры, поместите его на верхнюю 

границу нижнего проводника левее правого края на две ячейки и щёлкните левой кнопкой 
мышки, чтобы зафиксировать начало рисунка топологии. 

21. Не нажимая кнопки мышки, двигайте курсор вправо так, чтобы было отражено dx:0.1, 
dy:0. Щёлкните левой кнопкой мышки, чтобы зафиксировать эту точку. 

22. Не нажимая кнопки мышки, двигайте курсор вправо и вверх, пока будет отражено 
dx:0.3, dy:-0.3. Щёлкните левой кнопкой мышки. 

23. Продолжайте аналогично: 
o двигайте курсор вправо, пока будет dx:0.1 dy:0; 
o двигайте курсор вниз, пока будет dx:0 dy:0.25; 
o двигайте курсор влево, пока будет dx:-0.1 dy:0; 
o двигайте курсор влево и вниз, пока будет dx:-0.3 dy:0.35; 
o двигайте курсор влево, пока будет dx:-0.1 dy:0; 
o дважды щёлкните левой кнопкой мышки или двигайте курсор вверх, пока будет dx:0 

dy:0.25, чтобы замкнуть контур. 
24. Повторите пункты с 1-го по 4-ый, но введите 3.55 в поле x, введите 1.85 в поле y, 2.15 в 

поле dx, 0.25 в поле dy. 
25. Выделив последний вставленный проводник, щёлкните левой кнопкой мышки по значку 

Copy и затем по значку Paste на панели инструментов. Скопированный проводник подключите 
к нижнему проводнику, как показано на рис. 4.55. 

26. Щёлкните левой кнопкой мышки по значку Add Conductor на панели инструментов. 
27. Переместите курсор в окно электромагнитной структуры, поместите его на верхнюю 

границу последнего верхнего проводника левее правого края на две ячейки и щёлкните левой 
кнопкой мышки, чтобы зафиксировать начало рисунка топологии. 

28. Не нажимая кнопки мышки, двигайте курсор вправо так, чтобы было отражено dx:0.1, 
dy:0. Щёлкните левой кнопкой мышки, чтобы зафиксировать эту точку. 

29. Не нажимая кнопки мышки, двигайте курсор вверх, пока будет отражено dx:0, dy:-0.1. 
Щёлкните левой кнопкой мышки. 

30. Продолжайте аналогично: 
o двигайте курсор вправо, пока будет dx:0.45 dy:0; 
o двигайте курсор вниз, пока будет dx:0 dy:0.1; 
o двигайте курсор влево и вниз, пока будет dx:-0.45 dy:0.25; 
o двигайте курсор влево, пока будет dx:-0.1 dy:0; 
o дважды щёлкните левой кнопкой мышки или двигайте курсор вверх, пока будет dx:0 

dy:-0.25, чтобы замкнуть контур. 
31. Щёлкните левой кнопкой мышки по нарисованному уголку, чтобы выделит его. 

Щёлкните левой кнопкой мышки по значку Copy и затем по значку Paste. Поместите 
скопированный уголок поверх нарисованного и щёлкните левой кнопкой мышки. Выберите 
Draw > Flip (Рисовать > Зеркальное) в выпадающем меню. Поместите курсор посредине между 
краями последних проводников, нажмите левую кнопку мышки и, не отпуская её, двигайте 
курсор вниз. Уголок отобразится зеркально. Поместите курсор на зеркальный уголок так, 
чтобы курсор отображался в виде перекрестия, и, нажав левую кнопку мышки, присоедините 
уголок к нижнему проводнику так, чтобы уголок перекрывался с проводником на две ячейки. 



32. Повторите пункты с 1-го по 4-ый, 
но введите 5.7 в поле x, введите 0 в поле 
y, 0.45 в поле dx, 0.2 в поле dy. 
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одному 

азначение материала проводникам. 

Назначьте всем проводникам материал 
Copper о 

Полученная топология показана на рис. 
4.56. 

пределение частот для моделирования. 

Определите частоты для моделирования, как описано в примере 4.3, но введите 4 в поле Start, 18 
в поле S

оздание графика и добавление измеряемых величин. 

1. Щёлкните по значку Add Graph на панели инструментов. 
ика, например, Graph 1 в 

по r 

е панель Proj в нижней части левого 
ок

Щёлкните левой кнопкой мышки по значку 
Ad

as. 
Ty

rom 

 в 

t Index и

 
нализ делителя. 

1. Щёлкните левой кнопкой мышки по значку Analyze на панели инструментов. 
Ре ь

 
Примечание. Щёлкнув левой кнопкой мышки по значку Print на панели инструментов при 
активном окне графика (таблицы), можно распечатать график. Содержание любого активного 
окна можно распечатать, выбрав File > Print View в выпадающем меню. 

33. Повторите пункты с 1-го по 4-ый, 
но введите 5.8 в поле x, введите 0.2 в 
поле y, 0.2 в поле dx, 0.2 в поле dy. 

34. Повторите пункты с 1-го по 4-ый, 
но введите 5.7 в поле x, введите 0.4 в 
поле y, 0.45 в поле dx, 1.45 в поле dy. 

35. Повторите пункты с 1-го по 4-ый, 
но введите 5.7 в поле x, введите 2.5 в 
поле y, 0.45 в поле dx, 2.1 в поле dy. 

 
Полученная топология показана на рис. 4.55. 

Добавление портов и площадок для возбуждения поверхностных токов. 
 

Добавьте порты и площадки к входному 
проводнику, и затем к правому выходному 
проводнику и к левому ответвлённому вых
проводнику, как описано в примере 4.3. 
 
Н
 

, а резистору материал Resist, как описан
в примере 4.3. 
 

 
О
 

top и 1 в поле Step. 
 
С
 

2. Введите имя граф
ле Graph name (Имя графика), выберите Tabula

(Таблица) в области Graph Type (Тип графика) и 
нажмите OK. 

3. Нажмит
на. 
4. 
d Measurement на панели инструментов. 
5. Выберите Port Parameter в списке Me
pe, S в списке Measurement, no в поле Data 

Source Name, 2 в поле To Port Index, 1 в поле F
Port Index, нажимая на стрелки, справа от этих 
полей, отметьте DB в области Result Type и Mag
области Complex Modifier, нажмите Apply. 
 нажмите Apply. 6. Выберите 3 в поле To Por

7. Нажмите OK. 

А
 

зул таты анализа отображаются в таблице рис. 4. 57. 



5. Создание топологии схемы 
 

Топология показывает физическое представление схемы. Она является определяющей частью 
проекта СВЧ-схемы, т.к. 

В Microwave Of фективный объектно-
риентированный метод программирования. При этом топология тесно связана со схемой и 
электро я 

ски и немедленно отображаются и в 
соответ ии 

 
го 

Руководству пользователя Microwave Office. 

 

o Импортирование библиотеки элементов; 

o Замена изображения схемного элемента в схеме; 
иков в топологии; 
логии элементу схемы; 

о рисовать изогнутые 
р

логии. 
 
Создание н о

 
Чтобы з
 

ew Project (Файл > Новый проект) в выпадающем меню. 
2. Выберите File > Save Project As (Файл > Сохранить проект как) в выпадающем меню. 

 As. 
3. Наберите имя проекта (например, layout_example) и нажмите Сохранить. 

 

 
яет 

тановки по умолчанию для представления 

ображение топологии, 3-х мерное 
изображ

 
ой кнопкой 

ней части левого 
окна, чтобы открыть менеджер 
тополо

шки 

 
Pr s

 
диалоговое окно Открытие файла. 

определяет характеристики проекта. 
fice для создания топологии схемы используется эф

о
магнитными структурами. Топология – это фактически другое представление схемного решени

и любые модификации, которые делаются в схеме, автоматиче
ствующей её топологии и наоборот. Это исключает необходимость в сложной синхронизац

соответствия схемы и её топологии перед моделированием. 
Приводимый здесь пример показывает некоторые основные возможности создания топологии. В 

Microwave Office имеется много возможностей, которые позволяют создавать сложные топологии, типа
монолитных СВЧ микросхем (MMIC) и различных типов многослойных структур. Для более подробно
ознакомления с возможностями модуля Layout обратитесь к 

5.1. Создание топологии для схемы 
 
Создание топологии в Microwave Office включает следующие основные шаги: 

o Импортирование файла слоя (*.lpf); 

o Импортирование и размещение файла данных в схемном решении; 

o Размещение микрополосковых проводн
o Назначение нарисованного элемента топо
o Просмотр топологии; 
o Рисование элемента топологии; 
o Управление элементом MTRACE (элемент, которым можн
п оводники, например, меандровую линию) в топологии; 

o Экспортирование топо

ов го проекта. 

 со дать новый проект: 

1. Выберите File > N

Откроется диалоговое окно Save

Импортирование файла слоя. 

Файл слоя (LPF) определ
ус
топологии, включая рисунок слоёв, 
от

ение и отображение 
электромагнитных структур. Чтобы 
импортировать файл *.lpf: 

1. Нажмите лев
мышки на панель Layout 
(Топология) в ниж

гии (Layout Manager). 
2. Правой кнопкой мы

щёлкните по Layer Setup 
(Установка слоя) в менеджере 
топологии и выберите Import

oce s Definition (Импорт 
процесса определения) во 
всплывающем меню. Откроется
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шки, 

т 
о на рис. 5.1. 

 
Импорт тов GDSII. 

ice, чтобы обеспечивать создание как 
ногослойных физических структур, так и полосков печатных плат или обработки гибридных устройств, 

а так же хем 

 
ой мышки щёлкните по Cell Libraries 

(Библиотеки элементов) в менеджере топологии и выберите 
Re G

 
мышки, чтобы открыть папку. 

опкой 
мы и

Database Unit 
(П  

иотеке 

тся 
нная 

 
данных. 

х: 

1. Щелкните левой 
кнопкой мышки по панели 
Pr го 

 щёлкните по группе 
Da тра 

 
. 

R\MWO2002 и дважды 
щё  

папке Exa
щёлкните по подпапке Quick Start. 

 
Размещение 

: 

3. Найдите папку …\AWR\MWO2002 и дважды щёлкните по ней левой кнопкой мы
чтобы открыть папку. 

4. Выделите файл MIC_english.lpf и нажмите Открыть. Окно менеджера топологии буде
выглядеть, как показан

ирование библиотеки элемен
 

Библиотеки элементов используются в Microwave Off
м

 для стандартных графических работ, используемых при обработке монолитных СВЧ микрос
(MMIC) и высокочастотных интегральных схемах (RFIC). Microwave Office поддерживает формат 
файлов GDSII для рисунков. 

Чтобы импортировать библиотеку элементов GDSII: 

1. Правой кнопк

ad DSII Library (Читать библиотеку GDSII) во 
всплывающем меню. 

2. Найдите папку …\AWR\MWO2002 и дважды щёлкните
по ней левой кнопкой 

3. Дважды щёлкните левой кнопкой мышки по подпапке 
Examples (Примеры), затем дважды щёлкните левой кн

шк  по подпапке Quick Start. 
4. Выделите файл packages.gds и нажмите Открыть. 

Откроется окно Warning: Different 
редупреждение: Модуль различной базы данных). В этом

окне сообщается, что некоторые пункты в этой библ
будут сокращены в текущем модуле базы данных при 
выполнении рисунка или сохранении в файле и перечисляю
элементы из базы данных. Нажмите OK. Импортирова
библиотека будет отображена в окне менеджера топологии, 
как показано на рис. 5.2. 

Импортирование файла 
 

Чтобы импортировать файл данны
 

oj в нижней части лево
окна. 

2. Правой кнопкой 
мышки

ta Files в окне просмо
проекта и выберите Import 
Data File во всплывающем 
меню. Откроется диалоговое
окно Открытие файла (Рис
5.3). 

3. Найдите папку 
…\AW

лкните по ней левой
кнопкой мышки, чтобы 
открыть. 
mples, затем дважды 4. Дважды щёлкните левой кнопкой мышки по под

5. Выделите файл N76038a.s2p и нажмите Открыть. 

файла данных в схеме. 
 

Чтобы поместить файл данных в схеме
 



1. Правой кнопкой мышки щёлкните по группе Circuit Schematics (Схемы электрических 
цепей) в окне просмотра проекта и выберите New Schematic (Новая схема) во всплывающем 
меню. Откроется диалоговое окно Create New Schematic (Создать новую схему). 

2. Наберите qs layout и нажмите OK. 
3. Нажмите левой кнопкой мышки 

на панель Elem в нижней части левого 
окна, чтобы отрыть окно просмотра 
элементов. 
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емы. 

Размещение микрополосковых эле

ание. Microwave Office имеет специализированные элементы микрополосковой линии 

ы от 
присоединённого элемента. 

4. Найдите подгруппу Subcircuit 
(Подсхемы) щёлкните по ней левой 
кнопкой мышки. Модели подсхем 
отображаются в нижней части левого 
окна. 

5. Нажмите левой кнопкой мышки 
на модель N76038a и, не отпуская 
кнопки мышки, перетащите её в окно 
схемы, отпустите кнопку мышки, 
поместите элемент в окне схемы и 
щёлкните левой кнопкой мышки, чтобы 
зафиксировать, как показано на рис. 5.4. 

Замена узла заземления элемента файла данных на явный узел. 
 

Примечание. Изменить земляной узел иногда необходимо потому, что это может быть 
единственным способом сделать количество узлов в нарисованном элементе таким же, как и в 
импортированном. 

 
Чтобы добавить явный земляной узел к 

элементу файла данных транзистора: 
 

1. Дважды щёлкните левой кнопкой 
мышки по элементу подсхемы в окне сх
Откроется диалоговое окно Element 
Options (Опции элемента). 

2. Нажмите левой кнопкой мышки на 
панель Ground (Земля). 

3. Отметьте радиокнопку Explicit 
ground node (Явный земляной узел) и 
нажмите OK. Результат показан на рис. 5.5. 

 
 
 

Замена символа элемента. 
 

Символ подсхемы может быть изменён на FET, 
чтобы можно было видеть, какие узлы соответствуют 
затвору, стоку и истоку. Чтобы изменить символ: 
 

1. Дважды щёлкните левой кнопкой мышки 
по элементу подсхемы в окне схемы. Откроется 
диалоговое окно Element Options. 

2. Левой кнопкой мышки щёлкните по панели 
Symbol в верхней части окна. 

3. Выделите FET@system.sys в окне списка 
Compatible Symbols (Совместимые символы) и 
нажмите OK. Результат показан на рис. 5.6. 

 
 
ментов в топологии. 

 
Примеч
по имени Icell (для интеллектуальных элементов), которые не требуют никаких значений 
параметров для элемента. Эти элементы автоматически наследуют необходимые параметр



 

Элемен исваиваются параметры и размеры в соответствии со значениями, 
определ

е просмотра 
элементов. 

 
и левого окна. 

ль 
MLIN и, не отпуская кнопки мышки, перетащите 
эл н

 
ды) в группе 

ов. Модели р
левого окна. 

 
ие. Элементы, имеющие на конце имени $, наследуют атрибуты от портов, с 

которыми они соединяются. Элементы, имеющие на конце имени X, созданы 

гнитным 

 
левой кнопкой мышки на модель MTEE$ и, не отпуская кнопки мышки, 

перетащите элемент в окно схемы, 
ент 

ой 

кн и
раза право  

та 

 

с. 

евой 
кн о по 

 в 

с. 5.9. На
г 

9 для MLIN и MLEF 
уйте их 

па

Su
не 

ложек 

Микрополосковые элементы имеют по умолчанию соответствующие им элементы топологии. 
там топологии динамически пр
ёнными для каждого параметра. Чтобы разместить микрополосковые элементы: 

 
1. Дважды щёлкните левой кнопкой мышки по подгруппе Microstrip в окн

2. Щёлкните левой кнопкой мышки по подгруппе Lines. Модели линий отображаются в
нижней част

3. Нажмите левой кнопкой мышки на моде

еме т в окно схемы, отпустите кнопку, 
поместите элемент на узле 1 подсхемы N76038a 
и щёлкните левой кнопкой мышки, чтобы 
зафиксировать его (Рис.5.7). 

4. Теперь щёлкните левой кнопкой мышки
по подгруппе Junction (Перехо

Microscrip в окне просмотра элемент  пе еходов отображаются в нижней части 

Примечан

электромагнитным моделированием с параметрами, сведёнными в таблицу. Например, 
MTEEX$ – это Т – сочленение в микрополосковой линии, созданное электрома
моделированием, которое наследует ширину полосок от портов, с которыми оно 
соединяется. 

5. Нажмите 

отпустите кнопку, поместите элем
так, чтобы соединить его с левым 
узлом элемента MLIN, как показано 
на рис. 5.7 и щёлкните левой кнопк
мышки, чтобы зафиксировать его. 

6. Нажмите левой кнопкой мышки 
на модель MLEF и, не отпуская 
опк  мышки, перетащите элемент в 

й кнопкой мышки, чтобы повернуть
элемент, поместите 
его на узел 3 элемен
MTEES и щёлкните 
левой кнопкой
мышки, чтобы 
зафиксировать (Ри
5.9). 

7. Дважды 
щёлкните л

окно схемы, отпустите кнопку, щёлкните три 

опк й мышки 
элементу MTRACE

жмите OK. 
9. Повторите ша

окне схемы, чтобы открыть диалоговое окно Element Options. 
8. Отредактируйте параметры MTRACE, как показано на ри

и отредактир
раметры, как 

показано на рис. 5.9. 
10. Щёлкните 

левой кнопкой 
мышки по подгруппе 

bstrates 
(Подложки) в ок
просмотра элементов. 
Модели под
отображаются в 
нижней части левого 
окна. 

98



11. Нажмите левой кнопкой мышки на модель MSUB и, не отпуская кнопки мышки, 
пе а рис. 

SUB в окне схемы, чтобы 
от но на 

нопкой мышки по значку Port на панели инструментов, переместите 
курсор

 панели инструментов, 
пе

й 

щёлкните левой кнопкой мышки по значку Ground на панели 
ин

 

Назначение

Элементу схемы может 
быть по

но 
: 

1. Дважды щёлкните 
по элементу N76038a в 
ок

 

 
панель

кне 
списка e Cells 

Совместимые  

2. Выберите Edit > Snap Together 

ретащите элемент в окно схемы, отпустите кнопку, поместите элемент, как показано н
5.10 и щёлкните левой кнопкой мышки, чтобы зафиксировать. 

12. Дважды щёлкните левой кнопкой мышки по элементу M
крыть диалоговое окно Element Options. Отредактируйте параметры MSUB, как показа

рис. 5.10. Нажмите OK. 
13. Щёлкните левой к

 в окно схемы, поместите порт на левом узле элемента MTRACE, как показано на рис. 
5.11 и щёлкните левой кнопкой мышки, чтобы зафиксировать. 

14. Снова щёлкните левой кнопкой мышки по значку Port на
реместите курсор в окно схемы, щёлкните три раза правой кнопкой мышки, чтобы 

развернуть порт, поместите его на узле 2 элемента SUBCKT и щёлкните левой кнопко
мышки, чтобы зафиксировать. 

15. Чтобы закончить схему, 
струментов, переместите курсор в окно схемы, поместите землю на узле 3 элемента 

SUBCKT и щёлкните левой кнопкой мышки, чтобы зафиксировать (Рис. 5 11). 

 элементу схемы нарисованного элемента топологии. 
 

ставлен в соответствие 
элемент топологии, который мож
нарисовать. Чтобы сделать это
 

не схемы, чтобы 
открыть диалоговое окно
Element Options. 

2. Нажмите левой 
кнопкой мышки на

 Layout. 
3. Выберите 

Alpha_212_3 в о
 Compatibl

 элементы) и нажмите
OK. 
(

 
Просмотр топологии. 
 

Чтобы просмотреть топологию: 
 

1. Выберите Schematic > View 
Layout (Схема > Показать топологию) в 
выпадающем меню или щёлкните левой 
кнопкой мышки по значку View Layout 
на панели инструментов. Топология 
будет показана в окне топологии на 
рабочем поле (Рис.5.13). 
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(Р к  

Чтобы нарисовать элемент то

еда тор > Связать вместе) в выпадающем меню, чтобы связать вместе все нарисованные
элементы. 

 
Рисование элемента топологии. 
 

пологии: 
 

1. Нажмите левой кнопкой мышки на панель Layout в 
нижней части левого окна, чтобы активизировать менеджер 
топологии. 

2. Щёлкните правой кнопкой мышки по подгруппе packages 
(многослойные структуры) в группе Cell Libraries (Библиотеки 
элементов) и выберите New Layout Cell (Новый элемент 
топологии) во всплывающем меню. Откроется диалоговое окно 
Create New Layout Cell (Создание нового элемента топологии). 

3. Наберите chip cap (чип конденсатора) в поле Enter the 
name of the cell (Ввод имени элемента) и нажмите OK. На 
рабочем поле откроется окно для рисования. 

4. Щёлкните левой кнопкой мышки по квадрату 0->Copper 
(Медь) в нижней части окна менеджера, чтобы назначить медь 
для активного слоя, как показано на рис. 5.14 (не щёлкайте по 
лампочке, т.к. такой щелчок определяет слой для показа или 
скрытия). 

5. Щёлкните левой кнопкой мышки по окну рисования на 
рабочем поле, чтобы сделать его активным. 

6. Выберите Layout > Rectangle (Топология > Прямоугольник) в выпадающем меню или 
щёлкните по значку Rectangle на панели инструментов. 

7. Переместите курсор в окно рисования, затем нажмите 
клавишу Tab на клавиатуре. Откроется диалоговое окно Enter 
Coordinates (Ввод координат). 

8. Введите значения 0 и 10 в поля x и y соответственно и 
нажмите OK. 

9. Нажмите клавишу Tab снова, чтобы открыть диалоговое 
окно Enter Coordinates. 

10. Введите значения 10 и -10 в поля dx и dy соответственно и 
нажмите OK. Полученный рисунок показан на рис. 5.15. 

11. Щёлкните левой кнопкой мышки по квадрату 0->Footprint 
(След) в нижней части окна менеджера, чтобы выделить пустой прямоугольник на плате. 

12. Щёлкните левой кнопкой мышки по 
окну рисования на рабочем поле, чтобы 
сделать его активным. 

13. Выберите Layout > Rectangle 
(Топология > Прямоугольник) в выпадающем 
меню или щёлкните по значку Rectangle на 
панели инструментов. 

14. Переместите курсор в окно рисования, 
затем нажмите клавишу Tab на клавиатуре. 
Откроется диалоговое окно Enter Coordinates. 

15. Введите значения 10 и 10 в поля x и y соответственно и нажмите OK. 
16. Нажмите клавишу Tab снова, чтобы открыть диалоговое окно Enter Coordinates. 
17. Введите значения 20 и -10 в поля dx и dy соответственно и нажмите OK. Полученный 

рисунок показан на рис. 5.16. 
18. Щёлкните левой кнопкой мышки по левому медному квадрату в окне рисунка и 

нажмите клавиши Ctrl+C и затем 
Ctrl+V или щёлкните левой кнопкой 
мышки по значку Copy и затем по 
значку Paste на панели инструментов, 
чтобы скопировать и вставить 
прямоугольный проводник. Нажмите 
левой кнопкой мышки на 
скопированный проводник и, не 
отпуская кнопки мышки, переместите 

его к правому краю последнего квадрата топологии и щёлкните левой кнопкой мышки, чтобы 
зафиксировать. Полученная топология показана на рис. 5.17. 

 



Добавление портов к нарисованному элементу. 
 

Чтобы добавить порты к нарисованной топологии: 
 

1. Выберите Layout > Cell Port (Топология > Порт элемента) в выпадающем меню или 
нажмите на значок Cell Port на панели инструментов. 

2. Переместите курсор в окно рисования. Нажав и удерживая 
клавишу Ctrl, поместите курсор на нижний левый угол  левого 
квадратного проводника так, чтобы небольшой квадратик появился 
на этом углу. Не отпускайте клавишу Ctrl. 
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мышки и клавишу Ctrl. 

о 
просмотра элементов. 

т 
 

 

3. Не отпуская клавишу Ctrl, нажмите левую кнопку мышки 
(соответствующее изображение показано на рис. 5.18) и, не 
отпуская её, двигайте курсор к верхнему левому углу проводника, 
пока другой квадрат появится на этом углу. Отпустите кнопку 

4. Повторите шаги с 1-го по 3-ий, чтобы поместить порт на противоположной стороне 
рисунка, но начните с верхнего 
правого угла и двигайте курсор к 
правому нижнему углу. 

5. Закройте окно рисования. Будет 
выведен запрос, хотите ли вы 
сохранить нарисованный элемент. 
Нажмите Yes, чтобы сохранить. 
Полученная топология показана на 
рис. 5.19. 

 
Редактирование схемы и назначение элемента chip cap. 
 

Чтобы отредактировать схему и ввести бескорпусной конденсатор элемент chip cap: 
 

1. Щёлкните левой кнопкой 
мышки по окну схемы, чтобы сделать 
его активным. 

2. Щёлкните левой кнопкой 
мышки по PORT1 в окне схемы. 

3. Нажмите и удерживайте 
клавишу Ctrl, нажмите левую кнопку 
мышки и, не отпуская её, оттащите 
порт влево от элемента MTRACE, как 
показано на рис. 5.20. 

4. Нажмите панель Elem в нижней 
части левого окна, чтобы открыть окн

5. Дважды щёлкните левой кнопкой мышки по группе Lumped Element (Сосредоточенные 
элементы), затем щёлкните 
левой кнопкой мышки по 
подгруппе Capacitor 
(Конденсаторы), чтобы 
отобразить модели 
конденсаторов в нижней 
части левого окна. 

6. Нажмите левой 
кнопкой мышки на модель 
CAP и, не отпуская кнопки 
мышки, перетащите элемен
в окно схемы, отпустите
кнопку мышки, поместите 
элемент между элементами
PORT1 и MTRACE, 
щёлкните левой кнопкой 
мышки, чтобы 
зафиксировать элемент. 

7. Дважды щёлкните левой кнопкой мышки по элементу CAP C1 в окне схемы. Откроется 
окно Element Options (Опции элемента). 

8. Нажмите на панель Layout в верхней части этого окна. 



9. Выберите chip cap в окне списка Compatible Cells (Совместимые элементы) и нажмите 
OK (рис. 5.21). 
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ировка элемента MTRACE в окне топологии. 

1. Щёлкните левой кнопкой мышки по элементу топол и
ту 

кн о
однике 

ите курсор на крайний 
пр

релки. 

р, не нажимая кнопки 
мышки  

вать. 

ин кам 

ь 

нная 

10. Выберите Schematic > View Layout (Схема > Показать топологию) в выпадающем 
меню. Новая топология будет отображена на рабочем поле (рис. 5.22). 

Трасс
 

Примечание. Элемент MLIN – это элемент, чья ширина задаётся и может изменяться в 
топологии, но редактировать топологию этого элемента (например, делать изгибы) нельзя. 
Элемент MTRACE – это элемент, топология которого может быть отредактирована, чтобы 
иметь изгибы со скошенными краями. Элемент MCTRACE – это элемент, топология которого 
может быть отредактирована, чтобы иметь изгибы со скруглёнными краями. 

 
Чтобы выполнить трассировку топологии элемента MTRACE: 

 
оги  MTRACE (т.е. по 

соответствующему этому элемен
прямоугольному проводнику), чтобы 
выделить его. 

2. Дважды щёлкните левой 
опк й мышки по элементу 

топологии MTRACE. На пров
появятся синие ромбики, как показано 
на рис. 5.23. 

3. Помест
авый ромбик так, чтобы он 

отображался в виде двойной ст
Дважды щёлкните левой кнопкой 

мышки, чтобы активизировать инструмент 
трассировки (рис. 5.24). 

4. Переместите курсо
, в желательную точку и щёлкните

левой кнопкой мышки, чтобы зафиксиро
(Щелчок правой кнопкой мышки удалит 

последнюю точку трассировки, 
нажатие клавиши Esc отменяет 
процесс трассировки). 

5. Продолжайте двигать 

 

струмент трассировки к точ
нужного маршрута, щёлкая левой 
кнопкой мышки, чтобы фиксироват
точки изгиба, затем дважды щёлкните 
левой кнопкой мышки, чтобы 
закончить трассировку. Получе
топология показана на рис. 5.25. 
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кспорт топологии. 

Чтобы экспортировать топологию: 
 

1. Выберите Options > 
Dr i

 

. 

). 

Layers

нель 
DX

ite 

 
адающем ме .  

F 
 выпадающем 

списке

рава 

и 
на

ь, 
 

 
Н

оделирования топологии закончен. 
При жел охранить 

 

 
 
 

Э
 

aw ng Layers (Опции > 
Нарисованные слои) в 
выпадающем меню, чтобы
определить слои, которые 
надо экспортировать в файл
Откроется диалоговое окно 
Layer Setup (Установка слоя

2. Нажмите на панель File 
 (Файл слоёв) в верхней 

части окна. 
3. Нажмите на па
F в нижней части окна, 

отметьте только слой меди 
(Copper) и Error в поле Wr
Layers (Записать слои) и 
нажмите OK (рис. 5.26). 

4. Выберите Layout >
Export Layout (Топология > Экспорт топологии) в вып ню Откроется диалоговое
окно Сохранение (рис.5.27). 

5. Отметьте DX
(Flat*.dxf) в

 Тип файла, 
щёлкнув левой кнопкой 
мышки по стрелке сп
от этого списка. 

6. Наберите myfile в 
поле Имя файла 
жмите левой кнопкой 

мышки на Сохранит
чтобы экспортировать слой
меди в файл DXF. 

а этом пример 
м

ании вы можете с
свою работу, выбрав File > Save 
Project в выпадающем меню 
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